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Introducing FusionAnalytics

Out of the box, FusionAnalytics is a comprehensive analytics tool covering a wide spectrum of analytical requirements. It can provide you 
with everything from high-level monthly trend reporting, all the way down to monitoring the status of individual database requests on a 
millisecond to millisecond basis. It is designed to be an invaluable tool for everyone, from the manager trying to estimate future hosting 
costs and requirements, right down to the developer trying to optimize the memory footprint of a troublesome application page.

At its core though, FusionAnalytics is actually a powerful platform capable of running any number of Analytics Apps (each of which could 
be tailored to a specific purpose and can draw data from any external application or server capable of generating log files). At launch 
time we currently only support the FusionAnalytics for FusionReactor App, but we will be making other Analytics Apps available over 
time.

Additionally, you can also customize the standard App or even register for a free Developer License and build your own FusionAnaytics 
App from scratch. Information on customizing or building new Apps will be coming soon.

If you are  to FusionAnalytics, it is recommended to start by taking a look at the  and once you have everything . new User Guide installed
Even if you do plan on building your own Apps in the future, the standard App will give you a good idea of what is possible with the 
platform.

For more information about FusionAnalytics please see: http://www.fusion-analytics.com

Welcome

This is the documentation hub for FusionAnalytics. You can use the links on the left to navigate through the collection.

Feedback

We welcome feedback on all our products and publications. To discover the various ways of contacting us, please send an email to our 
support team on . We will address your feedback as quickly as possible.support@fusion-reactor.com

License and Copyright Information

FusionAnalytics End User License Agreement.

Third Party Software Notices and/or Additional Terms and Conditions for FusionAnalytics are made a part of and incorporated 
by reference into such product's End User License Agreement.

Copyright statement for all documentation contained in this collection.

Installation Guides

Overview

This section provides information about the general system requirements of FusionAnalytics and all of the installation instructions 
required to get FusionAnalytics running.

Next Steps

SYSTEM REQUIREMENTS

Amazon Elastic Compute Cloud (Amazon EC2)

INSTALLING FUSIONANALYTICS SERVER

Prerequisites for Installation

Installation

Installing your license

http://www.fusion-analytics.com/
mailto:support@fusion-reactor.com
http://www.fusion-reactor.com/license-v2.txt
http://www.fusion-analytics.com/support/fa/third_party.cfm


INSTALLING THE FUSIONANALYTICS AIR CLIENT

INSTALLING FUSIONREACTOR

INSTALLING FUSIONREACTOR EXTENSIONS FOR COLDFUSION

UNINSTALL A FUSIONANALYTICS LICENSE KEY

UNINSTALLING FUSIONANALYTICS

UPGRADING FUSIONANALYTICS

System Requirements

System Requirements

Operating Systems

 Windows

FusionAnalytics 
Server

Microsoft Windows Server 2016

Microsoft Windows Server 2012

Microsoft Windows Server 2008 
Microsoft Windows Server 2003 
Microsoft Windows 8 
Microsoft Windows 7 
Microsoft Windows XP Professional 
Microsoft Windows Vista 
Microsoft Windows 2003 Web Edition, Standard Edition, 
Enterprise Edition

Memory 4 GB (MIN)

Hard Disk Space 25 GB available (MIN) - Using Microsoft SQL Server 
2008 R2 Express

Architecture 64-BIT / 32-BIT

Servers

ColdFusion

Supported ColdFusion
Servers 

ColdFusion 2016 (64-BIT / 32-BIT)

ColdFusion 11 (64-BIT / 32-BIT)

ColdFusion 10 (64-BIT / 32-BIT)

ColdFusion 9 (64-bit / 32-BIT)

ColdFusion 8 (64-bit / 32-BIT)

ColdFusion MX 7

ColdFusion MX6

Server Monitor

FusionReactor

On This Page:

 Windows

 ColdFusion

 FusionReactor

 Database

 ™AIR

Hardware

Screen Resolution

 Memory and Hard Disk Space requirements arePLEASE NOTE:  comp
 letely dependent on the amount of metric data you wish to store and 

have available in FusionAnalytics. Read our Data Guidelines section.



FusionReactor 
Editions

FusionReactor 4 (or above) Enterprise Edition 
(Perpetual / Subscription)
FusionReactor 4 (or above) Standard Edition 
(Perpetual / Subscription)

Database

Microsoft

SQL 
Server 

Versions

Microsoft SQL Server 2016

Microsoft SQL Server 2014

Microsoft SQL Server 2012

Microsoft SQL Server 2008 R2

Microsoft SQL Server 2008

Microsoft SQL Server 2005

Microsoft SQL Server 2012 Express

Microsoft SQL Server 2008 R2 Express

Memory Minimum: 1 GB
Recommended: 4 GB or more 
Maximum: Operating system maximum

Note : SQL Server Enterprise Edition supports a maximum of 2 
TB of RAM or operating system maximum, whichever is lower

Database
size

The maximum database size applies per database, excluding 
log files.

10 GB (MAXIMUM for Express versions) 

CPU's Depends on MS SQL License
Processor type: Itanium processor or faster
Processor speed: Recommended: 1.0 GHz or faster

Architect
ure

64-BIT / 32-BIT

Adobe AIR Runtime

FusionAnalytics Client

ADOBE® AIR®

Supported from version 2.7 onwards

Visit  for more informationthe Adobe website

Hardware Platform

PLEASE NOTE: Microsoft recommends that you run SQL Server 2012 
on computers with the NTFS file format – please read the Hardware 
and Software Requirements for Installing SQL Server 2012 located on 
Microsoft's website for full details.

Please note that FusionAnalytics will   support ONLY Microsoft SQL 
 versions listed above.Server

Download for free: Latest version of Adobe AIR

http://www.adobe.com/products/air/
http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://get.adobe.com/air/


Processor

FusionAnalytics 
Server

1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) 
processor (MIN)
We recommend a 2 GHz or higher quad core 
processor

Screen Resolution

Resolution

FusionAnalyticsAir 
Client 
FusionAnalytics 
Web Client

SXGA 1280 x 1024 (MIN)
UXGA 1600 x 1200 or higher resolution monitor 
(RECOMMENDED)

Next Steps

Amazon Elastic Compute Cloud (Amazon EC2)

Amazon Elastic Compute Cloud (Amazon EC2)

Amazon Elastic Compute Cloud (Amazon EC2)

Minimum Instance Requirements for FusionAnalytics Server

Operating Systems

 

Windows Server 2008 R2 Base 
**

Instance Type Medium instance (m1.medium) 

Memory 3.75 GB (MIN)

Hard Disk Space 40GB (MIN)

CPU Units 2 ECUs (1 Core)

Architecture 64-BIT

** NOTE : THE SQL DATABASE WAS NOT SETUP ON THIS TEST SERVER - ONLY FUSIONANALYTICS SERVER - The SQL 
Server was setup on a separate EC2 Instance

 Amazon charges for EC2 instances separately - and you should be aware of the pricing policies before setting up any 
instances.

When selecting which Amazon EC2 instance you require, it is IMPORTANT to note that instance requirements are  completely
dependent on the amount of metric data you wish to store and have available in FusionAnalytics. The information shown below 
are ONLY GUIDELINES BASED ON ONE SPECIFIC TEST CASE.  For more information on sizing guidelines, please refer to 
our Data Guidelines section.

For our test case, an Amazon EC2 instance, setup with these minimum specifications was able to manage up to 5 
DataCollectors, and processing a combined total of approx. 500,000 requests per day (100,000 requests per DataCollector).

A LARGER EC2 instance will be required when using more than 5 DataCollectors and we recommend that you increase the 
maximum heap space of FusionAnalytics Server JVM by 128MB for each additional DataCollector.

Additional information on FusionAnalytics JVM requirements can be found .here

This information is ONLY to be given as a  to show the Minimum configuration necessary to support our example GUIDELINE
application, running 5 DataCollectors / 500,000 Requests (per day)
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Installing FusionAnalytics Server

Overview

This guide will help you with your first installation of FusionAnalytics.

Prerequisites for Installation

Make sure you are ready to begin the installation.

Installation

Once your system is ready, this section will guide you through the install process.

Installing your license

You can visit the tutorial on license files for help uploading and activating your licenses.

Quick Start Guide

Go back to the  to view your next steps.Quick Start Guide

Take me back to the .Installation Guides

Next Steps

Prerequisites for Installation

Installation

Installing your license

 

Prerequisites for Installation

PREREQUISITES FOR INSTALLING FUSIONANALYTICS SERVER

In order to get started with the installation of FusionAnalytics in your system, please make sure that the following steps have been 
checked.

You have checked the minimum system requirements for the system where you want to install FusionAnalytics. For more 
information please check the following link, .System Requirements

It's really important that you have . For more information, please check out the following link, prepared your database Database 
.Configuration

You have the  with  on the target database.database login details available appropriate privileges

You have the appropriate FusionAnalytics installer. The latest installer can be found in the following link; http://www.fusion-
analytics.com/download/

Make sure that the JavaScript is enabled in your default browser.

NEXT STEPS

Installation
Once you have completed the steps above, you can start the installation.

Installation

INSTALLING FUSIONANALYTICS SERVER

Executables

It is the  to configure and test their Amazon EC2 image to ensure that it will support their responsibility of the customer
application running

Please note that FusionAnalytics will  support Microsoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL ONLY 
Server 2012, Microsoft SQL Server 2008 R2, Microsoft SQL Server 2008 and Microsoft SQL Server 2005.

http://www.fusion-analytics.com/download/
http://www.fusion-analytics.com/download/


Executable System Architecture

FusionAnalytics_windows_2_0_8.exe 32-bit

FusionAnalytics_windows-x64_2_0_8.exe 64-bit

In order to get a copy of the latest executable options, please visit our official website  .here

Setup

To start the installation process, double click the latest installer OR right click on the file and choose the option "Run as administrator".

When the installer starts you will see the Welcome screen (Figure 1). You can click the  and  buttons to navigate through the Next Back
installer.

 

Figure 1: Welcome Screen

The next screen will show you the  (Figure 2). If you agree to its terms and conditions, you need to select License Agreement 'I accept 
 before continuing.the agreement'

 You will not be able to install FusionAnalytics if you do not accept the license agreement.

You will need to have Administrator privileges on the system you are installing on.

http://www.fusion-analytics.com/download/


 

Figure 2: License Agreement

Next you will see the  screen. The default (and ) option is to install the whole FusionAnalytics Select Components recommended
package (Figure 3).

A description of what each component does can be seen under its name (or by clicking the green question mark).

If you would only like to install one of the components on the current machine, make sure only the component you want to install is 
selected.

 If you only install one component, you will skip the Application Name and Database Configuration screens. After install, you will need 
to upload an application and connect it to a database manually.



Figure 3: Select Components

The next screen allows you to select the , which is where FusionAnalytics will be installed (Figure 4).Destination Directory

You can change this location by clicking the  button.Browse...

Figure 4: Destination Directory

The following screen allows you to choose a  (Figure 5).Start Menu Folder



If you do not want to create a folder in the start menu, uncheck the box marked .Create a Start Menu folder

You can also choose if you want to create shortcuts for all users or only the current user, by checking or unchecking the box marked Crea
.te shortcuts for all users

 

Figure 5: Start Menu Folder

On the next screen you can define the  to be used by FusionAnalytics (Figure 6). If you want different ports to be used, TCP/IP Ports
check the box marked  and adjust the port numbers.Adjust Settings

The setup will check if the ports are free before continuing. If they are not available, they will need to be changed.



 

Figure 6: TCP/IP Ports

The default user that will be created for FusionAnalytics is called ; for this you will need to set the  'admin' Administrator Password

(Figure 7). The user will be the .'admin'

You need enter the password in the Password and Confirmation fields to make sure they match, before clicking .Next

Make sure you choose a secure password, as this user account will have access to everything within FusionAnalytics.



Figure 7: Administrator Password

Next, you will be asked to enter an  (Figure 8). This will create one application for FusionAnalytics DataCollector and Application Name
one application for FusionAnalytics DataServices.

This needs to be a unique instance name, since later you can upload further applications, which may point to different databases and log 
files.

For this guide we will use ColdFusion 11, as this is what we will be monitoring.



 

Figure 8: Application Name

The next screen (Figure 9) allows you to enter the  for the database that you have already prepared (see Database Configuration Datab
).ase Configuration

You will need to enter the database name, machine name or IP address, and the username and password which has the appropriate 
privileges on that database.

Before continuing, click  to make sure a connection can be correctly established.Test Connection

If you have followed the Database Configuration tutorial, you should use the    fadb database we set up, with fadb as the 
user.

In FusionReactor 2.0.8 the driver options field has been added.

This by default will contain 2 options:

loginTimeout - This reduces the login timeout from 30 seconds to 5 seconds for when a connection to the database is 
attempted

sslProtocol - This allows a user to specify the TLS protocol used when connecting to an MSSQL database



 

Figure 9: Database Configuration

In the  screen (Figure 10) you can select which parts of FusionAnalytics you would like to open after the install finishes.Additional Tasks

It is recommended that you select both  and .Open DataServices Administrator Open DataCollector Administrator

After you have selected which ones you want to open, click .Next



 

Figure 10: Additional Tasks

The installer will now install the files to the selected directory and the installation wizard will complete. Click  to close the installer.Finish

NEXT STEPS

Installing your license
After logging in for the first time, you will need to upload and activate your licenses.

Installing the FusionAnalytics AIR Client
Installing the AIR client will allow you to start analyzing the data from your server.

Quick Start Guide
Go back to the Quick Start Guide to review your next steps.

Installing your license

INSTALLING YOUR LICENSE

Note:If you have installed FusionAnalytics for the first time you will be granted a Free Trial Period (FTP) license which allows 
you to use the system for 30 days.

If you chose to open either of the Administrator windows at the end of the installation, it can take 30 seconds or more 
(depending on the performance of your server) for the service to start and the pages to be displayed.

You can log into both components using the  user we configured in the installation.'admin'

Note:  Please keep in mind that if you have purchased an  license key, you will only be able to monitor S Pack ONE 
. For example, if you have a ColdFusion 11 and a ColdFusion 2016 installed in the same box, Application Server Instance

you have installed the latest FusionAnalytics version and you have purchased an S Pack, then you will only be able to monitor 
the ColdFusion 11 server  the ColdFusion 2016 server. If you want to monitor both of them using the , you OR SAME BOX
need to upgrade your license key.

More information about pricing can be found .here

http://www.fusion-analytics.com/pricing/


Uploading a License

You can upload your license in either FADS or FADC and by navigating to   (Figure 1).System > License Info

 

Figure 1: License Info

This will take you to the License Info screen (Figure 2). Click the  button.Install License

 

Figure 2: License Info without licenses.

You will be directed to the License Upload screen (Figure 3). Click the browse button and navigate to the license file you wish to upload. 
Then click .upload

 

Figure 3: License Upload.

If you are using multiple product families you will need to upload a license for each.



If your upload was successful you should see something like the following:

 

Figure 4: License Uploaded.

Your license will now be fully functional. You  activate your license within the number of days shown or you will no longer be able to must
use analytics for that product family until you activate.

Activating a License

Once your license is uploaded it needs to be activated. To activate your license simply click the Activate button and click "OK" on the 
prompt.

 

Figure 5: Activate confirmation.

If you encountered an error uploading your license, please make sure that you are using a valid license file. In case you are 
using a valid license key please contact the FusionReactor Support Team  for further help. support@fusion-reactor.com

There are multiple things that can happen at this stage:
Your license activates straight away. See License Activated

You are taken to the manual activation page because you have no internet connection. See Manual Activation

Your license has no activations left. See License Rejected

mailto:support@fusion-reactor.com
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Manual Activation

If the server running FusionAnalytics is , you will be taken to the manual activation page of not connected to the Internet
FusionAnalytics.

 

Figure 7: Manual activation

The steps below are going to guide you through the manual activation process.

Access the manual license activation page of FusionAnalytics The URL is the  using a computer that can access the Internet. 
following,  .Manual License Activation

Make sure that you have  the whole copied Activation Input String.

Paste the  in the Activation area. See screenshot below.Activation Input String

Press the button.Submit 

A new page will appear and under the field with name "  " you will find an Activation Key.Activation Key:

http://www.fusion-analytics.com/fa/activate/activateFA.php


6.  

7.  

8.  

Copy the Activation Key.

Paste the key in the Activation Key area.

Press the "Activate License" button.

License activated straight away

If your license activated instantly, you should see a screen similar to the following:

 

Figure 6: License activated.

Your license is now fully activated.

Activation rejected due to no activations remaining

If you have run out of activations, you will have to uninstall this license on another machine that is using it before you are able to activate 
it again.



 

Figure 8: No activations remaining

NEXT STEPS

Installing the FusionAnalytics AIR Client
If you have not already done so, you will need to install the AIR client to start analyzing the data.

Installing the FusionAnalytics AIR Client

Introduction

The AIR Client should be installed on any machine that you want to use to monitor your server. This does not
have to be on the same machine where you have installed the FusionAnalytics Server. You can use the AIR 
Client to monitor the data from multiple applications from your desktop.

 

ABOUT ADOBE AIR

At a basic level, you can consider Adobe AIR to be a bit like a new web browser specifically designed to run 
Adobe Flash content. The FusionAnalytics client is made available as Flash content so it can be accessed in 
normal web browsers (by clicking the Launch button on the  page) or by running FADS Application Summary
it in Adobe AIR. Because Adobe AIR doesn't have to worry about all of the other tasks that web browsers 
have to deal with, you often find that you get better performance from applications which use Adobe AIR. 
Additionally, Adobe AIR can support more functionality because it is running directly out of your operating 
system rather than as a plugin within another piece of software. For these reasons we generally recommend 
that you use the FusionAnalytics AIR client.

Unlike Flash content viewed from within a browser, when you download and run an AIR application such as 
the FusionAnalytics AIR client, it is installed as if it were a desktop application. You can have a shortcut on 
your computer desktop and run it directly from there.

Back to the top
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Before continuing, you will need to make sure that the machine you want to install the 
FusionAnalytics AIR Client on has Adobe AIR already installed on it. See  for System Requirements
more information.

Download for free: Latest version of Adobe AIR

http://get.adobe.com/air


Executable System Architecture

fusionanalytics-air-2.0.7.air 32-bit and 64-bit

Back to the top

SETUP

Once AIR is installed, double click the FusionAnalytics AIR Client installer (.air file).

When the installer starts, you should click  (Figure 1).Install

Figure 1: AIR Client Installer

The next screen (Figure 2) allows you to configure installation options.

It is recommended that you keep  checked, as we will start configuring the Start application after installation
client after it is installed.

If needed, you can change the location of the installation directory by clicking the folder icon.

Click  to carry on with the installation.Continue



Figure 2: Installation options

When the installation has completed, the AIR Client can be opened by double-clicking the icon on the 
desktop named: .FusionAnalyticsAir

Back to the top

UNINSTALLING THE ADOBE AIR CLIENT

To uninstall the FusionAnalytics AIR Client you need to follow the standard steps for uninstalling an 
application on your computer. For example, on Windows you would open the "Add or Remove Programs" 
dialog from the Control Panel. Scroll down to "FusionAnalytics AIR", highlight it and then click the Remove 
button. The applicaion will be automatically uninstalled from your system.

Back to the top

Next Steps

Accessing FusionAnalytics
Once you have FusionAnalytics installed, you are ready to start the configuration tutorial.

Quick Start Guide
Go back to the Quick Start Guide to review your next steps.

Installing FusionReactor

Installing FusionReactor

To get the most out of FusionAnalytics, it should be used with FusionReactor 5 or greater version. Using them together will produce 
highly detailed log files for your server and allow you to analyze the results.

Check out the link,  for more information and details about pricing. There is a 14-day trial period, enabling FusionReactor Pricing
you to check out all the functionality of the software before purchase.

Check out the link,  for help on installing FusionReactor. Once installed, FusionReactor will start FusionReactor installation guide
producing logs suitable for importing into FusionAnalytics.

http://www.fusion-reactor.com/pricing/
http://docs.intergral.com/display/FR71/FusionReactor+Installation+Guide
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These can be shipped automatically to FusionAnalytics periodically using the . See the  in this FusionAnalytics Connector section
manual, with links to individual topics, or use , the , to  for FusionAnalytics FRAM FusionReactor Administration Manager set up FR
transfer, using handy popups.

Installing FusionReactor Extensions for ColdFusion

Installing FusionReactor Extensions for ColdFusion

FusionReactor ColdFusion Extensions is a plugin for FusionReactor, which can enhance the information that you receive in 
FusionAnalytics. It is designed specifically for ColdFusion servers, allowing extra log files to be generated giving you a much higher level 
of detail when analyzing requests in FusionAnalytics.

For a detailed installation tutorial, please see the FusionReactor documentation: . More information FusionReactor ColdFusion Plugin
about the installation process of the extensions can be found .here

Uninstall a FusionAnalytics License Key

Introduction

This section will provide readers with more information about the process of successfully uninstalling a FusionAnalytics license key.

If you want to activate a FusionAnalytics License key, please follow the link below.

Install a FusionAnalytics License Key

Getting Started

There are a number of reasons why you might want to uninstall a FusionAnalytics license key. Some of the most common reasons 
described below.

You want to monitor more Application servers than the size of your license key. For that reason, you need to uninstall the 
current license key and activate a new one.

You want to uninstall the license key from one machine in order to free an activation and use the license key on another 
machine.

UNINSTALLING THE LICENSE KEY

The process of uninstalling a license key in FusionAnalytics is fast and simple. In order to do that, please follow the steps listed below.

Access the FADS FADC application via a browser.OR 

Navigate to . You should be able to see something similar to the screenshot below. System > System Info

Click the " " button.Uninstall

In the pop-up message, click OK in order to uninstall the license key.

 Please note that this section refers to FusionReactor 4.x versions. If you are using FusionReactor 5.x and greater, there is no 
need to install the Extentions for ColdFusion as this is done automatically for you.

https://docs.fusion-reactor.com/display/FR71/FusionReactor+Installation+Guide
http://docs.intergral.com/display/FR71/Analytics
http://docs.intergral.com/display/FR62/FusionReactor+ColdFusion+Plugin
http://www.fusion-reactor.com/support/kb/frs-249/
http://docs.intergral.com/display/FA206/Installing+your+license


5.  If the process has been successful, you will be able to see the following message "License Uninstalled Successfully". See 
screenshot below.

If you try and refresh the page, you will redirected by default to the "Application Summary" page and there you will be able to see FADS 
the red message " " indicating that the license key has been uninstalled. See screenshot There is no license installed for this application.
below.

Also, if the license key has been deactivated successfully, an activation seat will be available and you should be able to use the license 
key in another machine.

See also

Uninstalling FusionAnalytics

Upgrading FusionAnalytics

Uninstalling FusionAnalytics

Introduction

This section will guide readers through the process of  FusionAnalytics from a machine.uninstalling

Uninstalling FusionAnalytics

If for any reason you need to uninstall FusionAnalytics, this can be done with two different ways which are described below.

http://docs.intergral.com/display/FA206/Uninstalling+FusionAnalytics
http://docs.intergral.com/display/FA206/Upgrading+FusionAnalytics


1.  

2.  

Navigate to the FusionAnalytics directory and double click the "uninstall" icon. Alternatively, you can type in the Search bar of 
Windows "FusionAnalytics Uninstaller" and the uninstaller will appear.

You can navigate to . Choose the FusionAnalytics 2.0.6 icon, right click and Control Panel > Programs > Uninstall a program
choose the option " ".Uninstall/Change

FUSIONANALYTICS SERVER

Once the uninstaller has been started, you will see the FusionAnalytics Uninstall wizard (Figure 2).

Note
The FusionAnalytics Server and FusionAnalytics AIR Client must be removed separately.

The database used by FusionAnalytics must also be removed separately, either by deleting it from the SQL 
Server Management Studio or uninstalling Microsoft SQL Server.

If you remove the Server, you will no longer have access to those applications in the Client.

If you remove the AIR Client, the applications will still exist and can be accessed in another client.



If you are sure you want to remove FusionAnalytics DataCollector and FusionAnalytics DataServices, click .Next

 

Figure 2: Uninstaller Wizard

After the uninstaller has finished, FusionAnalytics Server will have been removed from your computer and you will no longer have access 
to its applications in the client.

Click the button in order to close the uninstaller wizard.Finish 

FUSIONANALYTICS AIR CLIENT

You can only uninstall the client from the Windows Control Panel (see above).

Once it has been uninstalled the applications will still exist and can be accessed from other clients.

Upgrading FusionAnalytics

Introduction

This section is going to guide you through the process of Upgrading FusionAnalytics.

Upgrading FusionAnalytics

UPGRADING FUSIONANALYTICS SERVER

To upgrade your current version of FusionAnalytics (FA), simply download and 
run the latest FA installer (this can be downloaded from our ).website

The installer will detect your current version of FA, and will upgrade it accordingly. 
The setup will restart the FA services during the upgrade process and any 
existing applications will be kept.

However, once the upgrade is complete you will be required to manually upgrade 
your existing (FADS and FADC) applications, if required, therefore when the 

 
On this page:

Upgrading 
FusionAnalytics 
Server

Upgrading FADS 
Applications

Upgrading FADC 
Applications

Make sure that the lastest installer version is newer (greater) than your 
current installed version of FA.

Server Restart Required
Whenever an APML or 
DCML application has 
been upgraded the 
FusionAnalytics server 
has to be restarted. This 
will ensure that any 
locked files can be 

http://www.fusion-analytics.com/download/


installer will ask which applications should be opened after the setup has been 
completed, select both " " and "Open DataServices Administrator Open 

":DataCollector Administrator

After the update process, the   and DataServices (FADS) Administrator DataColl
 will be opened in the browser.ector (FADC) Administrator

Back to the top

UPGRADING FADS APPLICATIONS

Once FADS has been launched (if FADS is not launched please navigate to 
FADS and) log into the Administrator.

 

Once the application(s) has been stopped, click the "Upgrade" button to upgrade 
the application:

Click the browse button and navigate to the package you would like to upgrade to:

Once you have selected the application upgrade package, click the "Upgrade" 
button:

Once the application has been successfully upgraded, please make sure that 
you restart the FusionAnalytics server before you can use the upgraded 

.application

For a more detailed description regarding upgrading FADS applications, please 
see:  .Upgrade an Application (FADS)

Back to the top

UPGRADING FADC APPLICATIONS

Once FADC has been launched (if FADC is not launched please navigate to 
FADC and) log into the Administrator.

 

Once the application(s) has been stopped, click the "Upgrade" button to upgrade 
the application:

Before you can upgrade an application, you have to STOP the 
 that you want to upgrade by clicking the "Stop" button application(s)

for the relevant application.

Navigate to your FA installation Directory, and open the "Applications" 
folder ( ). In this folder you should see FusionAnalytics > Applications
two applications (as compressed zip folders). These are the 
applications for the selected installed / upgraded instance of FA. Select 
the  (e.g. fusionreactor-fads-X.X.X-DSAPP.zip).DSAPP

Note
Before you can upgrade an application, you have to STOP the 

 that you want to upgrade by clicking the "Stop" button application(s)
for the relevant application.

released and new files 
are loaded correctly.



Click the browse button and navigate to the package you would like to upgrade to.

Once you have selected the application upgrade package, click the "Upgrade" 
button:

Once the application has been successfully upgraded, please make sure that 
you restart the FusionAnalytics server before you can use the upgraded 

.application

For a more detailed description regarding upgrading FADS applications, please 
see:  .Upgrade an Application (FADC)

Back to the top

 

 

Quick Start Guide

FusionAnalytics Quick Start Guide

Overview

Welcome to the Quick Start Guide for FusionAnalytics. Follow our  10 step tutorial
to get FusionAnalytics up and running as soon as possible.

PART 1: INSTALLATION

Step 1: Database Configuration
Follow our 3 simple tutorials to get your database ready for FusionAnalytics:

Configure Network Settings of MSSQL Server

Create a New Database Login

Create a New Database

Step 2: Installing FusionAnalytics Server
This guide can assist you with your first installation of FusionAnalytics.

Step 3: Installing the FusionAnalytics AIR Client
Make sure you have the FusionAnalytics AIR Client ready, so that you can view 
your data.

PART 2: CONFIGURATION

Step 4: Accessing FusionAnalytics
How to get to the different parts of FusionAnalytics.

Step 5: Setting Up the AIR Client
Set up your AIR Client so that you can view your data once it has imported.

   

Navigate to your FA installation Directory, and open the "Applications" 
folder (FusionAnalytics > Applications). In this folder you should see 
two Applications (as compressed zip folders). These are the 
applications for the selected installed / upgraded instance of FA. Select 
the  (e.g. fusionreactor-fads-X.X.X-DCAPP.zip).DCAPP

Before you start...
Have you installed both components of ?FusionAnalytics Server

Have you installed the  on machines that FusionAnalytics Client
you want to monitor data from?

Do you have ?FusionReactor installed

Is your database available and ready for data to be imported to 
it?

Do you have the password for the FusionAnalytics  'admin'
account ready?

Is JavaScript enabled in your web browser?



Step 6: Configuring FusionReactor for FusionAnalytics
Making sure your log files get sent to the right place.

Step 7: Setting Up Users
How to create and edit different accounts.

Step 8: Setting Up the Email Server
Receiving important notifications and reports from FusionAnalytics.

Step 9: Setting Up Application Filters
How to make the most of your application.

Step 10: Setting Up TAP and Daily Status Reports
Configuring the reporting feature of FusionAnalytics.

Next Steps

DATABASE CONFIGURATION

Configure Network Settings

Create a New Database Login

Create a New Database

ACCESSING FUSIONANALYTICS

SETTING UP THE AIR CLIENT

CONFIGURING FUSIONREACTOR FOR FUSIONANALYTICS

SETTING UP USERS

SETTING UP THE EMAIL SERVER

SETTING UP APPLICATION FILTERS

SETTING UP TAP AND DAILY STATUS REPORTS

SETTING UP THE SLA REPORTS

Database Configuration

Database Configuration

Overview

This section will help you prepare your database ready for use with 
FusionAnalytics.

Visit  for more information on the different Microsoft's SQL Server website
versions and details on how to buy. You can also use the , free Express Edition
see below for more information.

Microsoft SQL Server Express

The Express Edition is a  version of Microsoft's SQL Server. It still uses the free
same core database engine, but on a smaller scale.

There are no limitations on the number of databases or users that can be set up, 
but there are constraints on the size of each individual database, and the overall 
performance of the system.

Constraint Maximum Value

Database size 4GB for Express 2005 and 2008. 10GB for Express 2008 R2

   

Please note that FusionAnalytics currently  supports ONLY
Microsoft SQL Server.

Supported versions are: 2005, 2008, 2008 R2, 2012, 2014 and 2016

http://www.microsoft.com/sqlserver/en/us/default.aspx


Memory used 1 GB

CPUs used 1

 The maximum database size applies per database, excluding log files.

Database size

The following tables should give you a rough idea of how big your database will 
be. This information is for Microsoft SQL Server in simple recovery mode (if you 
follow the Quick Start Guide you will configure your database in this way).

High resolution data is all information stored in the database from every 
sample taken by FusionAnalytics.

Low resolution data is data that has been quantized to reduce the 
database size.

See  for more information on data quantization or Scaling and Quantization Applica
 to find out how to control the length of time this tion Configuration (FADC)

information is stored.

Next Steps

Prepare and Configure your database for FusionAnalytics:

Configure Network Settings

Create a New Database Login

Create a New Database

Once your database is ready to use, visit the  to get started.installation guide

Configure Network Settings

CONFIGURE NETWORK SETTINGS

FusionAnalytics uses  to connect to the Microsoft® SQL Server database. To allow FusionAnalytics to communicate to JDBC
the database the network settings of the database server must be configured appropriately. To configure the network 
connections of the database server start SQL Server Configuration Manager

 

Download for free: Microsoft SQL Server 2008 R2 RTM - Express 
.with Management Tools

The above figures are only an estimate based on test data. Using 
longer URLs, more parameters, more database requests and other 
details will change the results. The average URL used in the above 
data was 60 characters long from http:// to the file extension with an 
average of 1.3 JDBC requests per standard request.

http://www.oracle.com/technetwork/java/overview-141217.html
http://www.microsoft.com/download/en/details.aspx?id=23650
http://www.microsoft.com/download/en/details.aspx?id=23650


Figure 1: Starting SQL Server Configuration Manager

then select  and double click the line with the  protocol shown belowProtocols for SQLExpress TCP/IP

Figure 2: Configuring Protocols

In the  dialog set  to TCP/IP Properties Enabled Yes



Figure 3: Enabling TCP/IP

then click on the  tab and at the bottom of the property list enter  as value for .IP Addresses 1433 TCP Port

Figure 4: Configuring TCP Port



1.  

2.  

To apply the configuration changes the SQL Server must be restarted. This can be done from the SQL Server Configuration 
 shown below.Manager

Figure 5: Restarting SQL Server

Back to the top

NEXT STEPS

Create a New Database Login
Next, you will need to create a new database login for FusionAnalytics to use.

Create a New Database Login

CREATE A NEW DATABASE LOGIN

Access the MSSQL database

Open the .SQL Server Management Studio

In the  panel (located on the left side), expand the server where you Object Explorer
want to create a new login.

Enabling SQL Server Authentication

  On This Page:

Enabling SQL 
Server 
Authentication

Create a New User

More Database 
Configuration 
Tutorials:

Configure Network 
Settings

Create a New 
Database Login

Create a New 
Database



1.  

2.  

3.  

1.  

2.  

3.  

4.  

5.  

Right-click on the server and go to Properties.

In the  pop-up that appears, go to Server Properties Security.

Make sure that  is selected and SQL Server and Windows Authentication mode
click OK.

Back to the top

Create a New User

Right-click the  folder and go to  > Security New Login...

In the  dialogue that appears, enter a new login name.Login - New

 This tutorial will use  as the new login name.fadb

Select SQL Server authentication.

Enter an appropriate password in the  and  fields.Password Confirm Password



5.  

6.  

7.  

8.  

9.  

1.  

2.  

3.  

4.  

Uncheck Enforce password expiration.

Make sure  remains checked.Enforce password policy

Click the  page.Server Roles

Make sure ' ' is checked. (this is not required on SQL Server 2008 sysadmin
Standard RC2)

 This is required by FusionAnalytics to perform some of its tasks.

Click  to create the user.OK

Some tasks within FusionAnalytics require the user to have ' '  (this is sysadmin permissions
not required on SQL Server 2008 Standard RC2 . Once your user is created:)

Back to the top

NEXT STEPS

Create a New Database
Next, you will need to create a new database for FusionAnalytics to use.

Create a New Database

CREATE A NEW DATABASE

The steps below will guide through the process of creating a new Database which will be compatible with the System Requirements of 
FusionAnalytics.

Open the SQL Server Management Studio

In the  panel (located on the left side), expand the server where you want to create a new databaseObject Explorer

Right-click the  folder and go to Databases New Database...

Figure 1: Creating a New Database

In the  pop-up that appears, enter a new database name and ownerNew Database

Check if the new user can log in.
In the  panel, click   . Select the correct Object Explorer Connect Database Engine

 and enter the new login and password details. Login should be Server Name
successful but you should not be able to expand any of the  folders.Database



4.  

5.  

6.  

Figure 2: Configuring database name and owner

Next click on the little button with the three dots underneath the Autogrowth column in the first line. In the Change Autogrowth 
for FADB dialog change the setting for Autogrowth from its default value In Megabytes to In Percent as shown below.

Figure 3: Changing Autogrowth of database

Back in the New Database dialog change the Recovery Model of the database from Full to Simple mode

This tutorial will use fadb as the new database name



6.  

7.  

8.  

Figure 4: Configuring Recovery Model and Auto Shrink

and enable the database to automatically shrink its size by enabling the Auto Shrink property.

Click  to create the new databaseOK

In Server Management Studio right click on your server name and click properties.

To prevent the database log files from taking up too much disk space, the  is set to .Recovery Model Simple

Check your new database has been created
The new database should appear when you expand the  folder.Databases

Server Memory
If you do not limit the amount of memory the database can use it will be consumed very quickly.

http://msdn.microsoft.com/en-us/library/aa173531(v=SQL.80).aspx


8.  

9.  

Figure 5: Server properties

In the properties dialog click Memory. Set the Maximum Server Memory here.



9.  

Figure 6: Allocating memory

Back to the top

NEXT STEPS

Installing FusionAnalytics Server
Visit the installation guide when you are ready to get started with FusionAnalytics.

Accessing FusionAnalytics

Accessing FusionAnalytics
There are three different parts of FusionAnalytics that you can access using the  account. These are DataCollector, 'admin'
DataServices and the Client. For more information on what each component does, please see the FusionAnalytics User's 

.Guide

FUSIONANALYTICS SERVER

The following URLs can be used for direct access to each component. The FusionAnalytics Dashboard provides links to the 
DataCollector and DataServices components.

Component URL

Dashboard http://localhost:8400

FusionAnalytics DataCollector (FADC) http://localhost:8400/fadc

 

We recommend allocating  of available memory to the databasebetween 1 third and 1 half

http://localhost:8400
http://localhost:8400/fadc/user/login


FusionAnalytics DataServices (FADS) http://localhost:8400/fads

Back to the top

FUSIONANALYTICS CLIENT

To access FusionAnalytics, you can use either the  or a .AIR client web client

Component URL

FusionAnalyti
cs Client

http://localhost:8400/fads/myFADSApplicationName

 You will need to replace  with your actual FADS application name. If you 'myFADSApplicationName'
followed the  this will be .installation tutorial coldfusion9

To access the AIR Client:

You can double-click the FusionAnalyticsAir icon on your desktop.

The next step of this tutorial will help you with .Setting Up the AIR Client

To access the Web Client:

You can login to FADS and click the Launch button on the application you want to view (Figure 1).

You can also enter the above URL into a web browser's address bar.

 

Figure 1: Launch Application

Logging In

You can login to FADC, FADS and the Client using:

Username: admin

Password: The password you defined in the   Administrator Password screen during installation.

We will set up more users later in the configuration tutorial.

Back to the top

If you are using another hostname and not the "localhost", you can change that part of the URL to the machine 
name that you want to access. If you changed the HTTP port number from the default (8400), then you will need to 
use the configured port.

http://localhost:8400/fads/login.jsp
http://localhost:8400/fads/myFADSApplicationName




Next Steps

Setting Up the AIR Client
Set up your AIR Client so that you can view your data once it has imported.

Setting Up the AIR Client

Setting Up the AIR Client

AIR CLIENT CONFIGURATION

The FusionAnalytics AIR Client uses URLs to identify and connect to the server.

They follow the same pattern: http://127.0.0.1:8400/fads/myFADSApplicationName

This is broken down as follows:

URL Element Description

http:// HTTP is the default. See the tutorial on  for secure connections.Setting Up FusionAnalytics with HTTPS

http://127.0.0.1:8400/fads/myFADSApplicationName


127.0.0.1 The machine where FusionAnalytics Server is installed. This example uses the local machine, so the address is 127.0.0.1.

8400 The machine port. If you changed the default port during the installation, use that instead; if not, use the default (8400).

/fads The fixed path to DataServices.

/myFADSApplicationNa
me

The name of the DataServices application you want to connect to. If you used the suggested name from the , this will be installation guide
coldfusion9.

Enter this into the URL box at the top and click . A shortcut will be created (Figure 1), which you can double-click to go to the login page for that application.Add Application

 

Figure 1: AIR Client Shortcuts

At the login page, you should then enter your username and password (Figure 2).

To begin with, you can use the  username and password that you set up during the .'admin' installation of FusionAnalytics Server

We will set up more users later in the ?  tutorial.Setting Up Users



 

Figure 2: Login Screen

Back to the top

Alternatively

If you do not have an AIR client available, you can also access the client in your web browser.

The same URL can be entered into the address bar  you can access the FADS application and navigate to and click  on OR Applications > Application Summary Launch
the application that you want to view (Figure 3).

 

Figure 3: FADS Launch Button

Back to the top



Next Steps



Configuring FusionReactor for FusionAnalytics
Set up FusionReactor so that data from your server is sent to FusionAnalytics for you to analyze.

Configuring FusionReactor for FusionAnalytics

Introduction

This section is going to guide you through the process of configuring FusionReactor for FusionAnalytics.

Configuring FusionReactor for FusionAnalytics

Firstly, you will need to login to the FusionReactor instance that you want to use to send data to 
FusionAnalytics.
To do this, navigate to  (Figure 1).FusionReactor > Logging > Settings 

Figure 1: Navigating to FusionReactor Logging Settings

This will display the  pop-up (Figure 2). In order to see how to configure FusionReactor Logging Settings
these, go to .Log Settings

Figure 2: FusionAnalytics Log Settings

For this tutorial we will keep the Connector Mode and FRAM Service as the default options. We 
will only add a FusionAnalytics Target.

After the configurations above, you need to set up the . To do this, please navigate FusionAnalytics Targets
to  (Figure 3). Analytics > FusionAnalytics Targets

Under the displayed tab, click on the button. This specifies where the log files from Add New Target 
FusionReactor will be sent.
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Figure 3: FusionAnalytics Targets

In the screen that appears (Figure 5), fill in the following:

Field Description

Host The machine where FusionAnalytics is installed. This example uses the local machine, so the 
IP address is 127.0.0.1 or localhost.

Port The machine port. If you changed the default port during the ? , use that instead; if installation
not, use the default (8400).

Appli
catio
n 
Name

The name of the DataCollector Application that you want to collect the data. If you followed 
the example in the installation guide, this will be .coldfusion9

Data
Colle
ctor

The name of the actual DataCollector that you want to receive the data. Each DataCollector 
application can have multiple DataCollectors that receive data. The default setting is one 
DataCollector named .faDataCollector-1

User
name

The username for a user who has access to the DataCollector application. This is only used 
if the DataCollector requires authentication. If you are using the default setting, this is not needed.

Pass
word

The password for the above username.

HTT
PS

Check this box if your DataCollector uses HTTPS. For more information on this see Setting 
.Up FusionAnalytics with HTTPS

Status Once you have entered in the details, click    to check that you are connecting to a Test Target
valid DataCollector.

If you are following the tutorial, you should fill in the form as shown in Figure 5.

If you are happy with the settings, click the  button and after that press the Save Target Settings Test 
button in order to check if the connection is okay. If the connection is okay, you should be able to Connection 

see a message.200 OK  

  If you want to configure the Connect Mode, please navigate to Analytics > FusionAnalytics Settings.
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If you want to learn more about DataCollectors, including authentication and multiple DataCollectors 
within an application, see   in the  .Applications (FADC) FusionAnalytics User's Guide
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Figure 4: FusionAnalytics Settings

 

Back to the top

cu
me
nta
tion

Edi
t 
Fu
sio
nA
nal
ytic
s 
Co
nn
ect
or

Lo
ggi
ng

An
aly
tics

Next Steps

Setting Up Users
Add more users to and allow them to view specific applications.

Setting Up Users

Introduction

This section is going to guide you through the process of setting up new users to your FusionAnalytics application.

Setting Up Users

You can configure more user accounts for FusionAnalytics by navigating to  > . To add a new user click the  button at the top of Users Users Summary Create A New User
the screen (Figure 1).

Figure 1: Users Summary

Seeing your data in FusionAnalytics
When you connect FusionReactor to FusionAnalytics, the data will not instantly appear. You will 

. If you want to force a transfer, in FusionReactor go to need wait for a transfer to occur Analytics 
. Click  to send the logs to FusionAnalytics. You will need to wait for > Connector Status Transfer

each log to be processed by FADC before the data will be available in the Client.

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Adding a New User

By the time you press the Create a New User button, you will be required to enter a new  and  (Figure 2).  and  fields are Username Password First Name, Last Name Email
optional.

The password strength meter can help you choose a secure password and check that the two fields match. A secure password has to contain upper and lower case letters 
combined with numbers and special characters.

Click the button when you have finished entering their details.Add New User 

Figure 2: Creating a new user

Back to the top

ADDING MAPPINGS TO A USER

Once you have added the user, you can add any application mappings they might need (Figure 3).

There will be a list of applications under  Choose a role type from the drop down list and click Available Application Role Mappings. Add Role.

The application will now appear under a list of Current Application Role Mappings.

Please note that depending the license key you obtain, you will be able to configure the appropriate number of users. For example, the S Pack allows maximum 5 
users. More information can also be found in the link, . Additionally, you can also check the FAQ .FusionAnalytics Pricing here

For information on the differences between Administrator and User accounts, see ??User Mappings in the ? .FusionAnalytics User's Guide

http://www.fusion-analytics.com/pricing/
http://docs.intergral.com/display/FA206/Licensing+FAQ


Figure 3: Application Mappings

Back to the top

*Logging in as your new user*
For an Administrator: Log out of FADS and log in as the new user. You will only see applications you are mapped to. You can also try logging into the client.

For a User: Try logging into the client using the new user account.



Next Steps

Setting Up the Email Server
_Configure the email server so that you receive important notifications and reports from FusionAnalytics.

Setting Up the Email Server

Introduction

This section is going to guide you through the process of setting up an Email Server with FusionAnalytics. An email server needs to be 
configured in case you want to receive  and  from FusionAnalytics.notifications reports

Setting Up the Email Server

In FADC this can be found under   (Figure 1).System > Email Settings

Please note, the configuration of the email server must be completed for  Fusion Analytics DataCollector (FADC) and FusionAnalytics DataServices (FADS).both



Figure 1: FADC Email Settings

In FADS, it is under  (Figure 2).System > Server Settings

Figure 2: FADS Email Settings

The  should be the email address that you want any notifications sent from.From Address

The  is the email address(es) that all notifications are sent to; you can enter multiple addresses, as long as they are separated by a comma.To Address

The  field is needed for  reports and notifications. This will need to be set to the name or IP address of the server that sends SMTP mail messages; e.g. Mail Server all mail.
company.com:25.

By default the port number is set to 25, in case you are using another port, this can be configured like the following example: . If you 172.0.0.1:{port number configuration}
need to provide authentication, you will need to put this in front of the address: . username:password@mail.company.com:25

Back to the top

You should use an appropriate hostname or IP address for the  and above as these values are also used in URIs HTTP Server Host HTTPS Server Host 
embedded in reporting emails.

These addresses do not apply to the  (which allows you to receive TAP and Daily Status reports on the status of your server by reporting feature of FusionAnalytics
email). You can set different email addresses for these.





What Next?

Setting Up Application Filters
Configure the application filters to view specific types of request.

Setting Up Application Filters

Introduction

This section is going to guide you through the process of setting up application filters. The application filters are going to allow you to 
filter specific requests within the application based on their URL or user-defined parameters.

Setting Up Application Filters

To get the most out of FusionAnalytics, you should set up the Application Filters.

In the FusionAnalytics Web Client, please navigate to   (Figure 1). Enter a name for your application and click the Administrator > Manage Applications Add Application 
 button.Filter

Figure 1: Application filters

The new application filter will appear in a list of . It will be ' ' and ready to configure (Figure 2).Current Application Filters opened

You can open and close the filters by clicking the  button.

You can add any filters that you need by defining the URL path of the request, or setting specific request parameters. To add a  filter, select a path Request URL

option and enter an argument. For  you will need to enter both a filter and argument. Click  to add the filter.Request Params

In the example below (Figure 2), the    apps filter would show you the following requests:

http://localhost:8500/apps/testpage.cfm

http://localhost:8500/apps/newfolder/testpage2.cfm

It would not include these requests:

http://localhost:8500/apps/ignorethispage.cfm

http://localhost:8500/apps2/newpage.cfm

You must be logged in as an  or  to have access to the Application Filters.Administrator System User

http://localhost:8500/apps/testpage.cfm
http://localhost:8500/apps/newfolder/testpage2.cfm
http://localhost:8500/apps/ignorethispage.cfm
http://localhost:8500/app2/newpage.cfm


Figure 2: Newly added application in the Current Application Filters

To view the result of your new application filters, click the  button on the menu to the left (the table of contents). Now expand Refresh Tree Deep Server Analysis > 
. You will see the filters that you have defined (Figure 3).Applications

Figure 3: Filters in the TOC

Within each filter you can view a selection of charts and graphs, such as ,  and , specifically for the Slowest Requests Most Popular Requests Slowest DB Requests
requests you have filtered.

To add multiple filters, just enter a new, unique name in the  section and click .Add New Application Add Application Filter

For a more detailed look at the application filters, including deleting, modifying and copying, see ?  in the ? . Manage Applications FusionAnalytics User's Guide



1.  
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Next Steps

Setting Up TAP and Daily Status Reports
The final stage in this configuration tutorial is setting up daily reports that can give you information on how your servers are performing.

Setting Up TAP and Daily Status Reports

Introduction

This section is going to guide you through the process of setting up TAP reports and Daily status reports.

FusionAnalytics supports two types of reports:

TAP Reports: These provide a daily application score and trend analysis, based on your system's Traffic, Availability and 
Performance (TAP).



2.  Daily Status Reports: Aimed at more technical users, these reports give a complete breakdown of the performance for the 
whole application and individual Application Filters.

Setting Up TAP and Daily Status Reports

Viewing Application Tasks

In FADS, under the  you can find the two types of reports that can run for each application (Figure 1).Scheduled Tasks > Application Tasks Summary

These are already configured for you with each new application.

By default, the TAP report is running every day at 4:15 AM while the Daily Status report is running every day at 4:30 AM.

Figure 1: Pre-scheduled Application Tasks for the coldfusion9 application

By the time the reports have been executed, they can be viewed in the FusionAnalytics Web Client, under the .Business Metrics > Reports

Receiving Reports as Emails

A major feature of FusionAnalytics is that it is able to email you a daily report, so that you can easily keep track and analyze its performance.

Click  to enter the configuration screen for a report (Figure 2 shows editing a Daily Status Report).Edit

You must have completed the Setting Up the Email Server part of the   tutorial.Quick Start Guide



Figure 2: Editing a Daily Report

Under provider arguments, enter  as the name and a valid username as the value (Figure 3).'users'

 Make sure the users have email addresses set. This can be changed under Users > Users Summary.

Multiple user names can be entered if they are separated by a comma (but no space).

Figure 3: Entering provider arguments

Click . The next time the reports run, they will be emailed to the selected users.Update Task

Back to the top

You will need to repeat this for the TAP Report, so that both reports get emailed!

Both these reports gather data from the previous day, so you will need to wait  before these reports begin to show any data.24 hours



Next Steps

FusionAnalytics User's Guide
You have now finished configuring FusionAnalytics! Visit the User's Guide for more information on specific parts of FusionAnalytics.

FusionAnalytics Reporting
Visit this section for more information on these reports, including more configuration options and understanding the report data.

Setting up the SLA Reports

Introduction

This section provides a quick start guide for configuring and running  SLA Reports in FusionAnalytics. For detailed information, please 
check out this link, .full SLA Report documentation

SLA Report Configuration - Quick Start Guide

STEP 1: ACCESSING THE SLA REPORT CONFIGURATION PAGE

To access the SLA configuration, please launch the FusionAnalytics Web Client 
(see  ) and navigate to FusionAnalytics Client Administrator > SLA Report 

.Configuration

STEP 2: ADDING A NEW REPORT

Choose a suitable report name and enter it into the text field. Click the "Add 
Report" button in order to start configuring your new report.

STEP 3: SCHEDULE AND EMAIL PREFIXES

Once you have added a new report you will be presented with the configuration 
screen.

Configure the options to suit your needs. For more detailed information, check out 
this link, .The SLA Report Configuration
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For this tutorial we'll choose to run a report every day, and every Monday for the 
previous week Mon-Sun. We'll also replace the email subject with "Demo Report" 
and prefix it with "(S)" if our report is successful and "(F)" if not.

Press "Save Configuration" button in order to save these changes.

STEP 4: EMAIL RECIPIENTS

Next we'll configure who is going to receive our report via email.

Click the s tab.Email Recipient

Here you have two options:

Add a recipient from existing FADS users. For this, click the "Add from 
users" button to see a list of viable users. Only users mapped to this 
application will be visible in this list.

Add a custom email address and description. Simply enter the email 
address and description for this address and click the "+" icon to add it as 
a recipient.

STEP 5: DOMAIN FILTERS

The Domain Filters tab allows you to configure which domains to either include or 
exclude from your report.

Assume our demo server receives requests from the following 3 domains:

domain1.intergral.com

domain2.intergral.com

domain3.intergral.com

We might want to only include the first two domains on our report, or exclude the 
first and third domains and display everything else.

For this example, we'll leave this tab blank.

STEP 6: THRESHOLDS

This tab allows you to configure the target thresholds for your report. These 
values will determine whether your report has passed or failed and will effect the 
way the email is displayed.

 

The report is configured with some default values, but we recommend adjusting 
these to match your server requirements.

For this example we will use the values shown in the image below.
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The threshold targets are for a single day. If you run weekly or monthly 
reports, Outage and Total Request targets will be multiplied by the 
number of days on your report.
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STEP 7: SENDING THE REPORT EMAILS

You need to schedule the time at which data for the reports should be generated 
and the emails should be sent.

From  navigate to FusionAnalytics Server (FADS) Scheduled Tasks > 
 to view this report task. If you like, you can click the Application Task Summary

"Run Now" button in order to generate the emails immediately.

To change the time that the emails are sent, click the  button.Edit

Next Steps

Read the full documentation for the SLA Reports:  .SLA Reports

FusionAnalytics User's Guide

FusionAnalytics User's Guide

Overview

Introducing FusionAnalytics - After FusionAnalytics has been installed the User's 
Guide will help you getting started and up to speed with FusionAnalytics. This 
guide will discuss how FusionAnalytics is organized and how it can be used 
including detailed documentation on both the Client and Server.

Next Steps

GETTING STARTED

How FusionAnalytics Is Organized

Expandable and Extensible Platform

Scaling and Quantization

Exploring Data

FUSIONANALYTICS CLIENT

Getting Started with the FA Client

The FusionAnalytics Web Client

The FusionAnalytics AIR Client

Using the Table of Contents (TOC)

Date Navigation

Time Zones

Filtering Data

Data Visualizations
DataGrid Visualization

Chart Base Visualization

Time Block Chart Visualization

Placemark Chart Visualization

Sixway Chart Visualization

WARNING
Do not change any value on this screen except the hour on the 
"Recurring" row. The configurations on this screen are for Daily 
Status and TAP reports and should not be changed for SLA.

If you wish to disable SLA reports, you should do it from the 
configuration shown above by choosing not to run daily, weekly 
or monthly reports. See .here

#
#
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Reports

Administrator
Manage Applications

FusionAnalytics DataServices

FusionAnalytics DataCollector
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APML Volume Switching

Component

Data Provider Programs

Layout

Configuring Report Images

FusionAnalytics Licensing

MOVE FUSIONANALYTICS TO A NEW SERVER

Getting Started

Getting Started

Overview

This document will help you to explore and evaluate FusionAnalytics, a tool to visualize log data. We'll introduce the architecture of the 
system, show you how to use the client and server packages, explain the terminology, and touch briefly on the extension points.

Let's get started by explaining what FusionAnalytics is, and what it can help you do.

Next Steps

How FusionAnalytics Is Organized

Expandable and Extensible Platform

Scaling and Quantization

Exploring Data

How FusionAnalytics Is Organized

HOW FUSIONANALYTICS IS ORGANIZED?

FusionAnalytics is organized into  main areas, listed below.three

 

: How FusionAnalytics is organizedFigure 1
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FusionAnalytics DataCollector

The  is responsible for gathering information, transforming it, and writing it to a database. The DataCollector DataC
 provides fine-grained control over what raw information is loaded, and how it is transformed. It's also able ollector

to aggregate data to speed up analytics queries.

Learn more...

FusionAnalytics DataServices

DataServices hosts , supplying services like caching, persistent storage, database Analytics Applications
connections and reporting.  is responsible for communicating with the , answering DataServices AIR Desktop
queries for analytical information, and managing authentication and sessions.

Learn more...

FusionAnalytics AIR Desktop

The  is the user interface to the FusionAnlytics system. This is the component which allows you to AIR Desktop
navigate and control an Analytics Application, and displays the generated analytical information.

Learn more...

FusionAnalytics Applications

FusionAnalytics Applications are applications hosted by the  and/or . They can for DataServer DataCollector
example load  data into a database via the  to provide insight and analytics on that FusionReactor DataCollector
data via the . FusionReactor is able to store many requests online for an immediate diagnostic view DataServices
about the health of a server, but is not able to provide information about long-term data – this is to ensure that 
FusionReactor is small and fast and doesn't provide much overhead when installed.

FusionReactor , however, generate extensive log data. This data can be mined by the FusionAnalytics can
DataCollector and stored in a database. Together with the advanced functionality provided by FusionAnalytics, this 
data can then be used to provide valuable insight into long-term trends.

The high-resolution data is naturally still available - you can zoom down from months to milliseconds using our 
intuitive timeline control.

Learn more...
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Expandable and Extensible Platform

EXPANDABLE AND EXTENSIBLE PLATFORM

FusionAnalytics is a platform for visualizing data. The  and  do not place any restrictions on the type of ANY  DataCollector DataServices
data in use.

In order to specialize the platform for a particular system, we devised the concept of . These run within FusionAnalytics Applications
the FusionAnalytics platform, and adapt it to a specific type of data.

There must be two applications for every type of data you want to visualize:

A  (DataCollector Markup Language) which tells the how to load and interpret log data, and DCML application DataCollector 
into which database tables it should be loaded.

An  (Analytics Provider Markup Language) which tells which views are available in the client, APML application DataServices 
and how to generate data from the database to serve those views.

Both application packs, DCML and APML, are based on an XML syntax.  Both can be extended using scripting languages.

Scaling and Quantization

SCALING AND QUANTIZATION

Most views in FusionAnalytics are navigated using the  control.  This innovative component allows you to zoom in TimeLine
and out, as well as scrolling forwards and backwards in time.  The control supports a huge range---you can zoom in to a 
millisecond or out to a decade.

Naturally, the data must also support this.

The Analytics for FusionReactor application makes this possible by generating sets of data at different resolutions.  We call 
this  data since it has been combined and aligned to one of several preset values:  one minute, one hour, one day quantized
and 30 days.

   

http://www.fusion-reactor.com/


Most of the views we provide automatically switch to the most relevant data set as you zoom in and out, always providing the 
quantization level which fits best, and never overloading the visualizations with too many data points.  A dual-level (Client and 
DataServices) cache further speeds up data delivery, using a dynamic hinting process to pre-fill what we think you'll want to 
look at next.

If you're only interested at long timescales, the high-resolution (millisecond-scale) data can be purged after it's been 
quantized, saving space in the database.

Now let's have a quick look over the architecture of the system, and then get FusionAnalytics installed and importing data.

High Resolution Data

High resolution data is stored differently depending on where the data has come from:

For requests and JDBC, all information about every request is stored in the database.

For resources (cpu, memory etc) FusionReactor takes samples at a set time interval (default 5 seconds). The current 
status and details about the resource is stored at each sample.

High resolution data is very detailed information about your server. All of the information taken from every sample/request is 
stored in the database allowing you to see accurate and detailed statistics. While this is very useful, it consumes a large 
amount of disk space and so we recommend only storing high resolution data for a short period of time for extremely accurate 
deep server analysis.

Low Resolution Data

Low resolution data has been quantized to greatly reduce the amount of disk space that is required. As explained above, data 
is quantized and aligned to one minute, one hour, one day and 30 days which can then be used when analyzing data in the 
FusionAnalytics perspectives. This information is useful if you want to analyze your server over long periods of time.

How the quantizer works

When a sample is taken by FusionReactor or a requests are sent to the server, the information gathered is stored in the logs. 
This is very precise and there is a lot of data gathered over a short period of time. At some point after the logs are transferred 
from FusionReactor to FusionAnalytics, the quantizer runs, gathering data for the appropriate alignments listed above and 
take averages creating compressed copies of the high resolution data. These averages are stored as quantized data.

Take a look at the image below. This shows an example of high resolution resource data taken over 1 hour. When the 
quantizer runs it takes an average of these samples and stores it as the quantized value for that time frame.

 

Figure 1: How the quantizer works

Data Truncation

If you choose to keep high resolution for one week, then any information over a week old will be deleted. This means you will 
always the most recent high resolution data for the previous 7 days. Similarly if you choose to keep low resolution data for one 
year you would always have low resolution stored for the previous 356 days.

In FusionAnalytics you can choose how long you wish to store High Resolution and Low Resolution data for each 
FusionAnalytics for FusionReactor application. Please see the  Application Configuration (FADC) for details on how to do this.

Exploring Data



Introduction

FusionAnalytics offers different tools and techniques that can be used to help Explore Data. Some of these tools include:

FILTERING DATA

FusionAnalytics gives you a lot of data so it is useful to be able to focus in on just the information you want. The type of filters available to you will differ depending upon 
the type of perspective. You will see a tab at the bottom of the perspective for each type of filter available (if any) For more information, check out the link .Filtering Data

DATE NAVIGATION

Most of the perspectives in FusionAnalytics are time based so, if you want to explore your data further, you will want to change the span of time that you are currently 
viewing. At the bottom of time-based perspectives you will see a tab named " ". By default the  will be in Basic Mode. For more information, please TimeLine TimeLine
check out the link, .Date Navigation

TIME ZONES

FusionAnalytics allows you to view graph and table data in the Time Zone of your choice. By default, this will be set to your local Time Zone. (ie, the Time Zone in which 
the FusionAnalytics Client is running.) If you want to change your viewing Time Zone then you can select a new Time Zone from the drop down box in the top left of the D

 area. For more information, please check out the link, .ate Navigation Time Zones

 

CONTEXT MENUS

Context Menus are used throughout the Client to help navigation and link data within applications. Context Menus are attached to and can be used with most Data 
... For more information please see .Visualizations Context Menus

USING TABS

Whenever you click on an item from the  a new perspective will be opened in the content area. This perspective will be opened in a new tab. Table of Contents (TOC)
Tabs appear along the top of the content area and can be interacted with in various ways. The simplest way to switch between tabs is simply to click on the tab you want 
to view. The content of that tab will then be made visible. For more information, please check out the link, .Using Tabs



USING STATE STORES

The State Store feature is designed to allow you to store the current state of a perspective so that you can return to it at a later point in time. The State Store will save the 
current  as well as any currently defined .... For more information please see .date range filters Using State Stores

DATA VISUALIZATION

FusionAnalytics provides different Data Visualizations that are used to render data. For example:

The : used to render data in a "list" based format.DataGrid Visualization

The : used to display / represent data within a chart / graph making data interpretation more "visible"Chart Base Visualization

The : used to render a large amount of data points providing a more detailed visualization (picture) of data at any one timeTime Block Chart Visualization

For more information on the above Visualizations (and more) please see .Data Visualizations

FusionAnalytics Client

FusionAnalytics Client

Overview

This section will discuss the FusionAnalytics Client in detail including information 
on how to set the clients (both Web and AIR) up and how to add, launch and use 
applications within the clients. This section will further discuss the different 
components and visualizations included in the client and how they can be used 
(including the best ways) to use the application (tools and components) to explore 
and analyze data.

Next Steps

Getting Started with the FA Client

The FusionAnalytics Web Client

The FusionAnalytics AIR Client

Using the Table of Contents (TOC)

Date Navigation

Time Zones

Filtering Data

Data Visualizations

DataGrid Visualization



Chart Base Visualization

Time Block Chart Visualization

Placemark Chart Visualization

Sixway Chart Visualization

Application Menus

Using Tabs

Using State Stores

Context Menus

Business Metrics

Reports

Administrator

Manage Applications

FusionAnalytics DataServices

FusionAnalytics DataCollector

Getting Started with the FA Client

Getting Started with the FA Client

Login

After launching the  the first screen you will be taken to will be the login screen. Enter your log in credentials (Username and Password) here The FusionAnalytics Web Client
and click Login to enter the client.

 

: Client login panelFigure 1

Back to the top

Default Perspective



In FusionAnalytics, perspectives are essentially different views that can be displayed on the screen. Once you have entered the client, the first perspective you will see is the 
"Overview Perspective".

The Overview Perspective is the default Perspective and (like most Perspectives in the application) is date/time-based. The perspective contains two visualizations, 
FusionReactor System Metrics and Server Summary, providing an instant insight into server utilization including :

Breakdown server utilization by hostname (per project/customer/language)

Total Response Size

Average Execution Time - per site

Total Execution Time

 

: Default PerspectiveFigure 2

You will notice that the application layout is split into two columns:

Table Of Contents (Left side) - This navigation menu allows you to navigate around FusionAnalytics and access different perspectives and features.

Perspective Canvas (Right side) - This is the panel where perspectives are displayed. This is where your server information is visible and the timeline control can be 
adjusted.

Date Navigation

At the bottom of the Overview Perspective you will see a tab named "Timeline" containing the  component :Date Navigation

 

: Timeline ControlFigure 3

You can use the  component to explore data further allowing you to change the span of time that you are currently viewing. By default the Date Navigation Date Navigation
component will be in . In this mode you can select a unit of time (Hours, Days, Weeks, Months or Years) and then select a range of those units to be the span of Basic Mode
time you are interested in seeing analytics data for. Clicking on one of the "unit" buttons will switch to that unit of time. You can also change the mode (from Basic to Timeline 

 or ) if preferred by switching between the three mode toggles on the left of the control.Mode Calendar Mode

Back to the top



Locking and Updating

 You may have noticed that even though you have been changing the time span, the data within the current perspective has NOT yet been updated.    At any point you 
can click the "Update" button and your perspective will be refreshed showing the currently selected span of time. Even if you have not changed the current time span, you can 
click the "Update" button to get the most recent data from FusionAnalytics.

There are many situations in which you would want graphs to automatically be updated as you scroll through time. In this case you can lock the TimeLine. Click the "Lock" 
button to toggle this feature on and off. Whilst locked, your perspective will be updated whenever you change the currently selected timespan.

Date Navigation^ts_lock.jpg! 

: Lock and Update ButtonsFigure 4

Back to the top

Reports

Using the Table Of Contents (left column) navigate to " " to open the Reports perspective. The reports Perspective includes a DataGrid containing Business Metrics > Reports
all of the reports that are relevant to the Application.

 

: Reports PerspctiveFigure 5

To open a report, either double click on the report you would like to open or right click on the report and select "Open Report".

Once authenticated, the selected report (in this case ) will then open in a new tab:TAP

Note: If you have the Timeline "Locked" whilst browsing through data then FusionAnalytics will constantly be requesting new data to show.  In this case you may 
find that the performance is slower than having the Timeline "Unlocked".   In general, we recommend that you have the Timeline "Unlocked" and use the "Update" 
button to refresh data once you have navigated to the point in time you are interested in.

Note: FusionAnalytics will ONLY show reports which have been generated on the dates which you have selected in the Date Navigation component.

Note: The first time the report is opened Authentication may be required to view the reports (within the Web Client). If so simply enter the credentials for the 
application and click OK:



Tap Report

 

: TAP ReportFigure 6

To open another report simply repeat the same process by going back the the Reports Perspective (within the ) and selecting and opening a new report:Tab Navigator

Daily Status Report

TAP Report: The objective of the  index is to give application & program managers, business owners and solution stake Traffic, Availability and Performance (TAP)
holders, a less-technical orientated metric on their servers. FusionAnalytics makes suggestions on how to improve your TAP score, as well as measuring and 
comparing TAP performance over time.



 

: Daily Status ReportFigure 7

Back to the top

Deep Server Analysis

At the heart of FusionAnalytics is the wealth of information gathered and transferred from FusionReactor. This instrumentation includes requests, SQL statements, response 
times, CPU and memory information, as well as URL parameters, heap memory usage and JMX statistics. FusionAnalytics takes all of this information and builds a series of 
combined visual perspectives, allowing you to visualize all transactions, SQL queries, data transfer, server events etc. taking place over time, so you can build a complete 
historical view of what happened on your server. This data is essential to support investigative analysis, continuous server analysis and application improvement. With over 
80 different analytic views and reports, FusionAnalytics gives you unlimited insight into exactly what's happening on your server.

For Example: Using the TOC Navigate to " " to open the Slowest Request Perspective:Deep Server Analysis > Request > Slowest Request

Daily Status Report: The  are intended for use by technical developers, project leads as well as project managers and system administrators. Daily Status Reports
The Status Report contains a complete breakdown of your application / server performance as well as specific slow running requests which need improvement.

Note: All deep server related perspectives are listed under the "Deep Server Analysis" menu item within the Table of Contents.



 

: Slowest Requests PerspectiveFigure 8

Within the Slowest Requests Perspective, the top 100 slowest requests (within the the specified time frame) are listed allowing detailed analysis to be performed to help the 
identification of key areas that can be optimized. You can see more in depth information for each request by right clicking on a request and selecting the "Request Details" 
menu item.

 

: Slowest Requests Context MenuFigure 9

This will open the Request Details perspective for the selected request in a new tab:



 

: Request Details PerspectiveFigure 10

The Request Details perspective shows all the details of the actual (selected) request, including , , , , , URL Start/Finish time Status code execution time thread-ID request 
,  (at time of execution) etc.method memory metrics

The perspective offers further useful information related to the request including , ,  and  which can be Request DB Details DB requests DB Breakdown Request Breakdown
accessed using the toggle buttons that are rendered below the Request Details DataGrid. For example, to see where the database time is being spent on a query by query 
basis relevant to the the selected request click the "DB Requests" toggle button just above the timeline.

 

: DB Query Execution TimeFigure 11

With the database breakdown tab, mousing over a segment of the pie chart will reveal the actual SQL statement being called.



To compare processes CPU usage and process memory usage, again using the Table of Contents navigate to Deep Server Analysis > CPU > CPU / Memory Usage to open 
the CPU and Memory usage Perspective:

 

: CPU/Memory Usage PerspectiveFigure 12
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The FusionAnalytics Web Client

The FusionAnalytics Web Client
You can access the Web Client from  or by pasting the application URL directly into a browser (if known).FusionAnalytics DataServices (FADS)

If you open , by default you will be taken to the application overview page. For each application defined within FusionAnalytics (listed under FADS Applications > Application 
) you will see a " " button.Summary Launch

 

: FusionAnalytics DataServices (FADS)Figure 1

If you click on this " " button, the  will appear in a new browser window.Launch Web Client

Remember: If you want to change the time span at any time you can do so at any time using the Date Navigation Component



You will also see the application URL which can be copied and used to access the Web Client directly by pasting the URL into a web browser or alternatively into the AIR 
.Client

After launching an application the first screen you will be taken to will be the Login screen. Enter your log in credentials (Username and Password) here to access the rest of 
the client:

 

: Client login panelFigure 2

Back to the top

NEXT STEPS

An Example URL of the is the following:Web Client 

http://serverName:8400/fads/applicationName

Please make sure that you change the "applicationName" from the URL above to match the name of your application.

http://servername:8400/applicationName


The FusionAnalytics AIR Client - Learn how to access multiple different FusionAnalytics Applications using the FusionAnalytics 
AIR Client

FusionAnalytics DataServices (FADS) -    Learn about FADS and how it can be used in relation to System (Settings, Sessions, 
      Controllers, Jobs ...), Applications (Summary, Configuration, Detail, Scope ...), Users and Scheduled Tasks (both System and 

User tasks).

The FusionAnalytics AIR Client

The FusionAnalytics AIR Client
Unlike the  which you launch directly from , the FusionAnalytics AIR Client allows you to access multiple different Web Client FusionAnalytics DataServices (FADS) FusionAnal

 (even running on different servers) from a central location.ytics Applications

Adding Applications

When you first launch the AIR Client, you will be taken to the Server summary screen. This will initially be empty so you will need to ADD a link to an existing 
. To get this URL you need to go to the FusionAnalytics DataServices ( ) screen. By default you will see the Application Summary page.FusionAnalytics Application FADS

 

: FUsionAnalytics DataServices (FADS)Figure 1

Locate the application that you want to add to your AIR Client and you will see a URL displayed. If you click the URL then it will be copied to your clipboard.

 

:click to copy to clipboardFigure 2

Once you have copied the Application URL, return to the AIR client. At the top of the Server Overview screen you will see an input box with a button to the right saying "Add 
Application". Paste the Application URL into the text box and click the button.

http://docs.intergral.com/pages/viewpage.action?pageId=34898074


 

: Paste application URL into the FusionAnalytics AIR clientFigure 3

A new icon will appear in the main screen area representing the application.

Back to the top

Editing / Deleting Applications

If you want to or  an application link, you can right-click on the icon and the two options will appear.Edit Delete

 

: Editing / Deleting ApplicationsFigure 4

Selecting Delete will remove the icon from your AIR Client. (Note: This will have no effect on the actual application.) If you select Edit then the Edit Dialog will appear. Here 
you can change the details of this application link.

Note: when you mouse over / highlight an application icon, you will see a small "delete" button in the top right of the application icon. You can also delete / remove 
an application from the AIR client by clicking this button ).(this will have the same effect as clicking the "delete" menu item from the icons context menu



 

:Edit Server Details panelFigure 5

Back to the top

Logging into Applications

To log into a FusionAnalytics application from the AIR client, simply double-click on the requested server icon and you will be taken to the Login Page for that application. 
Enter your Username / Password to access the rest of the client.

 

: client login panelFigure 6



Unlike the Web Client, once you have logged into the AIR client you will have an extra "Logout" option in the "Application" menu. Selecting Logout from this menu will return 
you to the Server Summary screen.
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NEXT STEPS

The FusionAnalytics Web Client - Learn how to log into and use the FA Web Client

FusionAnalytics DataServices (FADS) -    Learn about FADS and how it can be used in relation to System (Settings, Sessions, 
      Controllers, Jobs ...), Applications (Summary, Configuration, Detail, Scope ...), Users and Scheduled Tasks (both System and 

User tasks).

Using the Table of Contents (TOC)

Using the TOC
When you log into an application through the FusionAnalytics Client (either the  client or the ) you will be Web Client AIR Client
taken to a screen showing the TOC (Table of Contents) and Content Area. By default the Content Area will be showing the Ov

 perspective:erview

 

: Default Perspective showing the TOCFigure 1

If you wish to view any of the other perspectives within FusionAnalytics then you can launch them from the TOC. The TOC is a 
simple tree navigation component containing perspectives. Launch a new perspective by left-clicking on it. You can also open 
folders by left-clicking them (expanding the menu items).

 

Remember Password
To remember the login credentials for this application click the "Remember Password" check box (the username remembered by default for each application) and 
then the next time you log into this sever the password filled will be pre-filled so you can simply (and quickly) click the "Login" button to log into the application.



 

: TOCFigure 2

You will notice three buttons rendered horizontally across the top of the TOC - The TOC can be expanded and collapsed using 
the  and  buttons and can also be refreshed (refreshing the TOC's data provider if required / the provider changes) using the  
button:

TOC Refresh Refresh the TOC data provider

Expand TOC Expand all TOC menu items

Collapse TOC Collapse all TOC menu items

Back to the top

NEXT STEPS

The FusionAnalytics AIR Client - Learn how to access multiple different FusionAnalytics Applications using the FusionAnalytics 
AIR Client

The FusionAnalytics Web Client - Learn how to log into and use the FA Web Client

FusionAnalytics DataServices (FADS) -    Learn about FADS and how it can be used in relation to System (Settings, Sessions, 
      Controllers, Jobs ...), Applications (Summary, Configuration, Detail, Scope ...), Users and Scheduled Tasks (both System and 

User tasks).

Using Tabs -Learn how to use the Application Tab Navigator

Date Navigation

Date Navigation
Most of the perspectives in FusionAnalytics are time based so, if you want to explore your data further, you will want to change 
the span of time that you are currently viewing. At the bottom of time-based perspectives you will see a tab named "TimeLine". 
By default the TimeLine will be in Basic Mode.

Basic Mode

 



The default TimeLine mode is Basic mode. In this mode you can select a unit of time (Hours, Days, Weeks, Months or Years) 
and then select a number of those units to be your timespan. Clicking on one of the "unit" buttons will switch to that unit of time.

 

: Basic Mode 1Figure 1

Note: When you switch between different modes, your current span will be retained. If this means that the start or end of your 
span doesn't match up with the snap points for the new unit of time, then new temporary snap points will be added.

 

: Basic Mode 2Figure 2

As you switch between modes, the blue calendars on the left and right of the TimeLine will change in order to better represent 
time spans within each unit. The left-hand calendar displays the start point of the current span and the right-hand calendar 
displays the end point of the current span.

 

: Basic Mode 3Figure 3

Clicking on the Arrow buttons between the calendars and the central time span will push the current window in that direction. 
Click and drag the central span handles in order to change the start or end points of the current time span. You can also click 
and drag from the center of the span in order to move both the start and end points at the same time.

At any point you can return to "now" by clicking the button to the right of the unit buttons. This button changes label depending 
upon which time unit you currently have selection. eg. "This Hour", "Today", "This Week"...

Back to the top

Timeline Mode

The Timeline view represents time as one long piece of ticker-tape. Click the "Timeline" button on the far left in order to switch 
to this mode. The window of time at which you are currently looking is the timespan currently selected. There are various ways 
in which you can interact with this time span. Firstly, you can click and drag the timeline to the left or right. Secondly, you can 
click the left and right buttons at the edges of the Timeline in order to move the current time span forward or back.



 

: Timeline Mode 1Figure 4

If you want to increase of decrease the size of the currently visible time span then you can click the up and down arrows at the 
left side of the Timeline. Clicking these will step up or down between the different units available. You can also use the mouse 
wheel to zoom the Timeline in and out. Unlike the Basic mode, the Timeline mode has many degrees of time unit, starting from 
millisecond, tens of milliseconds or hundreds or milliseconds, going right up to hundreds of years. As you scroll in and out, you 
will notice that the left and right buttons move up and down with the rest of the Timeline labels. A scroll button in the "minutes" 
areas of the Timeline will move you forward or back one minute, whilst the same button in the "years" area will move you by a 
full year. The buttons are context sensitive.

 

: Timeline Mode 2Figure 5

You can also double-click on any unit of time within the timeline. If you clicked on a unit from the lower half of the Timeline 
then the current displayed span of time will be changed so that it perfectly matches up with the unit that you double clicked on. 
If you clicked on a unit from the upper half of the Timeline then the currently display span of time will be zoomed out to 
perfectly match with the next highest unit above the one you double clicked on.

If you also like to use keyboard commands then the left and right cursor keys can be used to step forward and back by the 
smaller of the two visible time units. The up and down cursor keys can be used to zoom the Timeline in and out in the same 
way that the up and down buttons on the right do.

Back to the top

Calendar Mode

The final mode for time span selection is the Calendar mode. Click the "Calendar" button on the far left to switch to this mode. 
In Calendar mode you can click within the calendar components or the click on the numeric stepper components in order to 
change the start and end points of the currently selected time span. By default the start and end points will be linked (which is 
represented by the central check box labelled "Link" having a tick within it.) When the start and end points are linked, you will 
be unable to change the amount of time within the current time span, so if you had an hour-long time span and increased the 
start point by a minutes. The end point would also be increased by a minute.

If you click the "Reset" button for the start or end times then the Hour, Min, Sec and MS fields will all be reduced to zero. This 
can be helpful if you want to isolate a span of time encompassing a number of full days. (Note that this will still try and retain 
the current span of time though so clicking one and then the other whilst the dates are Linked will not leave you with both 
times at midnight, unless they both started out with exactly 24 hours separating them.)

If you unlink the start and end points (by clicking the central check box) then you can change the start and end points 
independently. (Although obviously, the start point must always occur before the end point.)

You will notice in the screen shots that there is a red marker line sitting over the Timeline. In this case you will also 
see marker lines on all supported graphs within your currently displayed Perspective. Moving the marker line using 
the handle at the bottom of the Timeline area will also move the marker on all of these graphs. This is just make 
help you when you are comparing data accross multiple graphs. You can double click the handle at the bottom of 
the timeline to turn the cursor on and off.



 

: Calendar Mode 1Figure 6

If you have the start and end points linked then you can change either the start point or the end point to "Relative" mode. In 
the image below, the start point is dealt with as before, but the end point is defined by picking a unit of time and then 
specifying how many of those units separate the start and end points. You can click and hold any of the numberic steppers in 
order to make them cycle through numbers quicker.

 

: Calendar Mode 2Figure 7

The Calendar components on the left and right-hand side of the display area can be changed by simply clicking of a desired 
Date. The left and right arrows at the top of each calendar allow you to change the current Month and to the right of the Year 
there are up and down stepper buttons as well.

Back to the top

Locking and Updating

If you have been trying the different date navigation modes outlined above then you will have noticed that, even though you 
have been changing the currently selected time span, the data shown within your current perspective will not have been 
updated to reflect your changes. At any point you can click the "Update" button and your perspective will be refreshed in order 
to show your currently selected span of time. Even if you have not changed the current time span, you can click the "Update" 
button to get the most recent data from FusionAnalytics.

There are many situations in which you would want graphs to automatically be updated as you scroll through time. In this case 
you can lock the TimeLine. Click the "Lock" button to toggle this feature on and off. Whilst locked, your perspective will be 
updated whenever you change the currently selected timespan.

 

: Lock and Update ButtonsFigure 8

Both the "Lock" and "Update" features work with all three of the Timeline display modes.

Back to the top

Timezone Control

You will notice in the top left of the Date Navigation component (used for all modes) is a Time zone Control (drop down):

|  

: Timezone Control |Figure 9

If you have the Timeline "Locked" whilst browsing through data then then you will be constantly asking 
FusionAnalytics for new data to show. In this case you may find that the performance is slower than having the 
Timeline "Unlocked".



The Time zone Control allows you to view Perspective data in the time zone of your choice. By default, this will be set to your 
local time. For more information about Time zones and the Time zone control See: .Time Zones
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NEXT STEPS

Time Zones -    Learn about Time Zones within the Client and how to use the Time Zone control

Time Zones

Time Zones

FusionAnalytics allows you to view graph and table data in the Time Zone of your choice. By default, this will be set to your 
local Time Zone. (ie, the Time Zone in which the FusionAnalytics Client is running.) If you want to change your viewing Time 
Zone then you can select a new Time Zone from the drop down box in the top left of the  area:Date Navigation

 

: Timeline Control - Basic ModeFigure 1

Many perspectives have an overview at the top and you can also see the current Time Zone setting in this location:

 

: Perspective FiltersFigure 2

If you change the current Time Zone then all the times and dates displayed in the client will be updated to take this new Time 
Zone into consideration.

 

: Timezone ControlFigure 3

Dates displayed in the overview section, in data grids and on graphs will include the current Time Zone Offset so that you 
know what Time Zone you are currently using.

 

: Perspective FiltersFigure 4
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NEXT STEPS

Date Navigation - Learn how to use the Time Line Component for advance Data Navigation.

Filtering Data

Filtering Data
FusionAnalytics gives you a lot of data so it is useful to be able to focus in on just the information you want. The type of filters available to 
you will differ depending upon the type of perspective. You will see a tab at the bottom of the perspective for each type of filter available (if 
any).

 

: Filters TabFigure 1

Timeline

Note: Many Time Zones have an additional hour offset over summer. This is referred to as Daylight Savings Time 
(DST). If you are looking at a Time Zone which is UTC - 6:00, but is currently using Daylight Savings Time, then the 
actual offset will be UTC - 5:00. In this situation the offset will be displayed as -0500 but the string "(DST)" will be 
added to the date in order to identify this change, as in the following image which represents a span of time that 
crosses the Daylight Savings Time boundary.



The TimeLine filter can be used to select a specific period of time. For more information on this filter, see the  section. The Date Navigation
TimeLine filter also contains the  Control allowing you to view graph and table data in the  of your choice.TimeZone TimeZone

 

: Timeline TabFigure 2
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Request

This filter type allows you to limit the view to only include requests with specific limitations. These are your options:

Request ID IS, ISNOT, >, <, >=, <=

JSession ID IS, ISNOT, LIKE, NOTLIKE

Method IS, ISNOT, LIKE, NOTLIKE

CFID IS, ISNOT, LIKE, NOTLIKE

CFTOKEN IS, ISNOT, LIKE, NOTLIKE

Client IP Address IS, ISNOT, LIKE, NOTLIKE

SERVER IS, ISNOT

THREAD ID IS, ISNOT, LIKE, NOTLIKE

CP Reason Code IS, ISNOT, LIKE, NOTLIKE

AMF Request IS, ISNOT, LIKE, NOTLIKE

Status Code IS, ISNOT, >, <, >=, <=

Request Execution Time IS, ISNOT, >, <, >=, <=

Memory Percent IS, ISNOT, >, <, >=, <=

Number of Queries IS, ISNOT, >, <, >=, <=

Total Time in Queries IS, ISNOT, >, <, >=, <=

Execution Time in Queries IS, ISNOT, >, <, >=, <=

Total DB Rows Retrieved IS, ISNOT, >, <, >=, <=

Response Size IS, ISNOT, >, <, >=, <=

Time To First Byte IS, ISNOT, >, <, >=, <=

Time To Last Byte IS, ISNOT, >, <, >=, <=

Once you have entered your filter type, comparison type and value, you can click the "+" button to add the new filter to the list of filters 
below. Clicking the "Apply Filter" button will update the perspective to include your defined filters.
??



 

: Request TabFigure 3
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Request Duration

This filter allows you to use a slider to define a minimum and maximum request duration to be displayed. The minimum and maximum 
values are both in milliseconds.

 

: Request Duration TabFigure 4
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Request Params

This filter allows you to select values for a given request parameter. You have the option of picking "fuseaction", "event", or you can enter 
your own Request parameter to filter. For each filter you can either choose "IS" or "ISNOT".

Once you have entered your filter type, comparison type and value, you can click the "+" button to add the new filter to the list of filters 
below. Clicking the "Apply Filter" button will update the perspective to include your defined filters.

?  

Note: The Request filter is based on a  component. For more information about using this component see the MultiComboFilter
 Overview section at the bottom of this page.MultiComboFilter

You can change / adjust the minimum and maximum values by wither dragging the slider thumbs, or to be more precise by 
using the numeric steppers below the slider control by clicking the "up" and "down" stepper buttons or simply typing values into 
the control.



: Request Params TabFigure 5
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Request URL

This filter lets you isolate some section of the request URL and filter just that part of the URL. These are the options:

URL Protocol (protocol://*...)

URL Username (://username:...)

URL Password (://:password@*...)

URL Hostname (*://hostname/...)

URL Port (://:port/*...)

Path Element 1 (:/// /...)1

Path Element 2 (://// /...)2

Path Element 3 (:///// /...)3

Path Element 4 (:////// /...)4

Path Element 5 (://///// /...)5

Path Element 6 (://////// /...)6

Path Element 7 (:///////// /...)7

Path Element 8 (:////////// /...)8

Once you have entered your filter type, comparison type and value, you can click the "+" button to add the new filter to the list of filters 
below. Clicking the "Apply Filter" button will update the perspective to include your defined filters.

 

: Request URL TabFigure 6
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MultiComboFilter Overview

As discussed within this section the are some filters () that are based on the MultiComboFilter component. The MultiComboFilter is a 
component that accepts different values (DataProviders) that can be used to filter different data types. The component allows the user to 
add filter values and compare these filters to arguments (also user specified) using different action types (E.g. IS, ISNOT, LIKE, 
NOTLIKE, >, <, >=, <= etc ... ).

Note: The Request Params filter is based on a  component. For more information about using this component MultiComboFilter
see the  Overview section at the bottom of this page.MultiComboFilter

Note: The Request URL filter is based on a  component. For more information about using this component see MultiComboFilter
the  Overview section at the bottom of this page.MultiComboFilter

null/pages/createpage.action?spaceKey=FA208&title=1&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=2&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=3&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=4&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=5&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=6&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=7&linkCreation=true&fromPageId=148119117
null/pages/createpage.action?spaceKey=FA208&title=8&linkCreation=true&fromPageId=148119117


1.  

2.  

3.  

As an Example use of the MultiComboFilter component lets take the "Request" filter:?

 

: MultiComboFilter 1Figure 7

The MultiComboFilter component consists of a horizontal filter control bar containing the three filter inputs (rendered as either a combo 
box / drop down list or a text input), an add "+" button and an "Apply Filter" button (all laid out horizontally across the top of the 
component) and a Grid placed below to display the added filters. The three filter inputs include:

The Filter itself (the first input)

The filter Action (the second input)

The filter Argument (the third / last input)

All three filter inputs are linked together / are dynamic with Filter input controlling both the DataProviders and Item Renderers of the Action 
and Argument inputs, therefore the available Actions and the Argument type (if it can be any user defined input / string or a distinct list of 
items) depends on the filter that has been selected. E.g. The "Client IP Address" Filter contains the Actions "IS, ISNOT, LIKE, NOTLIKE" 
and can be any user defined input so the Argument input is rendered as a "Text Input" :

 

: MultiComboFilter 2Figure 8

Whereas the "Status Code" Filter contains the Actions "IS, ISNOT, >, <, >=, <="  however its Arguments are a distinct list of values so the 
Argument input is rendered as a Combo Box / Drop Down list:

 

: MultiComboFilter 3Figure 9

Once you have selected a filter and added an Action and Argument, you can add the filter to the filters grid by clicking the add "+" button 
and / or apply the filter by clicking the "Apply Filter" button.

The Filter inputs / values contain validation rules that applied to the Arguments for each Filter type (E.g. filters types can be of type 
Number not allowing character values etc...) :?

 

: MultiComboFilter Character ValidationFigure 10



 

: MultiComboFilter Number Validation |Figure 11

When the "Apply Filter" button is clicked only filters that have been added to the Filters Grid are applied. If the Add button is enabled (if 
you are adding a new filter) and the "Apply Filter" button is clicked, the new filter is both added to the Filters Grid and applied with all other 
filters in the Grid. If the Add button is disabled (there is no new filter to add) all the filters currently within the FIlters DG are applied

Once Filters have been added they are displayed in the Filters Grid where they can bu further edited or deleted:

 

: MultiComboFilter 4Figure 12

The filters within the Filters Grid can be edited in the same way as they were added. To edit a filter simply click the element (Action or 
Argument) within the row that you want to edit, and the cell will become editable (using its required item renderer) so thqt you can change 
the value(s). Once you are done editing click the "Apply Filter" button to update the Perspective results using the new filter(s). To remove / 
delete filters clikc the delete "-" button :?

 

: MultiComboFilter 5Figure 13

Note: The filters within the Filters Grid contain the same validation rules as when adding the Filters. If any arguments within the Filters 
Gris are not valid the "Apply Filters" button will be diabled until the Argumentshave been changed to a valid value preventing any invalid 
Arguments to be executed within a query :

Note: The add "+" button will be disabled while the content within the Argument input is either empty or invalid (in relation to the 
selected Filter) to prevent any invalid filter queries against the DataBase :  

Once valid content has been entered into the Argument input the add "+" button is enabled and the Filter can be added to the 
Filters Grid

Adding Filters
When adding single filters the "Apply Filter" button is very useful and faster to use that Adding the Filters to the Filters Grid and 
then Applying the Filters using a second step, however, if adding multiple filters, from a performance perspective it is better to 
add the filters individually and then Apply them all together as a second step using the "Apply Filter" button (as when the "Apply 
Filter" button is used it runs a query and updates the results each time, therefore when adding ten Filters, ten Queries will be 
performed being a lot more expensive than just one as when using the "Add" button to add the filters).



 

: MultiComboFilter 6Figure 14

?
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NEXT STEPS

Date Navigation - Learn how to use the Time Line Component for advance Data Navigation.

Time Zones - Learn about Time Zones within the Client and how to use the Time Zone control

Data Visualizations

DATA VISUALIZATIONS

OVERVIEW

This section will discuss the different Data Visualizations that are provided and 
used within the different application Perspectives and how they can be used to 
help visualize and analyze data in the most efficient manner(s)

NEXT STEPS

DataGrid Visualization

Chart Base Visualization

Time Block Chart Visualization

Placemark Chart Visualization

Sixway Chart Visualization

DataGrid Visualization

DATAGRID VISUALIZATION

The DataGrid Visualization is used to render data in a "list" based format having a similar layout to a (vertical) table with 
column headers at the top and rows of data (records) listed below. The DataGrid Visualization offers user controlled re-sizable 
and sortable columns, text wrapping (for larger strings), cell based Tool Tips, single and multiple row selection (including 
selection copy functionality),  and data paging to allow easy and usable scrolling through large data sets.Context Menus

The following image shows a typical DataGrid Visualization:



? 

: DataGrid VisualizationFigure 6
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Data Sorting

The DataGrid Visualization allows data to be sorted by "multiple" columns simply by clicking the column headers:

When the DataGrid is initialized it displays the data in the order that is is delivered from its DataProvider (DP). Once the 
DataGrid has been initialized (loaded) it allows the user to sort the data by single or multiple columns. Ordering data by a 
column is very straight forward, simply click a column header to order by that column, and click it again to re-order by the 
same column but in the reverse order etc. to add a second, third, fourth (multiple) ... order filter / sort repeat this process by 
clicking on a additional column headers to apply multiple column sorts. The direction in which the sort has been applied 
(ascending / descending) is displayed using a small arrow within the column header(s) and the order in which the sort has 
been applied to the columns is represented by a number (again displayed in the column header):



 

: DataGrid Visualization - Data SortingFigure 2
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Column Resizing

Columns can be re-sized by hovering over the column border (within the column header) until the cursor changes from a 
pointer to the "re-size" cursor: . When the re-size cursor is visible, click the column edge and drag it left or right to re-size it.

Columns resizing is useful when column content is too large / long to be rendered using the default column widths. In these 
cases the columns can be re-sized (as discussed), however this can also (sometimes) affect other column content preventing 
this content (all DataGrid content) to be fully displayed at the same time. The DataGrid Visualization further supports text 
truncating to help with this issue. Text truncating truncates strings that are too long to be rendered within a column. The string 
is cut to fit into a column and a trialing "..." is appended to the end of the string allowing the user to see that the string has 
been truncated.

Back to the top

Grid Tool Tips

The DataGrid Visualization additionally supports Tool Tips which are displayed when on a mouse over event for each cell 
within the DataGrid. The Tool Tip displays the (full) text content of the cell that the mouse is currently over (useful for seeing 
truncated content).

Back to the top

Grid Context Menu



Within most application Perspectives using DataGrid Visualizations,  support has also been implemented. To Context Menu
use the Context Menus, simply right click on a row within the DataGrid and a Context Menu will be displayed. Each Context 
Menu has a DataProvider that is relevant to the current Perspective / Visualization and the Context Menu renders each 
DataProvider item as a menu item within the Context Menu itself which the user can click / open.

 

: DataGrid Visualization - Context menuFigure 3

As you can see, the Context Menu Items are generally "links" to other Perspectives relevant to the current Perspective (date / 
time) within the application.
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Copying Grid Content

You will also notice that the  within the DataGrid Visualization contains two additional menu items:Context Menu

Copy Row(s)

Copy Cell(s)

The DataGrid Visualization supports both (multiple) row and cell section. To select multiple rows, select a row, hold the "Shift" 
key and select a second row or select a row and drag the mouse (up or down) across the rows you wish to select - The 
selected rows are then highlighted in green.

When the "Copy Row(s)" menu item is selected, the currently selected rows from "all" columns within the DataGrid will be 
copied to the computers clipboard (in the order that they are currently rendered within the DataGrid). E.g.:



 

: Copy RowsFigure 4

The above ("Copy Row(s)") menu item click will copy the selected rows to the clipboard where they can be further pasted 
resulting in:

Started        Request URL        Query String        Exec Time
11.07.11 14:04:35.812        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                
method=getLocalTime        2m 26s 94ms
11.07.11 14:04:38.437        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                
method=getLocalTime        2m 26s 94ms
12.07.11 12:32:57.968        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                
method=getLocalTime        2m 26s 32ms
12.07.11 07:08:49.453        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                
method=getLocalTime        2m 25s 953ms
12.07.11 11:05:16.640        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                method=getUKTime        
4m 17s 453ms
12.07.11 12:33:10.203        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                method=getUKTime        
2m 11s 375ms
12.07.11 13:10:24.359        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                method=getUKTime        
2m 11s 328ms
12.07.11 13:10:24.515        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                method=getUKTime        
2m 11s 172ms
12.07.11 12:33:04.562        http://int0046.bbn.intergral.com:
18080/apps/tellTime.cfc                method=getUKTime        
2m 10s 984ms
09.07.11 16:17:32.156        http://int0046.bbn.intergral.com:
18080/apps/fads/test.cpuspike.
cfm                                3m 4s 109ms
12.07.11 00:30:24.265        http://int0046.bbn.intergral.com:



18080/apps/fads/test.cpuspike.
cfm                                3m 3s 313ms

When the "Copy Cell(s)" menu item is selected, the currently selected rows from only the current (mouse over) column will be 
copied to the computers clipboard (in the order that they are currently rendered within the DataGrid). E.g.:

 

: Copy CellsFigure 5

The above ("Copy Cell(s)") menu item click will copy the selected cells to the clipboard where they can be further pasted 
resulting in:

http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
http://int0046.bbn.intergral.com:18080/apps/test.cfthread.cfm
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Next Steps

Date Navigation
An explanation of what Date Navigation is and how it can be used

Using Context Menus
An explanation of what the Context Menus are and how they works / are used

DataGrid Visualization - Description of the DataGrid Visualization
- Chart Base Visualization Description of the Chart Base Visualization

-Time Block Chart Visualization Description of the Time Block Chart Visualization
-Placemark Chart Visualization Description of the Placemark Chart Visualization

 -Sixway Chart Visualization Description of the Sixway Chart Visualization

Take me back to .?Data Visualizations

Chart Base Visualization



CHART BASE VISUALIZATION

The Chart Base Visualization supports (and is the base for) all chart series types within the Application. The chart types that 
the application supports include:

Area Series (Area Chart)

Line Series (Line Chart)

Column Series (Column Chart)

Bar Series (Bar Chart)

The Chart Base Visualization is used to display / represent data within a chart / graph making data interpretation more "visible" 
and in some cases easier to analyze and understand. Like most charts, the Chart Base Visualization uses an "X" and "Y" axis 
to map data, and in turn represent data points from the Charts DataProvider in a two-dimensional manner rendered as a 
series (Line, Area, Column, Bar etc.).

Most Chart Based Visualizations within the application are "time-bound" Visualizations therefore mapping time-based data 
(time-stamps) to the chart axis allowing interaction with the Perspectives  (if attached).Timeline Control

The following image shows a typical Chart Base Visualization:

 

: Chart Base VisualizationFigure 1

Back to the top

Chart Tool Tips

Note: Each "time-bound" Chart Base Visualization uses a Chart Cursor that is controlled from the . Timeline Control
This is the red line that is vertically rendered over the chart canvas and Timeline control. The cursor is controlled by 
dragging the handle at the bottom of the Timeline control which in turn updates and moves the cursor within the 
Chart Base Visualization. This is to help when comparing data across multiple charts within a ?Perspective.



Each axis has labels attached that relate to the data being rendered within the chart at any time. Each data point within each 
chart series contains a Tool Tip that displays information for each data point in relation to the Chart axis and Series 
DataProvider.
It is easy to "roughly" see the value / time of a specific data point just by looking at its position in relation to the chart axis, 
however to know the exact information of a specific point, Tool Tips are required and prove to be very helpful for accurate 
analysis between data points:

 

: Chart Base Visualization - Tool TipsFigure 2
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Chart Legend / Series Select

The Charts include a (color-coded) legend in that is rendered to the top left of the chart. The legend represents each of the 
(currently) selected chart series, displaying the series name and measurement. This legend is linked to the Series Select 
Component that is rendered to the top right of the chart (if included). The Series Select Component controls what series are 
displayed at any one time. For example if a Chart Base Visualization contains many series, or if a series is rendered behind 
another (preventing it from being visible) the chart can often be difficult to interpret / analyze. In such cases the Series Select 
Component can be used to turn on and off (show / hide) specific series making analysis both easier and more accurate:



 

: Chart Base Visualization - Series SelectFigure 3

To turn off / hide a series, simply open the Series Select Component combo box, find the series that you want to remove, and 
"un-check" it. This will update and remove the series from both the chart and the chart legend. To re-add the series follow the 
same process but select / "check" the series and in turn the chart will be updated and the series re-added and rendered again:



 

: Chart Base Visualization - Series SelectFigure 4
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Chart Context Menus

The Chart Base Visualizations support . To use the Context Menus, simply right click a data point within a chart Context Menus
series and a Context Menu will be displayed. Each Context Menu has a DataProvider that is relevant to the Perspective / 
Visualization, and the Context Menu renders the each DataProvider item as a menu item that the user can click / open. As you 
can see, the Context Menu Items are generally "links" to other Perspectives relevant to the current Perspective (date / time) 
within the application:

?|  

: Chart Base Visualization - Context Menu |Figure 5
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Next Steps

Date Navigation
An explanation of what Date Navigation is and how it can be used

Using Context Menus
An explanation of what the Context Menus are and how they works / are used

DataGrid Visualization - Description of the DataGrid Visualization
- Chart Base Visualization Description of the Chart Base Visualization



-Time Block Chart Visualization Description of the Time Block Chart Visualization
-Placemark Chart Visualization Description of the Placemark Chart Visualization

 -Sixway Chart Visualization Description of the Sixway Chart Visualization

Take me back to .?Data Visualizations

Time Block Chart Visualization

TIME BLOCK CHART VISUALIZATION

The Time Block Chart Visualization is a very powerful chart allowing the rendering of many data points (a lot more than the 
standard charts) providing a larger and more detailed visualization (picture) of data at any one time further allowing more 
powerful and accurate data analysis and interpretation.

The Time Block Chart Visualization is used to display / represent data within as a "block" based representation providing 
different yet in depth and more detailed / advanced image of data, in turn making data both interpretation and analysis more 
accurate and problem idetification easier to both find and understand.

The Time Block Chart Visualization is "time-bound" mapping time-based data (time-stamps) to the chart axis allowing 
interaction with a Perspectives  (if attached). The Time Block Chart Visualization uses both vertical and Timeline Control
horizontal axis to map data. The vertical axis contains category data and the horizontal axis is mapped to time stamps, in turn 
representing data points from the Charts DataProvider rendered as Time Blocks in a two-dimensional manner.

The following image shows a typical Time Block Chart Visualization:

 

: Time Block Chart VisualizationFigure 1

Note: As the time Block Chart is time-bound it includes a Chart Cursor which is controlled from the . Timeline Control
This is the red line that is vertically rendered over the chart canvas and Timeline control. The cursor is controlled by 
dragging the handle at the bottom of the Timeline control which in turn updates and moves the cursor within the 
Time Block Chart Visualization. This is to help when comparing data across multiple charts within a ?Perspective.
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Chart Tool Tips

Each individual Time Block rendered within the Time Block Chart has Tool Tip assigned containing information about that 
individual Time Block.

It is easy to "roughly" see the time (duration) and category of each block just by looking at the Time Blocks positions in relation 
to the chart axis, however to know the exact category / time (duration) of a specific Time Block (especially in charts rendering 
lots of Time Blocks) and additional information related to the Time Blocks, Tool Tips are required and prove to be very helpful 
for accurate analysis between time Blocks:

 

: Time Block Chart Visualization - Tool TipsFigure 2
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Copying Tool Tip Content

The Tool Tips used within the Time Block Chart Visualization are custom Tool Tips that allow more information than the 
standard Tool Tips along with Tool Tip formatting, scrolling (allowing for useable Tool Tip containing large amounts of data) 
and additionally the ability to copy the Tool Tip content. The ability to copy the content is both especially helpful and important 
for the Time Block Chart as it allows values to be copied and easily used when , again making data filtering and Filtering Data
analysis much more efficient.



 

: Time Block Chart Visualization - Copy Tool TipFigure 3
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Chart Context Menus

The Time Block Chart Visualization supports . To use the Context Menus, simply right click on a Time Block Context Menus
rendered within the chart and a Context Menu will be displayed. Each Context Menu has a DataProvider that is relevant to the 
Perspective and selected Time Block and the Context Menu renders each DataProvider item as a menu item within the 
Context Menu that the user can click / open. As you can see (in the screen shot), the Context Menu Items are generally "links" 
to other Perspectives relevant to the current Perspective (date / time) within the application.



 

: Time Block Chart Visualization - Context menuFigure 4
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Chart Scrolling

To allow fast and understandable vertical rendering of large quantities of data, the Time Block Chart Visualization supports 
vertical scrolling allowing many data categories (rows) to be rendered within any one chart at one time. Chart scrolling is 
activated when the amount of rows (size) rendered within the chart is larger than the available chart real estate (height). When 
scrolling is activated, the chart can be navigated both vertically (using the scroll bar) and horizontally (using the Timeline 

).Control



 

: Time Block Chart Visualization - Chart ScrollingFigure 5
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Also See

Date Navigation
An explanation of what Date Navigation is and how it can be used

Using Context Menus
An explanation of what the Context Menus are and how they works / are used

Filtering Data
An explanation of the data Filters, how they work and how they can be used

DataGrid Visualization - Description of the DataGrid Visualization
- Chart Base Visualization Description of the Chart Base Visualization

-Time Block Chart Visualization Description of the Time Block Chart Visualization
-Placemark Chart Visualization Description of the Placemark Chart Visualization

 -Sixway Chart Visualization Description of the Sixway Chart Visualization

Take me back to .?Data Visualizations

Placemark Chart Visualization

PLACEMARK CHART VISUALIZATION

The Placemark Visualization allows many points to be displayed / represented in an easy, understandable (visual) and fast 
(high performance) manner.

The chart is "time-based" containing one horizontal axis which is linked to and controlled by the Perspective  Timeline Control
(if in place) allowing the user to efficiently navigate between time periods to see / find different Placemarks.



The following image shows a typical Placemark Chart Visualization:

 

: Placemark Chart VisualizationFigure 1
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Placemark Grouping

The placemark Chart Visualization supports "grouping" allowing placemearks to be rendered both efficiently and in a manner 
that is easy to read / evaluate, e.g. If the canvas contains too many placemarks to render within a selected time period, 
instead of rendering all placemarks (which would make the chart confusing) the placemarks within a similar time period and of 
a similar type (E.g. Info, Error, Warning etc ) are grouped together therefore rendering less placemarks on the screen and 
making analysis easier. If an item contains grouped placemarks the items label (or Tool Tip if labels are turned off) will display 
the type and number of the grouped items:

Note: Each "time-bound" Placemark Chart Visualization uses a Chart Cursor that is controlled from the Timeline 
. This is the red line that is vertically rendered over the chart canvas and Timeline control. The cursor is Control

controlled by dragging the handle at the bottom of the Timeline control which in turn updates and moves the cursor 
within the Chart Base Visualization. This is to help when comparing data across multiple charts within a ?
Perspective.



 

: Placemark Chart Visualization - GroupingFigure 2

Each grouped item within the chart can be zoomed into using the  until the chart is at a level that it can render Timeline Control
the grouped items individually. At this point a switch will be made and the grouped items will be un-grouped and rendered 
individually

The chart supports multi-levels of grouping, e.g. items can be both grouped and sub-grouped (grouped items 
containing additional grouped items). In such cases multiple levels of switches (zooming) will be required to see all 
of the individual placemarks.



 

: Placemark Chart Visualization - GroupingFigure 3

Once placemark items are rendered at there lowest (individual) level the labels (or Tool Tips) of the placemarks will be 
relevant / distinct to each item.
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Adding Placemarks

The Placemanrk Visualization allows users to add custom placemarks to the chart for specific points in time. These 
placemarks are stored into the application database and retrieved / rendered whenever the chart is loaded within the "saved" 
placemark time frame.
To add a placemark to the chart, simply right click on the charts canvas at the time (horizontal) and position (vertical) where 
you want to save the placemark, and select the "Add Placemark" menu item from the displayed context menu:



 

: Placemark Chart Visualization - Add PlacemarkFigure 4

This will show the "Add Placemark" dialogue where the user can add details for the "new" placemark:

 

: Add Placemark PanelFigure 5

When adding a new placemark you can enter the following information:

Item Description 

Severity Choose a severity for the Placemark. The options available include:  (Information),  (Warning) and  INFO WARN ERROR
(Error) 



Point 
Color 

Choose a color for the placemart from the color pallet provided in the dialogue. Different colors can be chosen allowing to 
help categorize / distinguish different placemarks and placemark types 

Placema
rk Text 

Enter  some text / description for the tool tip. This is the text that will be rendered within the placemark label (or tooltip) 

Placema
rk URL 

Optional: Enter a URL for the placemark. When the placemark is double clicked the URL will be opened within a new tab 
within the application 

When you have finished adding the details for the new placemark, click the "Add placemark" button to remove the dialogue 
and add the placemark. You will notice that the placemark has been added in the exact location (that was clicked) on the 
canvas, the fill color of the placemark is the color that was selected and the placemark label (Tool Tip) is the text that was 
entered. The placemarks have double click actions enabled, so if a URL was added to the the placemark, you can double click 
the item and the URL will be loaded in a new tab window within the application

 

: Placemark Chart Visualization - Added PlacemarkFigure 6
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Editing and Deleting Placemarks

To edit or delete a custom placemark, simply right click on the relevant placemark and select the "Edit Placemark" menu item 
from the context menu:

If no URL was added a double click event will have no effect.



 

: Placemark Chart Visualization - Edit PlacemarkFigure 7

This will display the "Edit Placemark" dialogue:

 

: Edit Placemark PanelFigure 8

The "Edit Placemark" dialogue will display the information relevant to the selected placemark item. Within this dialogue you 
can edit / change the placemark (description) and URL. click the "Save" button to save / modify the item and return to the 
placemark canvas. Alternatively you can also choose to delete the placemark by clicking this "Delete" button which will delete 
the item from both the the database and the canvas.
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Placemark Control Bar

Above the placemark canvas is the placemark control car containing a pointer slider and label, axis and crosshair check boxes.
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Pointer Size Slider

The Pointer Slider controls the size of the placemarks that are rendered on the canvas. The ability to change the placemark 
size is useful as it allows the user to change the placemark size depending on the real estate available and the amount of 
placemarks being rendered at any time for easier chart readability.

Back to the top

Show Labels Check

The Labels Check controls weather or not the placemark labels are displayed. If there are a lot of placemarks being rendered 
at anyone time, including grouped placemarks, it can affect the charts performance therefore the labels can be turned off while 
scrolling / navigating through data, and then turned on again once the required time frame has been found.
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Show Chart Axis Check

The Axis Check controls whether or not the axis is displayed. Again this is useful in regards to rendering. If there are a lot of 
placemarks rendered at anyone time and / or a placemark is rendered in top of / over the axis then it can sometimes be hard 
to read. In such cases the chart axis can be switched off.

Back to the top

Show Crosshair Check

The Corosshair Check controls the visibilily of the crosshair cursor. The crosshair cursor follows the mouse pointer drawing 
both a horizontal line across the mouse pointer (the width of the canvas) and a vertical line through the pointer (the height of 
the canvas) with the two lines meeting / crossing in the middle. The crosshair is useful if placemark positions are important e.
g. for identifying alignment patterns between them.

Even when labels has been turned off, the placemark text is still available within the individual placemark tool tip.

When the chart axis is turned off chart performance can also be improved, although only really noticeable when a lot 
of placemarks are being rendered.



 

: Placemark Chart Visualization - CrosshairFigure 9
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Date Navigation
An explanation of what Date Navigation is and how it can be used

DataGrid Visualization - Description of the DataGrid Visualization
- Chart Base Visualization Description of the Chart Base Visualization

-Time Block Chart Visualization Description of the Time Block Chart Visualization
-Placemark Chart Visualization Description of the Placemark Chart Visualization

 -Sixway Chart Visualization Description of the Sixway Chart Visualization
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Sixway Chart Visualization

SIXWAY CHART VISUALIZATION

The SixWay Chart Visualization contains 6 Area Charts which are (by default) rendered evenly in a 3x2 grid structure (when 
the component is initialised). The contained charts include:

Request Activity Chart

Database Request Activity Chart

Memory Usage Chart

Average Request Time Chart

Average DB Time Chart

CPU Usage Chart



The following image shows the SixWay Chart Visualization in its initialized state:

 

: Sixway Chart VisualizationFigure 1
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Chart Transitions

The SixWay Chart Visualization is transitional and each individual chart within the Visualization can be maximized for better 
visibility.

To maximize one of the charts simply click the chart that you want to maximize and the selected chart will be maximized to the 
size of the allocated real estate and positioned to the right. The remaining five charts will be minimized and positioned vequally 
and laid out vertically to the left of the selected chart (see screen shot below).To maximize another chart simply click one of 
the minimized charts on the left, and the selected chart will then be maximized into the space on the right replacing the current 
maximized chart which in turn will be minimized down back to the left:



 

: Sixway Chart Visualization - Chart TransitionsFigure 2

To return to the default layout (with all charts of equal space and size) simply click the current maximized chart to return.
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Chart Context Menus

The SixWay Chart Visualization supports . To use the Context Menus, simply right click on a data point within Context Menus
one of the six charts chart series and a Context Menu will be displayed. Each series within each of the 6 charts has its own 
Context Menu DataProvider relevant to the Perspective / Visualization. The Context Menu renders the each DataProvider item 
as a menu item within the Context Menu that the user can click / open. As you can see, the Context Menu Items are generally 
"links" to other Perspectives relevant to the current Perspective (Date / time) within the application.



 

: Sixway Chart Visualization - Context MenuFigure 3

For more information about the SixWay Chart Visualization and its content / usage please see the  and Overview FusionReacto
 Perspectives pages along with the (the individual charts within the SixWay Chart Visualization r System Metrics Chart Base 

are based upon a "light weight" version of the ).Chart Base 

Next Steps

Date Navigation
An explanation of what Date Navigation is it can be used

Using Context Menus
An explanation of what the Context Menus are and how they works / are used

DataGrid Visualization - Description of the DataGrid Visualization
- Chart Base Visualization Description of the Chart Base Visualization

-Time Block Chart Visualization Description of the Time Block Chart Visualization
-Placemark Chart Visualization Description of the Placemark Chart Visualization

 -Sixway Chart Visualization Description of the Sixway Chart Visualization
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Application Menus

Application Menus
The application menus can be found at the top of the FusionAnalytics client. Click on a menu to open it:



? 

: Application MenusFigure 1

 

Application

The Application menu contains three elements:

About Show the FusionAnalytics About dialog box.

Logout In the AIR client, Logout will return you to the server browser screen. 
In the Web client, Logout will return you to the login screen for the current server.

Exit This is only available in the AIR client and will completely close the application.

? 

: Application Menus > ApplicationFigure 2

 

Options

The Options menu has two available options:

Res
et 
Cac
he

Much like an internet browser, the FusionAnalytics client caches some information in order to improve performance. Just like 
an internet browser, this option allows you to throw away all of this cached information to make sure you are seeing the most 
recent data from the server.

Stat
e 
Store

Selecting this option brings up the  dialog.State Store

? 

: Application Menus > OptionsFigure 3

 

Tabs

The Tabs menu is only available if you have tabs open. If you close all tabs then this menu will be greyed out.

Print Tab Only available in the AIR client. If you select this menu item then a print dialog will be displayed in order to print the 
contents of the currently selected tab.



Expert Tab 
to PDF

Only available in the AIR client. If you select this menu item then an export dialog will be displayed in order to create a 
PDF file from the contents of the currently selected tab.

Close Tab Close the currently selected tab.

Close 
Others

Close all tabs but leave the currently selected tab open.

Close All Close all tabs.

? 

: Application Menus > TabsFigure 4

 

Help

The Help menu has two menu items:

About Show the FusionAnalytics About dialog box.

FusionAnalytics Help Open the FusionAnalytics online documentation in a web browser window.

? 

: Application Menus > HelpFigure 5

NEXT STEPS

Using State Stores - Learn about saving States within your Application using the State Store

Using Tabs - Learn how to use the Application Tab Navigator

The FusionAnalytics AIR Client - Learn how to access multiple different FusionAnalytics Applications using the FusionAnalytics 
AIR Client

The FusionAnalytics Web Client - Learn how to log into and use the FA Web Client

Using Tabs

Using Tabs
Whenever you click on an item from the  a new perspective will be opened in the Table of Contents (TOC)
content area. This perspective will be opened in a new tab. Tabs appear along the top of the content area and 
can be interacted with in various ways. The simplest way to switch between tabs is simply to click on the tab 
you want to view. The content of that tab will then be made visible.

 
TOC and Content Layout



? 

: Tab NavigatorFigure 1

If you look at the far right of the tab bar then you will see a button with a down arrow on it. Click this to display a 
drop down list of currently opened tabs. The currently selected tab will have a marker next to it. You can click on 
an item within that list in order to open that tab.

 

: Currently Selected TabFigure 2

If you have opened more tabs than can be displayed across the top of the content area then you will be able to 
scroll through them by using the left and right buttons which appear next to the drop down list.

 

: Tab ScrollingFigure 3

If you want to close one of the tabs then move your mouse over it. When the mouse moves over a tab a close 
button will appear. Click on that button and the tab will be removed.

 

: Closing TabsFigure 4

If you right-click on a tab then you will see a context menu. From here you can either close a tab, close all tabs 
or close all but the tab you right-clicked on.

 

: Closing Tabs - Context MenuFigure 5

The tab closing menu items can also be accessed from the top level . If you select "Close Application Menus
Others" from the application menu then all tabs will be closed except the currently selected item.

The application canvas is split into two 
columns. The TOC is rendered in the left 
column and the Perspectives (content) are 
loaded in the right column:



 

: Printing and Exporting TabsFigure 6

If you are using the AIR client then you will also have Print Tab and Export Tab to PDF options available to you. 
These items are not available from within the Web Client. For more information on the Print and Export 
functionality, see the  section.Application Menus
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NEXT STEPS

Using the Table of Contents (TOC) - Learn about the client layout and Using the Table of Contents (TOC)

Application Menus - Learn how to use the Application Menus to close all tabs

The FusionAnalytics AIR Client - Learn how to access multiple different FusionAnalytics Applications using the FusionAnalytics 
AIR Client

The FusionAnalytics Web Client - Learn how to log into and use the FA Web Client

Using State Stores

Using State Stores
The State Store feature is designed to allow you to store the current state of a perspective so that you can return to it at 
a later point in time. The State Store will save the current  as well as any currently defined .date range filters

You can open the State Store dialog box using the  - Options > State Store :Application Menus

 

 

Opening the State Store dialog box
To access and open the State Store 
dialog box you the  - Application Menus
Options > State Store: 



 

: State Store PanelFigure 1

 

Creating a New State Store

In order to create a new State Store you have to enter a name, choose whether your State Store will be visible to all 
users who view this perspective, or just visible to the current user, and then click the Save State button.

 

: Creating a new State StoreFigure 2

Once you have saved your state store it will appear in one of the boxes below. Public State Stores are listed first, 
followed by Private State Stores below.

Loading, Updating and Deleting States

If you close the State Store dialog box and the perspective, then re-open the perspective and open the State Store 
dialog box then you will see your saves State Store listed in the appropriate section. To retrieve your saved state, simply 
click on the "Load" button associated with your State Store. You can also remove the State Store with the "Delete" 
button. The "Rename and Update" button will overwrite all of the currently saved State Store settings with those currently 
being used in the Perspective. It will also update the name of the State Store.



 

: Loading, Updating and Deleting StatesFigure 3

To close the State Store dialog box, click the "X" button in the top right hand corner of the dialog.

NEXT STEPS

Application Menus - Learn how to use the Application Menus to close all tabs

Date Navigation - Learn how to use the Time Line Component for advance Data Navigation.

Filtering Data - Learn how to filter date using the provided Application Filters

Context Menus

Context Menus
Context Menus are used throughout the Client to help navigation and link data within applications. Context Menus are attached to and can be used with most Data 

:Visualizations

 

: Application Context MenusFigure 1

Context menus are created and displayed when the user "right" clicks on a data point within a visualization, e.g. on a DataGrid row or a Chart Series Item. The Context 
Menus contain menu items that are relevant to the current Perspective and the clicked data point. The menu items are (generally) links to other perspectives within the 
application relating to the selected data point and time frame:

See the Data Visualization pages for more information about using Context Menus within each Visualization :

DataGrid Visualization

Chart Base Visualization

Time Block Chart Visualization

Sixway Chart Visualization



 

: Context Menu rendered in a DataGrid VisualizationFigure 2

You will notice that the Context Menus within the  contain two additional menu items at the top of the menu: "Copy Row(s)" and "Copy Cell(s)" allowing DataGrid Visualization
you to cony content form the DataGrid.

The remaining menu items are links to other Perspectives within the application which when clicked open the Perspective (selected from the menu item) in a new  within Tab
the Perspective Canvas. The selected Perspective will be loaded at a time frame relevant to the menu item selected from the menu, e.g. :

(at this time)

(before this time)

(7 days around this time)

NEXT STEPS

Copying Grid Content

Learn about using the Context Menus to copy Data within the DataGrids

DataGrid Visualization - Description of the DataGrid Visualization

Chart Base Visualization - Description of the Chart Base Visualization

Time Block Chart Visualization -Description of the Time Block Chart Visualization

Sixway Chart Visualization -Description of the Sixway Chart Visualization

Business Metrics

BUSINESS METRICS

OVERVIEW

This section contains information about FusionAnalytics Reporting (including TAP and Daily Status reports). The section will discuss how 
the client can be used to navigate to and open the available reports from within the "Reports" Perspective.

NEXT STEPS

Reports

Reports

For more information about copying DataGrid content see the  section of the page.Copying Grid Content DataGrid Visualization 



REPORTS

Opening Reports

To open Application Report, using the  navigate to "Business Metrics > Reports". This will open the "Reports" Perspective within a TOC
new Application . The "Reports" Perspective contains a  displaying all Reports relevant to the Tab Navigator DataGrid Visualization
current application.

You will see two types of reports displayed within the Grid,  and . To open a Report either right click on TAP Reports Daily Status Reports
a report (to pop a ) and select the "Open Report" menu item from the  or simply double click on the Report to Context Menu Context Menu
open the report in a new Perspective:

 

: Reports Perspective - Opening ReportsFigure 1

 

TAP Reports

The TAP Reports give you a less technical view of how your server is performing. Every day you will get a TAP Score and Grade for how 
well your server is doing. It will also compare this to your previous scores. This score gives you a standardized comparison of 
applications regardless of function or hardware capability.



 

: TAP ReportFigure 2

Learn more about TAP Reports

Daily Status Reports

The Daily Status Reports provide detailed information about the requests, database activity, resource usage and even a breakdown of 
the individual applications running. Each day you can see how your server has done compared to the previous day. This allows you to 
easily analyze which areas need improvement, helping you to improve the performance of your server.



 

: Daily Status ReportFigure 3

Learn more about Daily Status Reports

Next Steps

TAP Reports - Learn all about the TAP Reports

Daily Status Reports - Learn all about the Daily Status Reports

Using the Table of Contents (TOC) - Learn about the client layout and Using the Table of Contents (TOC)

Using Tabs - Learn how to use the Application Tab Navigator

DataGrid Visualization - Learn how to use and interact with the DataGrid Visualization

Context Menus - An explanation of what the Context Menus are and how they works / are used

Administrator

ADMINISTRATOR

OVERVIEW

This section will discuss how the Administrator can be used from within the 
FusionAnalytics application. The section will describe how you can Manage 
Applications from within the application and additionally how you can open and 
use both FusionAnalytics DataServices (FADS) and FusionAnalytics 
DataCollector (FADC) from within the client.

NEXT STEPS

Manage Applications

FusionAnalytics DataServices



FusionAnalytics DataCollector

Manage Applications

Manage Applications

Adding an application filter

To add an application filter, within the "Add New Application" section simply enter the application name (that you want to add 
the filter to) and click the "Add Application Filter" button:

 

: Adding Application FiltersFigure 1

The Application filter will then be added and displayed within the "Current Application Filters" section on the "Application Filter 
Configuration" page. To expand the Application Filter(s) (if not already expanded) click the "Edit Filters For (Application 
Name)"? .

Once the Application has been expanded you will see two tabs: "Request URL" and "Request Params" which you can add 
both filters accordingly. These filters allow you to limit the view to only include requests with specific limitations.

 

: Added FiltersFigure 2

You will notice that the Application filter added will be added to the TOC under the "Applications" node. Note, you will have to 
click the "refresh" ? button to update the TOC after an Application filter has been added. For more information about the TOC 
see ....

See the  page for more informationSetting Up Application Filters



 

: Added Filters listed in TOCFigure 3

Back to the top

Request URL



 

: Adding Request URL ArgumentsFigure 4

The Request URL filter lets you isolate some section of the request URL and filter just that part of the URL. These are the 
options:

URL Protocol (protocol://*...)

URL Username ( ...)://username:

URL Password ( :://
password@*...)

URL Hostname (*://hostname/...)

URL Port ( :port/*...)://

Path Element 1 ( /[1]/*...)://

Path Element 2 ( / ...):// /[2]/

Path Element 3 ( / /[3]/*...):// /

Path Element 4 ( / / ...):// / /[4]/

Path Element 5 ( / / /[5]/*...):// / /

Path Element 6 ( / / / ...):// / / /[6]/

Path Element 7 ( / / / /[7]/*...):// / / /

Path Element 8 ( / / / / ...):// / / / /[8]/

Once you have entered your filter type, comparison type and value, you can click the "Add"  button to add the new filter to the 
list of filters below and update the perspective to include your defined filters.



 

: Request URL ArgumentsFigure 5

Back to the top

Request Params

 

: Request Parameter ArgumentsFigure 6

The Request Params filter allows you to select values for a given request parameter. You can enter a Request parameter to 
filter (e.g. fuseaction, event etc...). For each filter you can either choose "IS" or "ISNOT".

Once you have entered your filter type, comparison type and value, you can click the "Add" ?  button to add the new filter to 
the list of filters below and update the perspective to include your defined filters.

As with the "Request URL Filters", to remove a Filter simply click the "Delete" button within the "Name" column of the 
Application Filters table in the "Request Params" tab to remove the filter from the filter list and update the perspective 
removing the deleted filter.

Back to the top



Deleting a filter

To remove / delete a Filter simply click the "Delete" button within the "Name" column of the Application Filters table in the 
"Request URL" tab. Note there is a "Delete"?  button assigned to each filter. This will remove the filter from the filter list and 
update the perspective removing the deleted filter.

Back to the top

Renaming a filter

To rename a filter click the "rename" button next to the filter that you want to rename. This will change the state of the filter 
name at the top of the relevant row within the filters grid into an editable text box allowing you to rename (change / edit) the 
filter name. : if you want to cancel the rename process simply click the cancel button (next to the text input box) to return Note
to the filters list. Once you have renamed the filter and are happy with your chosen name click the "modify" button (next to the 
text input box). A new dialogue will be showed confirming that you want to rename the filter which you can either select 
"cancel" (return to the rename state and choose another name) or "ok" (to change and save the filler name).

 

: Renaming FiltersFigure 7

Back to the top

Copying a filter

To copy a application filter click the "copy" button for the application that you want to copy and the following popup will appear 
asking you you "Enter name for copied application" ( : if you want to cancel the rename process simply click the cancel Note
button (next to the text input box) to return to the filters list):

 

: Copying FiltersFigure 8

Enter the name for the copied application and click the "OK" button from within the dialogue. The application will then be 
copied and added to the current application filter list and will also be added to the TOC under the "Applications" node:



 

: Copied Application FilterFigure 9

Back to the top

Next Steps

Understanding the Daily Status Report
Learn to use and understand the data in the Daily Status Reports.

FusionAnalytics DataServices

FusionAnalytics DataServices using the client

This page allows you to access all of the functionality of FADS exactly like you would in a browser. From the client menu simply navigate to Administrator > FusionAnalytics 
DataServices.

See the  page for more informationSetting Up Application Filters



 

: FADS from the clientFigure 1

For information on how to use FADS, see .FusionAnalytics DataServices (FADS)

Back to the top

Next Steps

FusionAnalytics Client

FusionAnalytics DataCollector

FusionAnalytics DataCollector using the client

This page allows you to access all of the functionality of FADC exactly like you would in a browser. From the client menu simply navigate to Administrator > FusionAnalytics 
DataCollector.

: FADC from the clientFigure 1



For information on how to use FADC, see FusionAnalytics DataCollector (FADC)

Back to the top

Next Steps

FusionAnalytics Client

FusionAnalytics Server

FusionAnalytics Server

Overview

In the following we will have a look at the directory structure of FusionAnalytics 
server and how it is configured. The two web applications FusionAnalytics 
DataCollector and FusionAnalytics DataServices are described in detail and the 
license model of FusionAnalytics is explained.

Next Steps

Server Structure

Directory Structure

FADC Applications

FADS Applications

Server Configuration

FusionAnalytics Log Files

Windows Service Configuration

FusionAnalytics DataCollector Settings

Setting Up FusionAnalytics with HTTPS

JVM Memory Requirements

FusionAnalytics DataCollector (FADC)

Applications (FADC)
Application Summary (FADC)

Application Configuration (FADC)

Application Detail (FADC)

Upload an Application (FADC)

Upgrade an Application (FADC)

Upload Log or ZIP Files (FADC)

Import History (FADC)

User (FADC)
Change Password (FADC)

System (FADC)
Email Settings (FADC)

Runtime Info (FADC)

Disk Usage Settings (FADC)

License Info (FADC)

Logout (FADC)

DCML (FADC)

FusionAnalytics DataServices (FADS)

Applications (FADS)
Application Summary (FADS)

Application Configuration (FADS)

Application Detail (FADS)

Application Scope (FADS)

Upload an Application (FADS)

Upgrade an Application (FADS)

Users (FADS)
Users Summary (FADS)



User Mappings

Scheduled Tasks (FADS)
User Tasks Summary

Application Tasks Summary

System (FADS)
Sessions

Controllers

Asynchronous Jobs

Server Settings

License Info (FADS)

Logout (FADS)

APML (FADS)
APML Volume Switching

Component

Data Provider Programs

Layout

Configuring Report Images

FusionAnalytics Licensing

Server Structure

SERVER STRUCTURE

OVERVIEW

This section provides you with an overview about the directory structure of the FusionAnalytics Server. You will learn what the main 
components of the server are, where the DCML and APML application packages can be found and where the installed applications 
reside in the directory structure of the server.

NEXT STEPS

Directory Structure

FADC Applications

FADS Applications

Directory Structure

Directory Structure

The FusionAnalytics Setup installs a a Java 7 VM together with a preconfigured Apache Tomcat Server with the FusionAnalytics 
 and  web applications deployed as exploded web archives (WAR) under the standard DataCollector FusionAnalytics DataServices webap

 directory. If you have accepted the default installation path FusionAnalytics is installed into the directory  ps C:/FusionAnalytics
containing the files as shown in Figure 1.

 

 Contents of the FusionAnalytics Root DirectoryFigure 1:

The directories are used by FusionAnalytics as described in the following table:

Description



Dire
ctory

.
insta
ll4j

A directory created by the setup containing files related to the Setup and also required when uninstalling install4j 
FusionAnalytics. You should not modify files in this directory.

Appl
icati
ons

Contains the DCML and APML FusionAnalytics for FusionReactor Applications (FA4FR) . If you want to add more FA4FR 
applications you can choose from these files when uploading the application from FADC resp. FADS

jre Contains the Java VM used by the FusionAnalytics Server

Serv
er

The root directory of the Tomcat Server coming with FusionAnalytics Setup. In addition to the regular structure of the Tomcat 
Server FusionAnalytics contains a directory named  where FADC specific files and license data is stored.data

The Tomcat Server is configured to run as a Windows Service named . The root directory of Tomcat in this FusionAnalytics Server
environment is . The two web applications are located inC:/FusionAnalytics/Server

Web Application Location

FusionAnalytics DataCollector C:/FusionAnalytics/Server/webapps/fadc

FusionAnalytics DataServices C:/FusionAnalytics/Server/webapps/fads

FADC Applications

FADC Applications

The  directory contains an  and  directory where FADC applications and their data/fadc Applications Configurations
configuration are installed to. Figure 1 shows the structure of a FADC application named 'myApplication' after it has been successfully 
installed.

 

 Structure of an installed FADC ApplicationFigure 1:

You can see that the application contains additional directories named , ,  and  with a annotations archived configuration import
subdirectory for each configured DataCollector (e.g. 'faDataCollector-1').

http://www.ej-technologies.com/products/install4j/overview.html


Direc
tory

Description

annot
ations

Currently not used

archiv
ed

Contains a dedicated directory for each configured DataCollector where a copy of all processed files is kept. Files are kept 
in 'daily' directories which are managed automatically by FusionAnalytics DataCollector.

config
uration

The content of this directory is deployed to the fadc webapp when the application is installed.

import Contains a dedicated directory for each configured DataCollector where files that should be processed are copied to. You 
can add files by uploading them via the web interface or manually copying them here.

FADS Applications

FADS Applications

FADS applications are deployed to the directory C:/FusionAnalytics/Server/webapps/fads/WEB-INF/classes
. Figure 1 shows how the structure of a successfully installed FADS application looks like:/Applications

 

 Structure of an installed FADS ApplicationFigure 1:

Server Configuration

SERVER CONFIGURATION

OVERVIEW

You can upload single files or a ZIP archive of files to FusionAnalytics DataCollector. Paths inside ZIP archives are fully 
supported. When you manually copy files into the belonging import directory you can copy single files, ZIP archives or even 
complete directories.

If you copy large files, archives or directories into the import directory it can take a long time for FusionAnalytics DataCollector 
to process them. The recommended approach is to start with smaller files until you get a feeling of how much resources are 
required for a certain amount of input files.



This section describes the FusionAnalytics Server log files and the default 
configuration and additional system properties that can be used to change the 
configuration. As FusionAnalytics runs on a Tomcat Server any configuration step 
related to Tomcat applies as well.

NEXT STEPS

FusionAnalytics Log Files

Windows Service Configuration

FusionAnalytics DataCollector Settings

Setting Up FusionAnalytics with HTTPS

JVM Memory Requirements

FusionAnalytics Log Files

FusionAnalytics Log Files

FusionAnalytics does output comprehensive logging information depending on the log level 
configured. The logging output can be configured by changing the settings in the two 
belonging  configuration files.log4j

For  the log4j configuration is defined in fileFADC

C:/FusionAnalytics/Server/webapps/fadc
/WEB-INF/classes/fadc-log4.groovy

for  it is defined in fileFADS

C:/FusionAnalytics/Server/webapps/fads
/WEB-INF/classes/log4j.xml

The log files are located in the directory 
C:/FusionAnalytics/Server/logs

Log file Description

FusionAnalytics Server.log Contains messages written to STDOUT and STDERR

fusionanalytics-
datacollector.log

Contains all messages created by FADC

fusionanalytics-
datacollector-errors.log

Contains only the error messages created by FADC

fusionanalytics-
datacollector-ignored-files.
log

Lists the files that have be ignored by FADC

fusionanalytics-
datacollector-imported-files.
log

Lists the files that have been processed by FADC

fusionanalytics-
datacollector-rejected-files.
log

Lists the files that have been rejected by FADC 
because they have been imported before

fusionanalytics-
dataservices.log

Contains all messages created by FADS

 

 

 

 

 

 

Windows Service Configuration

Per default the log level is set 
to 'INFO' which does produce 
only little logging data but on 
the other hand does not slow 
down the application.

Keep an eye on file fusionan
alytics-datacollector-

 to see if there errors.log
were any problems when 
running FADC

http://logging.apache.org/


Windows Service Configuration

FusionAnalytics Setup creates a Windows service named FusionAnalytics 
. The service uses a configuration file to define settings for the Java VM Server

and additional settings read by FusionAnalytics DataCollector. Shown below is 
the default configuration file for the FusionAnalytics service:

-server
-Xms128m
-Xmx768m
-XX:MaxPermSize=256m
-Djava.awt.headless=true
-Dcom.sun.management.jmxremote.
port=3333
-Dcom.sun.management.jmxremote.
ssl=false
-Dcom.sun.management.jmxremote.
authenticate=false
-Dfusionanalytics.datacollector.
dirObserver.scanInterval=5000
-Dfusionanalytics.lm.store=C:
/FusionAnalytics/Server/data/falm
/falm.store
-Dgrails.scan.interval=3600000

If the default destination directory has not been changed during the setup the 
location of the configuration file above is

C:\FusionAnalytics\Server\bin\FusionAnalytics Server.
vmoptions

 

 

 

FusionAnalytics DataCollector Settings

FusionAnalytics DataCollector Settings

The FusionAnalytics DataCollector can be further configured with the following system 
properties.

Name Description De
fa
ult
Va
lue

fusionanalytics.
datacollector.
batchSize

The number of statements in a SQL batch before 
committing it

500

fusionanalytics.
datacollector.
maxLineLength

The number of bytes a line is allowed to have before 
FADC rejects it as too long

32
768

fusionanalytics.
datacollector.
maxSize.
importHistory

The maximum number of lines the Import History page 
displays

100

fusionanalytics.
datacollector.
connectionObserve
rInterval

The number of seconds the connection observer thread 
sleeps until trying to restart apps that stopped because 
they have lost their database connection

300

fusionanalytics.
datacollector.
connectionpool.size

  50

We do not recommend to 
change the default 
configuration of 
FusionAnalytics DataCollector 
if not really required.



fusionanalytics.
datacollector.
connectionpool.
timeout

The number of seconds before a timeout occurs if a 
connection cannot be retrieved

30

fusionanalytics.
datacollector.
dirNameFormat

The format used for the directory names created in the 
archived and failed directories

yyy
y-
M
M-
dd

fusionanalytics.
datacollector.
disableCommitStat
ement

Disables database commits; useful for performance 
analysis only

false

fusionanalytics.
datacollector.
errorsBeforeFailure

not used 0

fusionanalytics.
datacollector.
importThreads

The number of import threads #co
res

fusionanalytics.
datacollector.
dirObserver.
scanInterval

The number of seconds between two checks for modified
/new/removed files in the application directories

50
00

fusionanalytics.
datacollector.
importShutdownTi
meout

The number of seconds to wait for an import to stop 
before it will be killed

15

fusionanalytics.
datacollector.
jobShutdownTimeo
ut

The number of seconds to wait for a job to finish before it 
will be killed

15

fusionanalytics.
datacollector.
maxLenErrorMessa
ge

The maximum length of an error message to be written to 
the logs before it will be truncated

10
24

fusionanalytics.
datacollector.
urlencoding

  UT
F-8

fusionanalytics.
datacollector.web.
recentImportSize

The number of most recently processed log files to show 
in the user interface

5

com.intergral.
fusionanalytics.ndc.
maxPoolSize

The number of threads the FADC thread pool used to 
import files will accept

8

Setting Up FusionAnalytics with HTTPS

Setting Up FusionAnalytics with HTTPS

FusionAnalytics supports secure (HTTPS) connections, however you need to setup / 
configure the server to use HTTP for this to work.

Tomcat

 You must install a Certificate into Tomcat to enable HTTPS. HTTPS then runs on a 
different port to the HTTP port (the HTTP port is typically 8400 in FusionAnalytics)

Modify the  server.xml file located under <fusionanalytics>/Server/conf

 

 
Note: You should also configure the HTTPS port in FusionAnalytics DataServices
(FADS) on the  hostname/port to tell it that HTTPS is availableServer Settings

Sending data to 
FusionAnalytics
DataCollectors are also 
available in HTTPS allowing 
data to be securely sent from 
FusionReactor into 
FusionAnalytics.

#


<Connector port="8443" protocol="HTTP/1.
1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="
true"
keystoreFile="C:/keys/keystore.jks" 
keystorePass="changeit"
clientAuth="false" sslProtocol="TLS" />

This is using port 8443 and assuming the keystore password is "changeit". Make 
any modifications as necessary

Restart the server (start it using catalina.bat to make sure no errors are being 
displayed).

For more information on how to configure a tomcat server to use SSL see: http://to
mcat.apache.org/tomcat-6.0-doc/ssl-howto.html

Creating a Self-Signed Certificate

You need to have Java installed and access to the keytool (java/bin)

keytool -genkey -keyalg RSA -alias selfsigned -keystore keystore.jks -storepass 
changeit -validity 360 -keysize 2048

Enter "localhost" as the first and last name!

Use the generated keystore in your tomcat installation.

Configuring FADS

You need to configure the FADS server to tell it that HTTPS is available.

Open FADS Administrator and log-in as a System User

Got the System  -> Server Settings

Enter the HTTPS server details into the Server Settings and click on the [Update 
Server Serttings] button

FusionAnalytics Jobs Configuration

 Typically Jobs in FusionAnalytics will generate links to the HTTP configuration but you 
may want links and images to use HTTPS also. This is controlled by the job itself but so far 
we are controlling this in the jobs by adding an Argument to the job:

Name Value

https true

AIR Client

Open the AIR client and create an application to localhost with HTTPS as the 
protocol.

You can also edit an existing application to use a secure connection
Right click on an existing application and select the "Secure 
Connection" check box

http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html
http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html


 

: Edit Server Details PanelFigure 1

When logging you will be prompted that the certificate is a problem (not secure).

Choose to view the certificate and install it.

When the installation wizard pops, chose to install the certificate yourself (not 
letting the wizard place it in the "right" place).

Then choose to see the physical locations and select the Trusted Root 
Certification Authorities and then pick the Registry node.

The certificate should install correctly and then OK the security dialog.

This should allow you to log in completely into the application without being 
prompted again.

This does not work with the certificate from the FR tickets. Use a keystore 
generate as above.

JVM Memory Requirements

JVM Memory Requirements

The JVM used by FusionAnalytics comes with 768MB heap and 256MB of 
PermGen memory configured as default. Depending on the number of 
applications and DataCollectors you want to use, you should increase these 
values so that the JVM does not run into memory issues.

The default memory configuration is sufficient to run the FA server with up to 5 
DataCollectors used in your application(s). Then for every additional 
DataCollector we recommend to increase the maximum heap space (which is 
defined via the -  argument) by 128 MB. Xmx

 

 

 

 

FusionAnalytics DataCollector (FADC)

FUSIONANALYTICS DATACOLLECTOR (FADC)

OVERVIEW

FusionAnalytics DataCollector (FADC) provides high speed import of arbitrary log 
files into a SQL database so that the resulting data can be processed by the 
FusionAnalytics Server and visualized by the FusionAnalytics Client. FADC uses 

These value are configured in the   and Windows Service Configuration
can be adjusted by simply editing the values in the configuration file. To 
apply the changes a restart of the service is required.

Please note that if you 
use a 32bit version of the 
JVM the maximum size of 
the heap space is limited 
to ~1.5GB.

We highly recommend to 
use a 64bit environment 
for FusionAnalytics.

DCML
A domain specific XML 
language called 
DataCollector Markup 
Language which defines 
from which files data is 



applications to model different usage scenarios. An application is typically made 
up of a DCML file and a set of auxiliary Groovy and/or BeanShell scripts, 
optionally accompanied by further classes or JAR files (e.g. JDBC drivers).

NEXT STEPS
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Upload an Application (FADC)

Upgrade an Application (FADC)

Upload Log or ZIP Files (FADC)
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DCML (FADC)

Applications (FADC)

Applications (FADC)

Overview

This section describes the menu items of the Application menu as shown in 
Figure 1.

 

 The Applications MenuFigure 1:

Next Steps

Application Summary (FADC)

Application Configuration (FADC)

Application Detail (FADC)

Upload an Application (FADC)

Upgrade an Application (FADC)

Upload Log or ZIP Files (FADC)

Import History (FADC)

imported and how this 
data is mapped to a 
relational database 
structure.



APPLICATION SUMMARY (FADC)

Application Summary (FADC)

Overview

The application summary gives you control over all of your DCML applications as well as information on log importing. The summary is split into the four sections

Runtime Information

Current Applications

Now Importing

Most recently imported

Figure 1 shows you a screen shot of the Application Summary page.

 

 Application SummaryFigure 1:

Runtime Information

This section details importing information and statistics such as uptime and disk usage, how many archives have been extracted, how many files are pending and have been 
imported and the current and maximum throughput..

Current Applications

Similar to FADS, this section allows you to control every aspect of your application. The available buttons are different depending on whether your application is started or 
stopped.
Options for a started application

Name Description

Application Detail Allows you to see information about this application's jobs, status, DataCollectors and database.

Stop Stops the application.

Upload Logs Allows you to manually upload logs.  See .Upload Log or ZIP Files (FADC)

Options for a stopped application

Name Description

Application Detail Allows you to see information about this application's jobs, status, DataCollectors and database.

Start Starts the application

Upload Logs Allows you to manually upload logs. See  .Upload Log or ZIP Files (FADC)

Upgrade Allows you to upgrade your application. See  .Upgrade an Application (FADC)



Configure Takes you to the   page.Application Configuration (FADC)

Delete Deletes your application from FADC.

Now Importing

This section details logs as they're being imported.

Most Recently Imported

This section shows what logs were most recently imported, what applications they belonged to and timestamp/transfer information.

Next Steps

Application Configuration (FADC) Application Detail (FADC)

Application Configuration (FADC)

Configuring applications in FADC

The Application Configuration page allows you to configure various properties of an FADC application. Here you can:

Configure data sources.

Limit data size.

Manage log file retention period/size.

Add, modify and delete DataCollectors.

Record uploaded files to avoid duplicate uploads.
Data Sources

This is where you can configure data sources for your application. Please fill in the settings that match your database.

Click to enlarge

Field 
Name

Description Example

Name The name of your datasource. Every FA4FR application contains a 
default data source (frdb) for fusion reactor which cannot be renamed.

DataSource1

Descri
ption

Enter a brief description of this data source. This data source is used to connect 
FusionAnalytics to FusionReactor

Datab
ase 
Type

The type of database you are using. Currently only Microsoft SQL Server 
is supported.

Microsoft SQL

Driver 
Class

The driver class tells FusionAnalytics the name of the JDBC database 
driver to use.

com.microsoft.sqlserver.jdbc.
SQLServerDriver

URL This specifies the JDBC connection URL used to connect to the 
database. Customize this field for your own database.

jdbc:sqlserver://127.0.0.1:1433;
loginTimeout=5;
databaseName=fadb

User A username that has full access to the database  

Passw
ord

The password for the above account  



Pool 
Size

This is the number of database connections that can be open at any one 
time.

30

Pool 
Timeo
ut 
(Seco
nds)

The number of seconds that have to pass before the pool times out. 10

FusionAnalytics DB Data Management

Here you can define the amount of time you would like FusionAnalytics to maintain your log/transactional data. 
FusionAnalytics stores detailed data and quantized data - this simply means that the data has been stored at different 
resolutions - 1 minute, 1 hour, 1 day, 30 days.

We recommend keeping the lower resolution (quantized) data for a longer period of time (so that you can analyze and 
compare your application's resources historically. The higher resolution (detailed) data should only be kept for short periods of 
time, because of the amount of space required to store this data in your database.

 This will affect the size of your database.

 The times you specify will refer to the dates inside your log files, not when the data was uploaded to FusionAnalytics.

 

Figure 1: Data size management

 
FusionAnalytics Processed Log File Management

Here you can define the number of days and the amount of storage which FusionAnalytics should take into account when 
managing retention of processed log files.

Once the FusionAnalytics DataCollector (FADC) has processed your log files then they will be stored in archive folders - one 
archive folder (with the naming convention YYYY-MM-DD) is used to store the logs for that day.

To ensure that you do not overflow your disk space, you can limit the number of days and the amount of space which can be 
allocated to storing these log files. Note that specified disk space (GB/MB) takes precedence over the number of days you 
specify i.e. if you reach your disk space limit, then the oldest log file data will be removed until you are back within acceptable 
space range. If you are within your space limitation, then we will simply retain the logs for the number of days you specify.

This configuration option is enabled per default. The default values are 30 days and 10GB as shown below.

Figure 2: Log size management

 
FusionAnalytics DataCollectors

FusionAnalytics supports multiple DataCollectors to be used in a single application; there must always be one DataCollector 
set up for FusionAnalytics to use. DataCollector names can consist of letters, numbers, hyphens and underscores only.



Figure 3: DataCollectors

If you enable the 'FusionAnalytics should delete the content from saved DataCollectors' option data belonging to this 
DataCollector will be also deleted from the database.
Miscellaneous Server Settings

If you are using FusionAnalytics to analyze logs generated from a Resin Application Server (e.g. with when using Railo), then 
you should tick the checkbox in this section.
Record Uploaded Files

FusionAnalytics can be configured to reject files that have been uploaded before. Therefore it records each file uploaded to 
this application together with the target DataCollector, the time when the upload occurred and a MD5 hashsum of the file in the 
database. You can limit the number of rows this table is allowed to have before entries - starting with the oldest data - will be 
deleted.
Reset Application

This feature was introduced in version 2.0.7 of FusionAnalytics. The function provides the ability to "Reset" an application, i.e. 
remove all the data belonging to the application but without deleting the configuration of the application.

Application Detail (FADC)

Application Detail (FADC)

The application detail page gives you control over the DataCollectors and Jobs of your application as well as information on log importing. The summary is split into the 
sections:

Application Status

Data Input

Data Management

Database Details



 

: Application DetailFigure 1

Application Status

This section provides you with information about the running imports of the application. Shown is how much percent of the lines of all files scheduled to be imported have 
been processed so far.

Data Input

Here you can control the DataCollectors of the application. You can start/stop all DataCollectors with a single click or you can start/stop each DataCollector separately after 
having clicked on the  button. In addition to the name of the DataCollector its import URL as used by FusionReactor is shown. A click on the Show/Hide DataCollectors D

 button opens the DataCollector detail page.ataCollector Detail
Data Management

This section lists the jobs defined by the application. Click the  button to show/hide the jobs of the application. Click the  to start all jobs, Show/Hide Jobs Start all Jobs
click  to stop them. Jobs can also be started/stopped separately. If you want to execute a job right now you can click the  button.Stop all Jobs Execute Now

A click on the  button opens a new page where you can edit the cron pattern that defines when the jobs executes.Job Detail

: Edit Cron Pattern of JobFigure 2

If new files are added to the application these values are updated as soon as their lines have been counted by FADC.



Next Steps

Application Configuration (FADC) 

Upload an Application (FADC)

Upgrade an Application (FADC)
UPLOAD AN APPLICATION (FADC)

Introduction

This section is going to guide you through the process of uploading/creating an application step-by-step with the use of screenshots as 
well as with detailed explanation.

Getting Started

Step 1: Access the FADC application

First step is to access the FADC application via the Browser. Depending on the port that was configured during the installation process, 
you will be able to access the FADC application by typing . If you have configured the FADC application in another localhost:8400/fadc
port, then you should use the configured port.
Step 2: Locate the Upload an Application option

In order to locate the " " option, navigate to Upload an Application Applications > Upload an Application.



Step 3: Upload an Application

When you click the " " option, a new screen is going to appear. See sceenshot below.Upload an Application

In the " " field choose a name of your preference. However, be aware that the name of the application is Application Name case 
 and can  use the options listed below.sensitive ONLY

- a - z

- A - Z

- 0 - 9

- dash ( - )

- underscore ( _ )

- whitespace

In the " " field click the  button and navigate to the following directory: DCML Application Package Browse C:
. In the directory you should be able to find two zip folders, the \FusionAnalytics\Applications fusionreactor-fadc-2.0.6-

and the For this application you need to choose the DCAPP  fusionreactor-fads-2.0.6-DSAPP. fusionreactor-fadc-2.0.6-
zip folder.DCAPP 

Click the " " button in order to upload the new application.Upload

Step 4: FusionAnalytics for FusionReactor Data Management Configuration

If the upload of the application was successful, a new screen is going to appear and is related with the Data Management configuration. 
See screenshot below.

If you encounter any issues with uploading an application, please double check that the application name is using the options 
listed below.



In that step, you should configure your database details. When the database configuration is completed, click the " " Test Connection
button in order to see if the connection was successful.
UPGRADE AN APPLICATION (FADC)

Upgrading an Application

Step 1: Navigating to the upgrade page

You can start to upgrade an application from one of the following places:

In the FADC navigation menu, go to Applications > Upgrade an Application.

In the FADC navigation menu, go to Applications > Application Summary and press the "Upgrade" button on a stopped 
application.

Step 2: Selecting the application to upgrade

You will be presented with a drop-down list of all applications that you have permission to upgrade.

Select the application you wish to upgrade.

Click the browse button and navigate to the package you would like to upgrade to.

Figure 1: Select the application you wish to upgrade

Step 3: Starting the Upgrade

Click Upgrade and FusionAnalytics will now make the necessary changes to your database and application configuration for 
the new version.

 

 

An application must meet the following prerequisites before upgrading:
The new application's version number must be higher than the current application's version number.

Application names can only contain a-z A-Z 0-9 dash( - ) underscore( _ ) whitespace

The Application must be stopped in order to be upgraded.

The Application must be able to connect to the database.

A restart of the sever is required before the upgraded application can be configured again



Step 4: Restart Server

Finally after the application upgrade has finished you have to restart the FusionAnalytics server. This completes the upgrade process.

Please be patient during the upgrade process. The time taken for this process to complete will vary depending on the size of 
your database!



UPLOAD LOG OR ZIP FILES (FADC)

Upload Log or ZIP files (FADC)

This page allows you to manually upload a log file or an archive of logs. Select the DataCollector that you want to receive the 
logs, click the Upload button and navigate to your .log or .zip file. After pressing submit you will see the Application Summary 
page and your logs will be processed.

 

Figure 1: Manually uploading logs





IMPORT HISTORY (FADC)

Import History (FADC)

The import history page displays up to the last 100 files imported by FADC.



 

Figure 1: Import history

User (FADC)

User (FADC)

Overview

The User menu contains the  menu item. Choose it if you want to change the password of the 'admin' user.Change Password (FADC)

Next Steps

Change Password (FADC)

CHANGE PASSWORD (FADC)

Change Password (FADC)

Here you can change the password used to log into FADC. Simply enter the current password and the password you would like to switch 
to as well as confirmation of this new password.



 

Figure 1: Changing password

System (FADC)

System (FADC)

Overview

From the System menu you can proceed to the  page, the  page and to the  page. Finally you can Email Settings Runtime Info License Info
click on the menu to quit your current session.Logout 

Next Steps

Email Settings (FADC)

Runtime Info (FADC)

Disk Usage Settings (FADC)

License Info (FADC)

Logout (FADC)

EMAIL SETTINGS (FADC)

Setting Up the Email Server

To receive notifications and reports from FusionAnalytics, you need to set up your email server.

In FADC this can be found under   (Figure 1).System  Email Settings

Figure 1: FADC Email Settings

The  should be the email address that you want any notifications sent from.From Address

The  is the email address(es) that all notifications are sent to; you can enter multiple addresses, as long as they are To Address
separated by a comma.



The  field is needed for  reports and notifications. This will need to be set to the name or IP address of the server that Mail Server all
sends SMTP mail messages; e.g. mail.company.com:25.

By default the port number is set to 25, but you can specify a port number after the address if needed; e.g. .127.0.0.1:587

If you need to provide authentication, you will need to put this in front of the address: . username:password@mail.company.com:25
RUNTIME INFO (FADC)

Runtime Info (FADC)

This page allows you to reset the runtime information displayed on the ?  page. This will also clear the "Now Application Summary (FADC)
importing" and "Most recently imported" sections on the Application Summary page.

 

Figure 1: Resetting runtime information

DISK USAGE SETTINGS (FADC)

Disk Usage Settings

On this page you can configure if and how FusionAnalytics should handle low disk space situations. Per default the Free Disk Space 
 is set to 20% of the total disk space. Changing this value does update the numbers in the description so that you can Threshold

immediately see the impact of your change.

Please note that you must have configured email settings beforehand to be able to receive notification emails. 

If you have enabled the  and there is not enough free disk space available new files added manually or sent by a Reject Imports option
FusionReactor instance will be rejected and deleted from the file system. A warning message for each rejected file will be written to the 
logs.

These addresses do not apply to the  (which allows you to receive TAP and Daily Status reporting feature of FusionAnalytics
reports on the status of your server by email). You can set different email addresses for these.



LICENSE INFO (FADC)

License Info (FADC)

The license info page can be found in   and displays all of the information related to your FusionAnalytics license. System > License Info
For help installing and activating your license see .Installing your license

The following information is displayed for each license you have installed:

Name Description Example

Product Name The name of your license. FusionAnalytics for FusionReactor 
(Subscription for 1 year)

Product Family The product family your license belongs to. FA4FR

Expiry Date The date your license will expire (not the same as 
activation expiry).

31-Dec-2017

License Status The current status of your license. Your license is valid and activated.

FusionAnalytics 
DataCollector

The number of datacollectors used and the maximum your 
license allows.

You are currently using 5 of 20 DataCollectors.

FusionAnalytics 
DataServices

The number of users and applications used and the 
maximum your license allows.

You are currently using 16 of 20 Applications 
and 31 of 40 Users.

You will also find buttons to activate or uninstall your license (depending on its current activation state) as well as the option to install a 
new license.
LOGOUT (FADC)

Logout (FADC)

You can log out of FADC by either:

clicking the logout link in the top right corner of FADC.

navigating to  in the navigation menu.System > Logout

Logging out will return you to the FusionAnalytics DataServices login screen.

DCML (FADC)

DCML (FADC)

Overview

 
DataCollector Markup 
Language



This section provides you with a basic overview about the DataCollector Markup 
Language (DCML) which is used to define how a FADC application works.

A DCML file is a XML document which conforms to the  and is FADC XSD schema
used to

declare which data should be imported,

how this data has to be processed before it is imported and

which additional tasks will be executed to bring the data into a format 
suitable to be used by FusionAnalytics Server.

A typical DCML configuration contains a root  element with three <FadcConfig>
children elements ,  and  <DataInput> <DataOutput> <DataManagement>
which define how incoming files are processed, how the belonging database 
schema looks like and which auxiliary tasks are used to manage the imported 
data.

<?xml version="1.0" encoding="UTF-8" 
standalone="yes"?>
<FadcConfig version='1.0' 
xmlns='http://www.fusion-analytics.
com/datacollector'>
    <DataOutput dbType='mssql'...>
    <DataInput...>
    <DataManagement...>
</FadcConfig>

Listing 1: DCML Structure

DataOutput

The  element defines the database type and schema - the tables, <DataOutput>
indices and statistics that will store the data provided by the  <DataInput>
element. The tables, indices and statistics defined here will be created in the 
database when you configure the application from the FADC web application.

<DataOutput dbType='mssql'>
    <Table name='table_1'...>
    <Index name='idx_table-1' 
onTable='table_1' fillFactor='90'...>
    <Statistics name='stat_table-1' 
onTable='table_1'...>
</DataOutput>

Listing 2: The DataOutput Element

Tables

A database table consists of a set of columns. In DCML this is defined as shown 
in Listing 3.

<DataOutput dbType='mssql'>
    <Table name='table_1' >
        <Column name='id' type='id' 
parse='false' />
        <Column name='date'/>

A domain specific XML 
language used to define 
from which files data is 
imported and how this 
data is mapped to a 
relational database 
structure.

The FADC XSD 
documentation is 
available here

The FADC DCML 
Database Documentation 
is available here

http://www.fusion-analytics.com/fa/helpdocs/200/DCMLSchema/fadc.html
http://www.fusion-analytics.com/fa/helpdocs/200/DCMLSchema/fadc.html
http://www.fusion-analytics.com/fa/helpdocs/200/DCMLSchema/fadc.html
http://www.fusion-analytics.com/fa/helpdocs/200/DCMLSchema/fadc.html
http://www.fusion-analytics.com/fa/helpdocs/200/dcmldoc/index.html
http://www.fusion-analytics.com/fa/helpdocs/200/dcmldoc/index.html
http://www.fusion-analytics.com/fa/helpdocs/200/dcmldoc/index.html


        <Column name='time'/>
        <Column name='dt' 
type='bigint'/>
        <Column name='message' 
type='varchar(30)' >
        <Column name='code' 
type='smallint' required='false'/>
    </Table>
</DataOutput>

Listing 3: The Table Element

When importing log files each line of the log file is tokenized into a list of column 
values matching the column definitions of the table element in the DCML. Per 
default a line is tokenized using the built-in high speed column parser which is 
able to parse the most common log line formats. For more control it is also 
possible to define a regular expression with the  elements optional <Table> sepa

 attribute which is then used to tokenize the input line into a list of ratorRegex
column values.

The type attribute defines the data type of the column in the database. When 
inserting the data FADC converts it to the correct type automatically. 
If a column has a  attribute FADC will not expect to find its value parse='false'
in the log line. If a column has no  attribute FADC will parse its value from type
the log line but ignore it. This is typically used to ignore redundant information in 
log lines. The  attribute is used to define database columns that are required
allowed to receive null values. Use it to process optional column values.

The order of the  elements used in the  elements defines how <Column> <Table>
to parse a line of data so that it maps to the columns of the table.

If you want to import log files into a table the order of the columns of the 
DCML table definition must match the columns of the lines in the log file.

How a log file is processed by FADC

The following example shows how a log file is processed by FADC 
depending on the table definition of Listing 3.

Our example log file contains two lines which will be tokenized one 
after each other:

2008-11-17 13:36:40.671 
1226925400671 "a message and a 
code" 0
2008-11-17 13:36:40.703 
1226925400703 "a message 
without a code" 

The first line is tokenized by the internal column parser into a list of 
strings:

"2008-11-17", "13:36:40.671", 
"1226925400671", "a message 
and a code", "0"

Then the column definitions of Listing 3 are applied to assign the values 
to their target columns:



Indices and Statistics

To keep your database efficient DCML allows you to define additional  <Index>
and  elements under the  element. Listing 4 and <Statistics> <DataOutput>
Listing 5 show example definitions for an index called 'idx_table_1' and statistics 
named 'stats_table_1'.

<Index name='idx_table_1' 
onTable='table_1' fillFactor='90'>
    <Column name='dt'/>
    <Column name='message'/>
</Index>

Listing 4: An Index Definition

<Statistics name="stats_table_1' 
onTable='table_1'>
    <Column name='dt'/>
</Statistics>

Listing 5: A Statistics Definition

DataInput

The  element defines the sources from which data is imported. It <DataInput>
can contain one or more  elements which logically group a <DataCollector>
set of data belonging together (e.g. the log files of a FusionReactor instance and 
the ColdFusion server log files).

<DataCollector name='faDataCollector-
1' timezone='Europe/Berlin'>
    <Events.../>
    <OnCreate program="
onCreateDataCollector.groovy"/>
    <OnDelete program="
onDeleteDataCollector.groovy"/>
    <OnImport program="onImportFile.
groovy"/>
</DataCollector>

dt:"1226925400671", message:"a 
message and a code", code:"0"

Column values without a  attribute are discarded and an type
appropriate SQL statement is added to the current batch of insert 
statements. The second line is then processed in the same way. Since 
the line does not have a 'code' value the belonging SQL insert 
statement does not specify a value for the 'CODE' column. This works 
because the 'CODE' column has a  attribute set. required='false'
Once the maximum size of the batch is reached or no more lines are 
available the insert operation is committed to the database.



Listing 6: A DataCollector Definition

Data is imported if the regular expression defined by the  attribute of matchFile
a  element as shown in Listing 7<Match>

<Events>
    <Match name='sample' 
matchFile='(?i)sample.*[.]log'>
        <TargetTable table='table_1'
/>
        <Line regex='.*'/>
    </Match>
</Events>

Listing 7: A Match Definition

matches the name of a file found in an import directory. The  <TargetTable>
element defines with its  attribute into which database table data read from table
the file will be inserted. The  element defines with its  attribute <Line> regex
which parts of each line should be taken - here the regular expression  '.*'
specifies to use the complete line.

Below the  element you can optionally use , <Events> <OnCreate> <OnDelete>
and  elements to execute a user defined script triggered by the <OnImport>
belonging event.

DataManagement

The  element defines auxiliary jobs written in Groovy or <DataManagement>
BeanShell which are executed depending on their  element. The job Trigger
defined in Listing 8 will result in FADC executing the Groovy script 'archiveFiles.
groovy' at 1:00am every night. The script is expected to be in the DCML 
applications root directory.

<DataManagement>
    <Job program='archiveFiles.
groovy' name='Archived Logfiles 
Management'>
        <Trigger name='archiveFiles' 
cronPattern='0 0 1 * * ?'/>
    </Job>
</DataManagement>

Listing 8: A Job Definition

FusionAnalytics DataServices (FADS)

FUSIONANALYTICS DATASERVICES (FADS)

Each application in FADC has an import directory containing a directory 
for each of its DataCollectors. These directories are monitored by 
FADC so that any file found there is detected and processed by FADC.

Cron Patterns
FADC uses the  to manage its jobs. Read the Quartz Scheduler tutorial 

 to learn more about using cron patterns.available on their site

http://www.quartz-scheduler.org
http://www.quartz-scheduler.org/documentation/quartz-1.x/tutorials/crontrigger
http://www.quartz-scheduler.org/documentation/quartz-1.x/tutorials/crontrigger
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This section provides information on using and configuring FusionAnalytics 
DataServices.
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Applications (FADS)

Applications (FADS)

Overview

This section details how to use applications within FusionAnalytics DataServices.

Next Steps

Application Summary (FADS)

Application Configuration (FADS)

Application Detail (FADS)

Application Scope (FADS)

Upload an Application (FADS)

Upgrade an Application (FADS)

APPLICATION SUMMARY (FADS)

Application Summary (FADS)

Overview



This section goes into detail about how to navigate and use the Application Summary page in FusionAnalytics DataServices.

The Application Summary page gives you control over all of your FADS applications and is the first page that is displayed in FADS. The options available for an application 
vary depending on whether it is started or stopped.

 

Figure 1: Application Summary

Options for a started application

Name Description

Stop Stops the application. This will remove all scheduled jobs from the scheduler, preventing them from running until the application is started again.

Restart An application restart causes the currently running application to be stopped and started automatically with one button click.

Launch Launches the FusionAnalytics DataServices Web Client

Info Displays the Application Detail page. See Application Detail (FADS)

Scope The Application Scope will display the application's essential elements and their details. See Application Scope (FADS)

Options for a stopped application

Name Description

Start Starts the application. This will add all scheduled jobs to the scheduler, ensuring they run at the next allotted time.

Configure Displays the application configuration page, used to configure database connections and other application properties. See Application Configuration 
(FADS)

Info Displays the Application Detail page. See Application Detail (FADS)

Upgrade Allows the application to be upgraded to a later version.

Enable
/Disable

When an application is enabled, it will be started when the server restarts regardless of its previous stopped/started state 
and its jobs will be added to the scheduler. A disabled application will not be started when the server restarts and its jobs 
 will not be added to the scheduler.

Delete Deletes an application, removing all association to it within FADS including scheduled jobs and user mappings. Some 
elements associated to the application cannot be deleted until the server is restarted.

Next Steps

Application Configuration (FADS)  Application Detail (FADS) Application Scope (FADS)

Please Note: You must be an administrator of at least 1 application to see the Application Summary, and only applications for which you are an administrator or 
user will be displayed.

An application cannot be named:
with a slash character ( neither'\' nor '/') in any position

with a semicolon (';') in any position

with a colon (':') in any position

as a single dot character ('.')

as a single at character ('@')

the same as an existing application (different capitalization is not considered unique)

When an application is started, it can be accessed via the Adobe AIR Client or the Web Client by users with sufficient permissions. A started application cannot be 
configured.



Application Configuration (FADS)

Application Configuration (FADS)

The Application Configuration page allows you to configure various properties of an application.
Name/Value Elements

 

Figure 1: Default Name / Value Elements for the Analytics for FusionReactor application

Here you can add, modify or remove Name/Value Elements for your application.

For the default Analytics for FusionReactor application, these have been pre-configured for you and should not be 
changed.

It is worth stating that in version 2.0.7 of FusionAnalytics the "DateFormat" field was added as a way to help users to change 
the date format used in the various tables in the UI. For example, if you want to change the display date format from the 
European style to an American style then you can simply change the "DateFormat" field to be "MM.DD.YY JJ:NN:SS.TTT" and 
afterwards click the "Modify" button in order to save the changes. If the changes have been successfully saved, a green 
message will appear on the top of your screen. The message would look like the screen shot below.

 
Application Scheduled Tasks

Here you can activate or deactivate?  that are run by the application.Scheduled Tasks (FADS)

 

Figure 2: Activating and Deactivating scheduled tasks.

 
Data Sources

This is where you can configure data sources for your application. Please fill in the settings that match your database.

Setting the "DateFormat" will only work correctly if the APML files (precisely the value of the "DateFormat" element 
in these files) of the application have not been manually altered.

The "Name" field is simply anything you wish to use as a name for this data source. It is  the name of the not
database. The name of the database must be added to the URL field as shown below.

Every FA4FR application contains a default datasource (frdb) for FusionReactor which cannot be renamed.



 

Figure 3: An example of a data source for an FADS application.

Field 
Name

Description Example

Name The name of your datasource. Every FA4FR application contains a 
default data source(frdb) for fusion reactor which cannot be renamed.

DataSource1

Descri
ption

Enter a brief description of this data source. This data source is used to connect 
FusionAnalytics to FusionReactor

Datab
ase 
Type

The type of database you are using. Currently only Microsoft SQL Server 
is supported.

Microsoft SQL

Driver 
Class

The driver class tells FusionAnalytics the name of the JDBC database 
driver to use.

com.microsoft.sqlserver.jdbc.
SQLServerDriver

URL This specifies the JDBC connection URL used to connect to the 
database. Customize this field for your own database.

jdbc:sqlserver://127.0.0.1:1433;
loginTimeout=5;
databaseName=fadb

User A username that has full access to the database  

Passw
ord

The password for the above account  

Pool 
Size

This is the number of database connections that can be open at any one 
time.

40

Pool 
Timeo
ut 
(Seco
nds)

The number of seconds that have to pass before the pool times out. 30

Application Detail (FADS)

Application Detail (FADS)

There are three sections to the application detail page:

Summary

On this page:

Summary

If you upload a new application into FADS and want to use a new database with it, you must upload an FADC 
application on the same database to automaticaly create all of the required tables and database objects. This will 
then allow you to launch your FADS application.



Manifest Data

Data Dump
Summary

The summary shows basic information about the application.

Name Description

Key The application deployment key.

Name The application name.

Revision The application version.

Deployed The date and time that the application was deployed.

Enablement Whether the application is enabled or disabled.

Current 
State

The current state of the application (Stopped, Started, Installed, 
Upgraded).

Back to the top

Manifest Data

The Manifest Data section displays information related to the installation of the 
application.

Key Description

Location The physical location of the application folder.

Provider The application provider.

ID The UUID (Universally unique identifier) of the application.

Support The support email address.

Configurati
on

The location of the application configuration.

Analytics Detailed information about the application. *Hover over any of these for 
a detailed list.*

Back to the top

Data Dumps

The Data Dump section displays any exception log data that was last output. If 
the application could not be started because of an error within the application, 
detailed log data would be shown here.
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Manifest Data

Data Dumps

Application Scope (FADS)

Application Scope (FADS)

The application scope shows essential elements of an application and their 
details.

Key Type Description 

id java.util.UUID The UUID (Universally unique identifier) of an 
application 

revisio
n 

java.lang.String The current version of the application 

applica
tion 

com.intergral.fads.impl.
app.APMLApplication 

The application type 

dataso
urces 

java.util.ArrayList A list of datasources used by the application 

descrip
tion 

java.lang.String The application description 

name java.lang.String The application name 



deploy
mentK
ey 

java.lang.String The application deploymentKey 

provide
r 

java.lang.String The application provider 

product
Family 

java.lang.String The product family to which this application 
belongs 

elemen
ts 

java.lang.String The Name/Value elements for this application. 
See ?Application Configuration (FADS)

support
URL 

java.net.URL The mailto: address of the support inbox for this 
application. 
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UPLOAD AN APPLICATION (FADS)

Introduction

This section is going to guide you step-by-step through the process of uploading an application in FADS. Additionally, this documentation 
contains detailed explanation of the each step alongside informative screenshots.

Getting Started

Step 1: Access the FADS application

The first step is to access the FADS application via the browser. If you have kept the default configurations during the installation 
process of FusionAnalytics, then you should be able to access the FADS application by typing: localhost:8400/fads

Step 2: Locate the Upload an Application option

In the FADS navigation menu, go to .Applications > Upload an Application

Step 3: Upload an application

When you click the " " option a new tab is going to appear. See screenshot below.Upload an Application



1.  

2.  

In the " " choose a name of your preference. However, be aware the the Application name Application Deployment Key cannot 
contain  like or any  like  or have the special characters  ( ' ; ',' . ', ' : ','@' ) slash characters ( ' \', ' / ' ) same name as an 

.existing application

In the " " field click the  button and navigate to the following directory: APML Application Package Browse C:
. In the directory you should be able to find two zip folders, the \FusionAnalytics\Applications fusionreactor-fadc-2.0.6-

and the For this application you need to choose the DCAPP  fusionreactor-fads-2.0.6-DSAPP. fusionreactor-fads-2.0.6-
zip folder.DCAPP 

Click the " " button in order to upload the new application.Upload

Application Configuration (FADS)

If the application has been successfully updated, a new tab is going to appear and is related with the Application configuration.

For more information about the application configuration, please check out the link, .Application Configuration (FADS)

UPGRADE AN APPLICATION (FADS)

Upgrading an Application

Step 1: Navigating to the upgrade page

You can upgrade an application in two places:

In the FADS navigation menu, go to Applications > Upgrade an Application.

In the FADS navigation menu, go to Applications > Application Summary and press the "Upgrade" button on a stopped application.

Back to the top

Step 2: Selecting the application to upgrade

You will be presented with a drop-down list of all applications that you have permission to upgrade.

Select the application you wish to upgrade.

Click the browse button and navigate to the package you would like to upgrade to.

If you encounter any issues with uploading an application, please double check that the application name is using the options 
listed below.

If your license does not allow any more applications you can either...
Delete an application belonging to the same product family as the one you're trying to upload

Upgrade to a license with bigger application capacity

An application must meet the following prerequisites before upgrading:
The new application's version number must be higher than the current application's version number.

Deployment keys cannot contain the slash character (neither '/' nor '\'), the semicolon or the colon in any position; nor can they named with a single dot ('.') 
or at ('@').

The Application must be stopped in order to be upgraded.

A restart of the sever is required before the upgraded application can be configured again

http://docs.intergral.com/pages/viewpage.action?pageId=34898077


 

Figure 1: Select the application you wish to upgrade

Back to the top

Step 3: Upgrading the application

Next press "Upgrade" and you will be taken to the application configuration screen in order to configure the upgraded application. See  for Application Configuration (FADS)
more information on configuring applications.

 

Figure 2: Application Configuration page

Step 4: Restart Server

Finally after the application upgrade has finished you have to restart the FusionAnalytics server. This completes the upgrade process.

Back to the top



Users (FADS)

Users (FADS)

Overview

This section details information about users in FusionAnalytics DataServices.

Next Steps

Users Summary (FADS)

User Mappings
USERS SUMMARY (FADS)

User Summary (FADS)

Overview

This section details creating, updating and mapping users as well as explaining the FusionAnalytics DataServices users 
interface.

You are able to do the following from the user summary page:

Create new users

Delete users

Edit users

Control user mappings (See ? ).User Mappings

Creating new Users

To create a new user, navigate to Users > User Summary.  You will see the Users Summary screen in the content area. Click 
on the "Create a New User" button and fill out the displayed form:



 

Figure 1: Creating a user

Each user created must have the following fields completed correctly in order to be created:

Username

Password

Password (Confirm)

The following fields are not mandatory for user creation:

First Name

Last Name

Email (Required if you want this user to receive reports via email)

Deleting users

To delete a user, navigate back to the User Summary page (Users > User Summary). You will see a list of users present on 
your system:

 

Figure 2: Deleting a user

To delete a user, simply press the Delete button and press OK at the confirmation dialog.

Editing a user

Once a user is created, you cannot change their username. Please ensure you have entered the correct username 
before submitting.

You may only delete users who either:
have no mappings.

are mapped  to applications for which you are an administrator.only



To edit a user, follow the steps in  but click the Edit button instead of Delete. Then fill out the form as described Deleting Users
in Creating new users

User Mappings

To learn about user mapping, see ? .User Mappings

Next Steps

User Mappings

User Mappings

User Mappings

There are two types of user mapping in FADS:

Administrator

User

There is also a single .System User role
The Administrator Role

The administrator role grants full access to an application. An application administrator can:

Log into FADS and FADC.

Start and stop the application.

Access all functions made available by the Application Summary. See ? .Application Summary (FADS)

Add, remove or modify any "user" mappings for that application.

Launch the web client.

View the application admin perspectives in the client.

Edit application scheduled tasks.

Run application scheduled tasks.

Deactivate application scheduled tasks.
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The User Role

The user role grants basic access to an application. An application user can:

Access the application via the AIR client.

Access the web client via a direct link.

An application user cannot log into FADS or FADC, nor can they view the admin perspectives in the client.
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System User role

There is a single System User within FADS. The System user will have complete access to all applications within FADS and 
FADC, all scheduled tasks for all applications (both application and user) and full access rights in regards to the modification 
of users. If you open the "Users Summary" page (Users > Users Summary) as the system user you will see that a system 
user has no mappings displayed with its edit screen. It is automatically mapped to all applications

Back to the top

Mapping a user

To map a user to an application, go to the ?  and click edit on the user you wish to map. You will be Users Summary (FADS)
presented with the edit screen and will find the mapping section at the bottom. If you have applications installed and are an 
administrator to any of these applications you should see the following screen:

A user only requires a single administrator mapping to gain access to FADS and FADC, though only applications 
they are mapped to will be visible.



 

Figure 1: Available Mappings

Simply select the mapping from the drop-down box and press Add Role.

? 

Figure 2: Add Role

?
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Editing a mapping

To edit a user mapping, go to the ?  and click edit on the user you wish to change. You will be Users Summary (FADS)
presented with the edit screen where you will find the current mapping section. If you are an administrator to the application 
you with to edit a mapping for you should see the following screen:

 

Figure 3: Current Mappings

You can either alter the mapping and press Modify, or delete the mapping completely.

Back to the top

Scheduled Tasks (FADS)

Scheduled Tasks (FADS)

Overview

This section explains how to create and modify both User and Application 
Scheduled Tasks in FusionAnalytics DataServices.



Next Steps

User Tasks Summary

Application Tasks Summary

USER TASKS SUMMARY

FADS User Scheduled Tasks

Steps to Setup:

Creating a User Job

Running Jobs

Database Connection

Scheduled tasks that use a database require a database connection to be alive.
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Creating a User Job

The following are the types of schedules for jobs

On-Time: Will run once on the designated date and time and will not be scheduled again unless configured again.

Recurring Daily: Job will execute every Day at the following time

Recurring Weekly: Job will execute every Week at the following time

Recurring Monthly: Job will execute every Month at the following time

Daily Every: Job will execute within the specific time periods defined every day

 

: Create a New USer Scheduled TaskFigure 1

The following is a list of validation constraints in place for the entry fields



Name Date Format 

One-Time hh/mm + (AM
/PM)

Recurring hh/mm + (AM
/PM)

Daily 
Every 

hh/mm + (AM
/PM)

Start Date mm/dd/yyyy

End Date 
(optional) 

mm/dd/yyyy 

Any invalid input will be identified and appropriate error messages will prompt valid input over the invalid fields.

 

: Create a New User Scheduled Task - ValidationFigure 2
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Running Jobs

A job can only be executed and remain within the scheduler if the application the job belongs to is started. If the application is 
stopped then the job is removed from the scheduler and will not be executed even if it's time to run as been reached. If a job's 
application is started the job will run upon its scheduled date and time. There is an option besides every job, user or 
application that allows a specific job to be executed at the current time via the 'Run Now' button. This button will be unusable if 
the job's application is stopped.

Back to the top

APPLICATION TASKS SUMMARY

FADS Application Scheduled Tasks

Steps to Setup:

Editing Application Job

Running Jobs



Database Connection:

Scheduled tasks that use a database require a database connection to be alive. See ? .Application Configuration (FADS)
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Editing Application Job

Application scheduled tasks can only be edited, not created, as they are pre-installed with applications.
To edit an application scheduled job from FADS navigate to Scheduled Tasks > Application Tasks Summary. An admin has 
the permission to edit every aspect of the application job except the job's name and data provider.

The following are the types of schedules for jobs

On-Time: Will run once on the designated date and time and will not be scheduled again unless configured again.

Recurring Daily: Job will execute every Day at the following time

Recurring Weekly: Job will execute every Week at the following time

Recurring Monthly: Job will execute every Month at the following time

Daily Every: Job will execute within the specific time periods defined every day

 

: Editing Scheduled TasksFigure 1

The following is a list of Validation Constraints in place for the entry fields

Name Date Format 

One-Time hh/mm + (AM
/PM)

Recurring hh/mm + (AM
/PM)

Daily 
Every 

hh/mm + (AM
/PM)

Start Date mm/dd/yyyy

End Date 
(optional) 

mm/dd/yyyy 
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Running Jobs

A job can only be executed and remain within the scheduler if the application it belongs to is started. If the application is 
stopped then the job is removed from the scheduler and will not be executed even if it's time to run as been reached. If a job's 
application is started the job will run upon its scheduled date and time. There is an option besides every job, user or 
application that allows a specific job to be executed immediately via the 'Run Now' button. This button will be unusable if the 
job's application is stopped.
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Disabling an Application Job

You can disable an application by either:

visiting its configuration page

 

: Application Scheduled TasksFigure 2

vising the Application Tasks Summary page

 

: Application Tasks Summary PageFigure 3

Disabling an Application Job will cause it to be removed from the scheduler and prevent it from executing at its designated 
time. Enabling the job will place it back into the scheduler.

Back to the top

System (FADS)

System (FADS)

Overview

This section details the options available within the System section of 
FusionAnalytics DataServices.

Next Steps

Sessions

Controllers

Asynchronous Jobs

Server Settings

License Info (FADS)



Logout (FADS)

SESSIONS

Sessions

A session is considered to be one user using FusionAnalytics through one client. When you log into the FusionAnalytics Client you are starting a session and logging out 
terminates that session. If you were to log into the AIR client and, at the same time, log into a separate server using the Web client then you will have creates two separate 
sessions. To see all of the currently active sessions, select "Sessions" from within the "System" section of the Table of Contents.

With no active sessions the content area will look like this:

 

: Session SummaryFigure 1

Example Session: Web Client

Follow these steps in order to generate a session using the Web Client and view it from within FADS:

Log into FADS as either System user or Admin user

If one is not already started then start an application you have admin rights to (if administrator)

Press the "Launch" button to launch the web client

Log in with valid credentials

Return to FADS and navigate to the System -> Session page. The session's details will be listed i.e Username of user logged in, Login Time, Session ID and the 
User's Name

 

: Current Session SummaryFigure 2
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Example Session: AIR Client

Follow these steps in order to generate a session using the Web Client and view it from within FADS:

Log into FADS as either System user or Admin user

If one is not already started then start an application you have admin rights to (if administrator)

Click on the URL of the application in order to copy it to your clipboard.

 

: Copy the Application URL from FADSFigure 3

Start the AIR client and (if one is not already set up) create a new link to your application by pasting the URL into the top bar and clicking "Add Application"



 

: Paste Application URL into the AIR ClientFigure 4

Double-click on the server icon to bring up the login screen and log in with valid credentials
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CONTROLLERS

Controllers

All actions within the Data Server are handled by Controllers. These controllers are a logical breakdown of each responsibility of the Data Server, and are complex, self-
contained components. E.g., the Cache Controller which is responsible for intelligently storing and retrieving large amounts of data very quickly. Selecting the “Controllers” 
menu item from the “System” section in the main Table of Contents will display all the controllers available within DataServices. Some of the more advanced controllers also 
allow you to perform some action. These actions vary from clearing records, dumping the state to the screen and also stopping/starting particular functionality. Under normal 
circumstances, you shouldn't need to change anything in the Controllers page; however you may be directed to obtain information from here for debugging, should you make 
a support request.

 

: All ControllersFigure 1
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ASYNCHRONOUS JOBS

Asynchronous Jobs

When the client (either the FusionAnalytics AIR client, or the web client) requests a set of data or an analytical operation from the server, the client creates a job which is 
streamed into the server.

In order to remain responsive, the client simply waits for the job to complete in the background. We say that these jobs are asynchronous – independent in time.

When DataServices receives the job, it queues it, executing it when it has available resources. With many jobs being queued and executed simultaneously, it is sometimes 
difficult for the user to comprehend what is happening when a job takes time to execute. By selecting the “Asynchronous Jobs” menu item from the “System” section in the 
main Table of Contents you will be able to view the current status of the job controller. You are able to see all the queued jobs, currently running jobs and a history of past 
jobs. It also displays the number of failed jobs.



 

: Summary of Asynchronous JobsFigure 1
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SERVER SETTINGS

Server Settings

Navigating to System -> Server Settings you will see the following: Under the heading "Server" you can configure the hostname from where the application is hosted along 
with the port. The https address of the server (host and port) can also be configured if secure connection urls are used. Under the heading "Email Server" you can configure 
where notification emails are sent from and to as well as adding a mail server to process these requests. (This is critical configuration for Daily Reports and T.A.P Reports)

 

: Server Settings*Figure 1

More information about setting up HTTP can be found here: .Setting Up FusionAnalytics with HTTPS

Back to the top



LICENSE INFO (FADS)

License Info (FADS)

The license info page can be found in   and displays all of System > License Info
the information related to your FusionAnalytics license. For help installing and 
activating your license see .Installing your license

The following information is displayed for each license you have installed:

Name Description Example

   



Product 
Name

The name of your license. FusionAnalytics for 
FusionReactor 
(Subscription for 1 year)

Product 
Family

The product family your license 
belongs to.

FA4FR

Expiry 
Date

The date your license will expire 
(not the same as activation 
expiry).

31-Dec-2017

License 
Status

The current status of your license. Your license is valid and 
activated.

FusionAna
lytics 
DataCollec
tor

The number of datacollectors 
used and the maximum your 
license allows.

You are currently using 5 
of 20 DataCollectors.

FusionAna
lytics 
DataServic
es

The number of users and 
applications used and the 
maximum your license allows.

You are currently using 
16 of 20 Applications and 
31 of 40 Users.

You will also find buttons to activate or uninstall your license (depending on its 
current activation state) as well as the option to install a new license.

Back to the top

LOGOUT (FADS)

Logging out of FADS

You can log out of FADS by either:

clicking the logout link in the top right corner of FADS.

navigating to System > Logout in the navigation menu.

Logging out will return you to the FusionAnalytics DataServices login screen.
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APML (FADS)

APML (FADS)

Overview

This document introduces , the , a system for describing analytical applications.APML Analytical Program Markup Language

APML is an XML grammar for describing software which performs analytical functions.
APML, and the auxiliary files which comprise an APML Application (also known as a DataServices Application) are loaded by FusionAnalytics DataServices, and used to 
answer demands for
data from the FusionAnalytics client software (either web or AIR-based).

APML is used to describe the three main components of a FusionAnalytics application:

Perspectives, which are made up of one or more

Views, whose data is supplied by

Data Providers

 

Perspectives are visible in the client as separate windows. The views are contained within them, and the calls to the individual Data Providers (DPs) are handled by the 
client framework.

In Figure 1, the CPU Usage perspective is visible. The perspective consists of two views:
• A CPU Line Chart showing two peaks
• A timeline controller



The timeline is simply another view, and all that is required to 'wire up' these components is that the timeline be present in the perspective. 
The client framework will take care of handling the internal message bus, ensuring that all interested parties are scrolled in sync with the timeline.

Here, for example, is the APML used to construct the perspective above:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<Module xmlns="http://www.intergral.com/FADS/v1/APML">
   <Perspectives>
      <Perspective id="CPUUsage">
         <Name>CPU Usage</Name>
         <Description>Shows details of all resource usage</Description>
         <Layout type="com.intergral.fusionanalytics.view.layout.layoutManager.
SimpleFlowLayoutManager">
            <VBox>
               <ViewRef ref="CPULC" title="CPU"/>
               <ViewRef ref="Global.TimeLine" height="145"/>
            </VBox>
         </Layout>
      </Perspective>
   </Perspectives>

   <Views>
      <View id="CPULC">
         <Name>CPU Usage</Name>
         <Description>Process and System CPU Usage</Description>
         <Component ui="com.intergral.fads.model.renderer.ChartBaseVisualization">
            <DataProviderRef ref="CPULC"/>
            <Argument name="Title">Process and System CPU Usage</Argument>
            <Argument name="Background.Color">0xffffff</Argument>
            ...further arguments omitted for brevity...
         </Component>
      </View>
   </Views>

   <DataProviders>
      <DataProvider id="CPULC">
         <Description>CPULC</Description>
         <Arguments>
            <Argument name="server" bindingname="Server.FilterBy.server"/>
            <Argument name="start" bindingname="Global.TimeLine.start"/>
            ...further arguments omitted for brevity...
         </Arguments>
         <Provider>
            <Program language="groovy" return="response" program="apml
/SeriesDataProvider.groovy"/>
         </Provider>
      </DataProvider>
   </DataProviders>
</Module>

Listing 1: APML for the CPU Usage Perspective



The APML, application manifest and Data Provider samples are all taken from our Analytics for FusionReactor DataServices application. 
This application ships with FusionAnalytics (it is optionally preinstalled by the installer).
The zip file containing the application is installed in the FusionReactor applications folder, and is called fusionreactor-fads-1.0.0-DSAPP.zip. Feel free to unzip it and take 
a look at the files yourself.

Next Steps

Data Provider Programs
Learn about how APML uses a Data Provider to specify how data is retrieved from the database

Layout
Learn about using the Layout tag. 

Component
Learn more about the View Component and the arguments used by it. 

APML Volume Switching
Customize the component to your needs using switch/case/default structuring.
APML VOLUME SWITCHING

APML Volume Switching

Within an APML   tag, at least one   must be specified. The View Component
Component is the visualization used in the Client to display the data points 
returned from the DPP.

In order that components may be switched based on data volumes, a simple Swit
 structure is supported. ch/Case/Default

Listing 1 shows a snippet of APML used in the Analytics for FusionReactor 
"DataFinder" perspective. A different component may be selected based on the 
result of the 
execution of a Volume Provider (VP), in this case GPRequestProviderVP. The 
Volume Provider is a 
DPP, named in the SwitchConditionProvider tag, which simply returns a single 
integer representing 
the number
of data points which would be selected if the corresponding DPP were run.

 

 

<View id="DataFinder">
  <Name>DataFinder</Name>
  <Description>DataFinder<
/Description>
  <Switch>
    <SwitchConditionProvider ref="
GPRequestProviderVP"/>
 
    <Case to="86400000" resolution="
HOUR">
      <Component ui="com.intergral.
fusionanalytics.view.itemRenderers.
visualisations.TimeBlockChartBitmap">
        <DataProviderRef ref="
PagedRequestDataFinderProvider"/>
        <Argument name="Title"
>DataFinder</Argument>
        ... further arguments 
omitted for brevity ...
      </Component>
    </Case> 

 



 
    <Case to="2592000000" 
resolution="DAY">
      <Component ui="com.intergral.
fusionanalytics.view.itemRenderers.
visualisations.TimeBlockChartBitmap">
        <DataProviderRef ref="
PagedRequestDataFinderProvider"/>
        <Argument name="Title"
>DataFinder (Day)</Argument>
        ... further arguments 
omitted for brevity ...
      </Component>
    </Case>
 
    <Default resolution="YEAR">
      <Component ui="com.intergral.
fusionanalytics.view.itemRenderers.
visualisations.TimeBlockChartBitmap">
        <DataProviderRef ref="
PagedRequestDataFinderProvider"/>
        <Argument name="Title"
>DataFinder (Year)</Argument>
        ... further arguments 
omitted for brevity ...
      </Component>
    </Default>
  </Switch>
</View>

Listing 1: View with Switch/Case/Default Structure

The switch processor then selects a component based on that result. In this way, 
FusionAnalytics is able to select a visualization component based on the volume 
of data being rendered. 
In Listing 1, you can see the same  is being run (DataProvider PagedRequestDat

), but the arguments differ. This allows the component to be aFinderProvider
customized based on the volume of data selected for display.

The DPP Provider tag may also be switched in a similar way. The Component will 
remain unswitched, but the Provider tag is placed within a Swtich/Case/Default 
structure, and a Volume Provider is run prior to the switch.
Although the component will not change, the provider (and the arguments 
supplied within the Provider tag) can be different, customized to the volume of 
data required for rendering.
COMPONENT

Component

Within an APML  tag, at least one  must be specified. The Component is theView Component
visualization used in the Client to display the data points returned from the .DPP
There are many visualization components supplied within the client.

The component used by the CPU Usage perspective given in the , is listed below:example



<Component ui="com.intergral.fads.model.renderer.ChartBaseVisualization">
 <DataProviderRef ref="CPULC"/>
 <Argument name="Title">Process and System CPU Usage</Argument>
 <Argument name="Background.Color">0xffffff</Argument>
 <Argument name="Chart.Maximum">100</Argument>
 <Argument name="start" bindingname="Global.TimeLine.start"/>
 <Argument name="end" bindingname="Global.TimeLine.end"/>
 <Argument name="timezone" bindingname="Global.TimeLine.timezone"/>
 <Argument name="Series.Count">3</Argument>
 <Argument name="Series.1.ID">qseries.resource.system_cpu_pct</Argument>
 <Argument name="Series.1.Type">AreaSeries</Argument>
 <Argument name="Series.1.Label">System CPU Usage (%)</Argument>
 <Argument name="Series.1.Relation">qseries.resource.system_cpu_pct</Argument>
 <Argument name="Series.1.X">DT</Argument>
 <Argument name="Series.1.Y">system_cpu_pct</Argument>
 <Argument name="Series.1.Color">0xaaaaaa</Argument>
 <Argument name="Series.1.Alpha">0.5</Argument>
 <Argument name="Series.1.Visible">true</Argument>
 <Argument name="Series.2.ID">qseries.resource.process_cpu_pct</Argument>
 <Argument name="Series.2.Type">AreaSeries</Argument>
 <Argument name="Series.2.Label">Process CPU Usage (%)</Argument>
 <Argument name="Series.2.Relation">qseries.resource.process_cpu_pct</Argument>
 <Argument name="Series.2.X">DT</Argument>
 <Argument name="Series.2.Y">process_cpu_pct</Argument>
 <Argument name="Series.2.Color">0x006b91</Argument>
 <Argument name="Series.2.Alpha">0.5</Argument>
 <Argument name="Series.2.Visible">true</Argument>

 <Argument name="Series.Selected" bindingname="CPULC.Series.Selected"/>
 <Argument name="Timeline.Cursor">true</Argument>
 <Argument name="Timeline.Cursor.Color">0xFF0000</Argument>
 <Argument name="Timeline.Cursor.Weight">1</Argument>
 <Argument name="Timeline.Cursor.Alpha">0.9</Argument>
 </Component>

 

Visualizations

In the declaration of the component, you may have noticed the following  attribute:ui

<Component ui="com.intergral.fads.model.renderer.ChartBaseVisualization">

This attribute is used to specify how the data will be rendered to the screen. In the example, is used, to create a graph such as the one below: ChartBaseVisualization



Figure 1: ChartBaseVisualization Area Graph

Other types of graph can be created using by specifying a  argument within the component, like so:ChartBaseVisualization, Type

<Argument name="Series.1.Type">AreaSeries</Argument>

Some of the type arguments provided by the client are:

AreaSeries - creates and Area Graph like the one in Figure1.

LineSeries - creates a Line graph

BarSeries - creates a Bar Chart

Other Visualisations:

 AdvancedDataGridRenderer can be used to render the data in a table such as this:

Figure 2: A visualisation of a Data Grid

PieChartRenderer can be used to render data in a Pie Chart like this:

Figure 3: A visualisation of a Pie Chart

 TimeBlockChartBitmap can be used to create a TimeLine chart, which shows each data point as a block, at is respective point in time.
Here is a TimeLine that shows each of the requests that happened within an hour period:

Figure 4: A visualisation of a TimeLine

Arguments

Within the component there are several Arguments. These are used to define different properties for how the data is displayed. 
We will now cover some of the arguments used to create the and and their purpose.ChartBaseVisualization  AdvancedDataGridRenderer, 
Only the essential arguments will be covered, the more advanced arguments will be omitted. 



Where arguments are defined for a specific series (i.e. Series.1.Type), the number defines which series the argument relates to.
The same arguments can be included for each additional series that is added to the graph, as long as the series number is incremented accordingly.

 

Argument Purpose

<DataProviderRef ref="CPULC"/> This provides a reference to the Data Provider which gets the data used in the component.

<Argument name="Title">Process and System CPU 
Usage</Argument>

Sets the title that is used for the View, and is seen in the grey bar at the top of Figure 1

<Argument name="Background.Color">0xffffff<
/Argument>

Sets the background colour of the graph using a hex colour value. In most cases white is used because it is easier 
to see the data when the background is white.

<Argument name="Chart.Maximum">100</Argument> Only for to set the max height of the Y Axis.ChartBaseVisualization 

<Argument name="start" bindingname="Global.
TimeLine.start"/>

This is a required argument, used to link the view to the TimeLine.

<Argument name="end" bindingname="Global.TimeLine.
end"/>

This is a required argument, used to link the view to the TimeLine.

<Argument name="timezone" bindingname="Global.
TimeLine.timezone"/>

This is a required argument, used to link the view to the TimeLine.

<Argument name="Series.Count">3</Argument> Only for Sets how many series you want the graph to render. In the case of the ChartBaseVisualization. 
example, there are 2 series; Process Memory and System Memory

<Argument name="Series.1.Type">AreaSeries<
/Argument>

Only for to set the type of graph that you want to display eg. AreaSeries, BarSeriesChartBaseVisualization 

<Argument name="Series.1.Label">System CPU Usage 
(%)</Argument>

Only for Gives a label to the series which is used in the key of the graph.ChartBaseVisualization. 

<Argument name="Series.1.Relation">qseries.
resource.system_cpu_pct</Argument>

Only for Sets the relation from where the series will get it's data. Must be the same as ChartBaseVisualization. 
the relation that is returned by the data provider

<Argument name="Series.1.X">DT</Argument> Only for Sets the units that will be used for the X Axis. In this case, DT is DateTimeChartBaseVisualization. 

<Argument name="Series.1.Y">system_cpu_pct<
/Argument>

Only for Sets the units that will be used for the Y Axis. In this case, System CPU values.ChartBaseVisualization. 

<Argument name="Series.1.Color">0xaaaaaa</Argument> Only for Sets the colour that will be used for rendering the series itself, using a hex ChartBaseVisualization. 
colour value

<Argument name="Series.1.Alpha">0.5</Argument> Only for Sets the transparency of the series.ChartBaseVisualization. 

<Argument name="Series.Selected" bindingname="
CPULC.Series.Selected"/>

Only for Defines a Series Selector drop down box, which can be used to dynamically ChartBaseVisualization. 
turn on/off a series while viewing the graph.

<Argument name="Columns.Count">4</Argument> Only for Sets how many columns you want the data grid to contain.AdvancedDataGridRenderer. 

<Argument name="Columns.1.Field">STARTED</Argument> Only for Sets the Data you want the column to contain. Must be the same as the AdvancedDataGridRenderer. 
column that is returned by the Data Provider.

<Argument name="Columns.1.Label">Started</Argument> Only for Sets a label for the column. This will be used as the column name when AdvancedDataGridRenderer. 
displayed.

<Argument name="Columns.1.Type">Date</Argument> Only for Sets the dataType for the column eg. String, Int, Date.AdvancedDataGridRenderer. 

<Argument name="Columns.1.Format">DD.MM.YY JJ:NN:
SS.TTT</Argument>

Only for If you want to display the data in a Specific format, use this argument. AdvancedDataGridRenderer. 
Otherwise, it is not needed.



<Argument name="Columns.1.Align">left</Argument> Only for Set how you want the data in the column to be aligned.AdvancedDataGridRenderer. 

<Argument name="Columns.1.Width">20</Argument> Only for Set the width of the column. This is a percentage of the total area the table AdvancedDataGridRenderer. 
is allocated on the page.

 
DATA PROVIDER PROGRAMS

Data Provider Programs

You may have noticed in our example, that the DataProvider used in the 
example (CPUMemLCProvider) does not actually specify how data is actually retrieved from 
the database.
That is the work of the DataProvider Program or DPP.

It is possible to use an XML <[!CDATA[ xyz ]]> construct to actually place the program inline 
in the XML text; however this is not recommended and we will not discuss it here.
Placing the program in a separate file enables it to be reused, tracked in source control, 
and edited independently of the APML.

The program is specified as follows:

<Program language="groovy" return="
response" program="apml/CPUMemLCProvider.
groovy"/>

The tag above specifies the language, return variable and program source for the provider.

Supported Languages

DataProvider Programs (DPPs) may be supplied in two Java-like languages:

Groovy: http://groovy.codehaus.org/
language="groovy"

BeanShell: http://www.beanshell.org/
language="bsh"

These languages are supported in FusionAnalytics using abstractions called Execution 
. These engines take care of injecting variables into the program's environment,Engines

invoking the relevant language compiler or interpreter, and extracting the results.

We recommend the Groovy language, since this is a very full-featured and mature 
environment and lends itself very well to the development of DPPs.

Return Variable

The  attribute in the example Program tag specifies the variable which return="response"
the execution engine will use when the program completes, 
in this case the variable called .response

Program Source Code

Finally, the  attribute instructs the execution program="apml/CPUMemLCProvider.groovy"
engine from where the source code for the program can be obtained;
in this case in the folder , in a file called .groovy.apml CPUMemLCProvider

The contents of the groovy source file are presented in Figure 1. We are using a ResourceQ
 object to construct the SQL being run against the database.ueryBuilder

On This Page:
Data Provider Programs
Supported Languages
Return Variable
Parameter Binding
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void go() 
{ 
    Util.recordStartAndEnd(session, 
argument); 
    response = ResourceQueryBuilder.select
(nature, argument, datafactory, 10000) 
    { 
      def resolution = Resolution.
getResolution(argument.get("start"), 
argument.get("end"));
      it.column("r.DT as DT"); 
      if (resolution == 0)
      { 
        it.column("r.PROCESS_CPU_PCT as 
PROCESS_CPU_PCT"); 
        it.column("r.SYSTEM_CPU_PCT as 
SYSTEM_CPU_PCT"); 
        it.from("RESOURCE r"); 
      } 
      else 
      { 
        it.column("r.AVG_PROCESS_CPU_PCT 
as PROCESS_CPU_PCT");
        it.column("r.AVG_SYSTEM_CPU_PCT as 
SYSTEM_CPU_PCT");
        it.from("RESOURCE_Q r"); 
        it.where("""r.
RESOLUTION=${resolution}""");
      } 
      it.addArgumentBasedFilters(argument.
get("start"), argument.get("end")); 
      it.orderBy("r.DT"); 
    } 
} 
go();

Listing 1: Data Provider Written in Groovy

DataProvider Programs may return several object types: in this case we are returning the 
result of the ResourceQueryBuilder, which is a Groovy SQL result set.

Because Analytics for FusionReactor supports quantization, a  object has been Resolution
written :

Resolution.getResolution(argument.get
("start"), argument.get("end"));

This Resolution object automatically selects the correct resolution of data based on the start 
and end 
(which comes from the timeline control) times.



DPP Variable Injection

Several arguments are injected into the Groovy (and Beanshell) environment before 
execution.
We will not enumerate them completely here, but a few are:

Parameter Binding

You may have noticed in Figure 2 the following DataProvider arguments:

<Argument name="start" bindto="Global.
TimeLine.start" bindingname="dp.start"/>
<Argument name="end" bindto="Global.
TimeLine.end" bindingname="dp.end"/>

These arguments specify how data value changes in the client are passed into the DPP. The 
 attribute specifies the name of the injected variable, name

the  attribute specifies the event used as the source of the argument, and the bindto bindingn
 specifies the name of this argument binding in the client.ame

These variables appear in the argument variable scope (see table above).

The client software manages an event model comprising event sources and bindings, and 
calls interested Components appropriately when the bound variables change. In most cases, 
the
Component will pass on the request to the DataProvider1. Any Component can raise such 
events, and any Component may listen for them using bindings, provided the name of the 
event is known.

Component

The Component may also specify bound variables in the same way. These declare an 
interest in the bound variable at the component level. 
When the bound variable changes, the Component will be notified, and can take whatever 
action it deems appropriate.
LAYOUT

Layout

The Layout tag, within APML, is used to define how the different elements of the perspective will be laid out on the page.
The FusionAnalytics Client software makes a number of different layout engines available, which may be embedded. This allows quite complex view layouts to be constructed.

Here is an example of some of the Layout tags within APML:

<Layout type="com.intergral.fusionanalytics.view.layout.layoutManager.SimpleFlowLayoutManager">
  <VBox>
     <Layout type="com.intergral.fusionanalytics.view.layout.layoutManager.IconSelectorManager">
         <ViewRef ref="CPULC" title="CPU"/>
         <ViewRef ref="ResourceMemoryAC" title="Process Memory Usage"/>
     </Layout>
     <ViewRef ref="Global.TimeLine" height="145"/>
  </VBox>
</Layout> 

Listing 1: Layout tag within the Perspective.

We can see two layout managers in use here:



1.  

2.  

1.  

2.  

3.  

1.  

SimpleFlowLayoutManager which, in this case, uses a  (a box which lays its contents out vertically, expanding horizontally to fit its extents) to contain anVBox
 

IconSelectorManager which is being used to toggle two further views, Process and System CPU Usage and Process Memory Usage. You can see the icon selector in Figure 1.

The final view, the , belongs to the 's , so it will appearTimeline SimpleFlowLayoutManager VBox
beneath the view laid out by the .IconSelectorManager

The layout tags used in listing 1 construct the following perspective

Figure 1: Perspective constructed from Listing 1 

More Layout Tags

HorizontalGridLayoutManager - which lays its contents out in a grid, optionally allowing them to extend vertically beyond their extends, with a scrollbar.

ComboBoxSelectorLayoutManager - used to toggle further views, similar to IconSelectorManager, using a drop down combo box.

HBox - a box which lays its contents out horizontally, expanding vertically to fit its extents

 

Configuring Report Images

Configuration Report Images

When viewing FusionAnalytics reports which have been delivered via email, you may see a request to log in to your FusionAnalytics 
Data Services server.

This happens because the images which comprise part of the reports are served directly from the FADS system itself.

If you are seeing a request to log in, you have not obtained a cookie for the FADS server on the address from where images are being 
served.

There are three solutions to this problem.

Log in

When the login dialog appears, log in as a FADS user who is able to view the images.

Adjust the security settings of the application

You can set your FADS application not to require authentication to view images.

Warning: If you disable this protection, anyone will be able to view these report images, regardless of whether they are a valid FADS 
user or not.

Navigate on your server to FusionAnalytics\Server\webapps\fads\WEB-INF\classes\Applications\YOUR_APP_NAME and 
open application.xml with a text editor. This editor must be capable of reading and writing UTF-8 Unix files. Windows Notepad is 
not able to do this - we recommend  .Notepad++

In this file, locate the ApplicationWebServer block and carefully remove the Path whose pathattribute is /_Persistent. 

You should be left with:

    <ApplicationWebServer>
       <PathRules>
          <Path path="/configuration">
             <Protected/>
          </Path>
       </PathRules>
    </ApplicationWebServer>

Restart the application by logging in to the Data Services webapp (usually located on port 8400), and restarting the data service 
itself using the Restart button.

Caveat: If the application is upgraded or reinstalled, this procedure must be repeated.

Change the domain name used to serve image links

The problem can also be solved by changing the host name used to serve image links. If you ordinarily log in to the FusionAnalytics Data 
Service webapp using - for example -  , then you should already have an authentication cookie for this domain. If http://fred.foo.com:8400/
the system has several aliases, images may be being served from a different domain name and the login dialog will appear. If this is the 
case, the domain name used in links can be changed:

Log in to the Data Services webapp (usually located on port 8400). Open the   section and click on the   eSystem Server Settings
ntry.

http://notepad-plus-plus.org/
http://fred.foo.com:8400/


2.  

3.  

Under the settings   and  , change the value to the domain name you usually use.HTTP Server Host HTTPS Server Host

Click Update Server Settings
This will cause generated links to use the new domain name, for which you already have an authentication cookie, and 
the login dialog should no longer appear.

FusionAnalytics Licensing

FUSIONANALYTICS LICENSING

How FusionAnalytics is Licensed

FusionAnalytics licenses come in individual packs (S,M,L,XL and XXL). The size of the 
pack determines how many users you can setup and how many CF instances you can 
analyze with FusionAnalytics.

Instances in relation to licensing

ColdFusion is installed on a J2EE server instance running within its own Java™ Virtual 
Machine (JVM). As its name implies, a virtual machine is a self-contained operating 
environment that behaves as if it were a separate computer, while actually sharing 
resources with other virtual machines on the same server. You might install another J2EE 
server instance on another, completely separate JVM, and install ColdFusion there as 
well. These two ColdFusion servers would then operate completely isolated from each 
other---as if they were on separate physical servers. Each individual instance can be 
monitored (by FusionReactor) and will generate a set of log files corresponding to the CF 
instance being monitored.

License packs are measured in the number of instances which you would like to analyze 
using FusionAnalytics.

 

: InstancesFigure 1

Take this example – here we have 3 instances of ColdFusion installed on one single 
server. If you wished to analyze the metric information from all three instances, then you 
would require:

1 x FusionReactor license (either FusionReactor Standard or Enterprise) – 1 license 
covers 1 physical server, no matter how many instances you have configured

1 x FusionAnalytics M Pack (containing 3 Data Collectors) – 1 Data Collector for each 
instance being analyzed

FusionAnalytics Users

You can setup individual users within FusionAnalytics – these may be system 
administrators, or regular users. Individual users receive their own login to FusionAnalytics 
and you can select specific users to receive any of the reports available, such as the ?TAP 

 or ? . Users are associated with applications and users can be Reports Daily Status Reports
given specific roles within FusionAnalytics e.g. Administrator.

FusionAnalytics DataCollectors
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FusionAnalytics DataCollector's (FADC) are used to import log files into a database so that 
the resulting data can be analyzed and visualized by the FusionAnalytics application. You 
require 1 Data Collector for each instance which you would like to analyze.

FusionAnalytics DataCollectors in relation to licensing

FusionAnalytics DataCollector's (FADC) are used to collect data from a specific 'instance' 
which you would like to analyze with FusionAnalytics. Each instance is unique and you 
require 1 data collector for each instance you would like to analyze. So, if you have 3 
instances to analyze, you need 3 data collectors etc.

I have more than 20 instances to analyze – what can I do?

If you have more than 20 instances, we can create you a custom license which perfectly 
matches your needs – please  and let us know how many instances you have contact sales
and we would be happy to send you a quote.

Back to the top

Move FusionAnalytics to a new server

Introduction

This documentation will provide readers with more information about the best way of moving a FusionAnalytics server to a new 
environment. For this scenario, we will assume that the  and only the FusionAnalytics server will be database will remain the same
transfered to a new environment.

Getting Started

Disable the license key in use

In order to move FusionAnalytics to a new server, please follow the steps mentioned below and make sure that the license key currently 
used has been disabled.

Access the FADC and the FADS application via the browser.

Navigate to .System > License Info

Click the ' ' button in order to uninstall the license key from that server.Uninstall

The steps mentioned above are vital as you will have a server seat available to activate on the new server.

Firewall configuration

In order to avoid any data loss and before the installation of FusionAnalytics, please make sure that a Firewall policy/configuration on the 
new server is  . More information about the  can not blocking traffic between the server and the configured database prerequisites
be found in the following link; .https://docs.fusion-reactor.com/display/FA207/Prerequisites+for+Installation

Transfer existing configuration to the new server

In order to keep the existing configuration of the FusionAnalytics server, please follow the steps mentioned below.

Make a copy of the FusionAnalytics directory somewhere in your environment.

Access the new server.

Run the FusionAnalytics installer using the appropriate privileges. More information about the installation process can be found 
in the following link; .FusionAnalytics Installation

Make sure the installation process was successful and that you are able to locate the 'FusionAnalytics Server' windows service.

Stop the 'FusionAnalytics Server' service.

Replace the FusionAnalytics folder with the one copied in step 1.

Start the 'FusionAnalytics Server' service.

Make sure that you are able to access the FADC and FADS applications via the browser and with the existing configurations.

FusionReactor configuration changes

Because the FusionAnalytics server has been transfered to a new environment, you need to make changes in the 'FusionAnalytics 
 and in the ' ' found in the FusionReactor UI. For more information, please check out the links below.Target' FusionAnalytics Settings

https://docs.fusion-reactor.com/display/FR62/FusionAnalytics+DataCollector+Targets

http://www.fusion-analytics.com/contact/
https://docs.fusion-reactor.com/display/FA207/Prerequisites+for+Installation
https://docs.fusion-reactor.com/display/FA207/Installation
https://docs.fusion-reactor.com/display/FR62/FusionAnalytics+DataCollector+Targets


https://docs.fusion-reactor.com/display/FR62/FusionAnalytics+Settings

If FusionReactor was not configured with FusionAnalytics and you have an hour downtime, you have the ability to manually add the logs 
in the datacollector. This can be done by pressing the 'Transfer All' button found under .Analytics > Connector Status

Test connection between FusionReactor and FusionAnalytics

Most connectivity issues between FusionReactor and FusionAnalytics revolve around the server where FusionReactor is running, not 
being allowed or able to connect to the FusionAnalytics server. Please make sure that the connection between FusionReactor and the 
FusionAnalytics server is successful. This can be achieved by either clicking the ' ' button found in the 'Test FusionAnalytics 

' area  by using a Web Browser directly on the server that is running FusionReactor and seeing if you can DataCollector Targets OR
open FADC (FusionAnalytics DataCollector) from that server.

More information about the 'FusionAnalytics DataCollector Targets' configuration can be found in the following link; https://docs.fusion-
.reactor.com/display/FR62/FusionAnalytics+DataCollector+Targets

FusionAnalytics for FusionReactor User's Guide

FusionAnalytics for FusionReactor User's Guide

Overview

FusionAnalytics for FusionReactor is the default App for FusionAnalytics at the time of 
launch. This App is designed to integrate with your existing FusionReactor installations 
(FusionReactor 4.0 or higher) in order to deliver a wide range of valuable analytics about 
your servers. This guide covers the various perspectives found in the FusionAnalytics for 
FusionReactor UI.

Next Steps

USING FUSIONANALYTICS WITH FUSIONREACTOR

APPLICATION PERSPECTIVES (EG. FADATACOLLECTOR-1)
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TAP Reports
What is TAP Score - and how is it calculated?

Running a TAP Report

TAP Report Provider Arguments

Understanding the TAP Report

The TAP Report configuration page

Daily Status Reports
Running a Daily Status Report

Daily Status Report Provider Arguments
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The Daily Status Report configuration page

SLA Reports
Accessing the SLA Report Configuration Page

Adding a new SLA Report Configuration

The SLA Report Configuration
Report Configuration Tab

Email Recipients Tab

Domain Filters Tab

Thresholds Tab

Running the SLA Reports

USING FUSIONANALYTICS TO ANALYZE A CLUSTER OF SERVERS / INSTANCES

Cluster Perspectives

Using FusionAnalytics with FusionReactor

Using FusionAnalytics with FusionReactor
FusionReactor's Analytics Connector can be configured to automatically 
transfer logs to FusionAnalytics. This gives you a reliable, continuous analysis of 
FusionReactor's captured data. The  is available in all Analytics Connector
editions of FusionReactor 4.0.0 and above, and is found in the  menu Analytics
item.

We won't go into detail here, because FusionReactor's own documentation 
explains everything - feel free to follow the links to get more information on a 
specific subject. 's the main entry on Analytics within FusionReactor.Here

Connector Status shows you the current status of FusionReactor's 
archive (similar to the   page) together with the Logging -> Log Archive
status of the internal components of the connector:

The transfer status of each log archive, together with butts for 
(re)transfer either single log archives or the whole day's worth;

The total size of the archive system, so you can keep an eye on 
disk space;

The status of each Connector Worker thread - if it's idle or busy 
transferring logs to FusionAnalytics, and how much data remains 
to be sent;

The Connector Transfer Queue, showing all the log archives 
remaining to be sent. These will be processed by worker threads 
as they become available.

FusionAnalytics Settings allows you to set the mode used (by default, 
FRAM - the FusionReactor Administration Manager - is used to transfer 
archives to FusionAnalytics, to alleviate load on the individual 
FusionReactor instances.

FusionAnalytics Targets allows you to set up the DataCollector target 
for each FusionReactor instance. Each DataCollector within 
FusionAnalytics receives data from a single FusionReactor instance, and 
this is where you configure them.

Many of these settings can also be administered from , the FRAM FusionReactor 
, in the , by clicking the Administration Manager Instance Manager

FusionAnalytics icon on a single instance. help you set up and test the Popups 
FusionAnalytics connector to make sure archives can be transferred.

Back to the top

   

Application Perspectives (eg. faDataCollector-1)

Application Perspectives (eg. faDataCollector-1)

Overview

This section will discuss the different perspectives that are used within the 
FusionAnalytics for FusionReactor Application.

At the heart of FusionAnalytics is the wealth of information gathered 
and transferred from FusionReactor. This instrumentation includes 

http://docs.intergral.com/display/FR52/Analytics
http://docs.intergral.com/display/FR52/Analytics
http://docs.intergral.com/display/FR52/Connector+Status
http://docs.intergral.com/display/FR52/Logging
http://docs.intergral.com/display/FR52/Log+Archive
http://docs.intergral.com/display/FR52/FusionAnalytics+Settings
http://docs.intergral.com/display/FR52/FusionAnalytics+DataCollector+Targets
http://docs.intergral.com/pages/viewpage.action?pageId=35291274
http://docs.intergral.com/pages/viewpage.action?pageId=35291274
http://docs.intergral.com/pages/viewpage.action?pageId=35291274
http://docs.intergral.com/display/FR52/Instance+Manager
http://docs.intergral.com/display/FR52/FRAM+Target


The section will describe each Perspective in detail including information 
regarding what the Perspectives is showing (what data it is rendering) and how it 
can be used for analysis problem identification

Next Steps
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requests, SQL statements, response times, CPU and memory 
information, as well as URL parameters, Heap memory usage and JMX 
statistics. FusionAnalytics takes all of this information and builds a 
series of combined visual perspectives, allowing you to visualize all 
transactions, SQL queries, data transfer, server events etc. taking 
place over time, so you can build a complete historical view of what 
happened on your server. This data is essential to support investigative 
analysis, continuous server analysis and application improvement. With 
over 80 different analytic views and reports, FusionAnalytics gives you 
unlimited insight into exactly what's happening on your server.
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Requests Restart Coverage

Database Hot-Spots
Slowest Database Requests (Hot-Spots)

ColdFusion Monitor
CF General Statistics

CF Scope Sizes

CF Hit Counts

CF DB Pool Stats

Applications

Overview

OVERVIEW

Description

This is the default perspective that you will see when opening the FusionAnalytics Client. The top of the perspective contains a set of graphs showing various server statistics. 
Under those graphs are a set of other useful statistics.

Usage

Clicking on any of the graphs from the top section will increase the size of that graph.

Additionally, you can change the information shown from the bottom section by selecting the required button from the button bar:

 

: Overview Perspective - Button BarFigure 1

Server 
Summary

A table view of all requests within the current time range, grouped by Server.

Performance A table view of Requests, ordered by execution time and grouped by Request URL.



Alerts A view showing application alerts. You can display this information as a graph or in a table.

I/O 
Performance 

A table showing the amount of database activity grouped by Request URL. You can either view the Most Queries on Average, or Most Data Returned on Average.

Popular 
Requests

A pie chart showing the top 10 most popular requests.

CF General This is a collection of various CF graphs. A second button bar will give you the option to select from Sessions, CFC Q, Thread Q, Throttle Q, WebService Q, Flash Q, Req 
Q, Template, Users, Temp Cache or Query Cache

Overview - Perspective View
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Deep Server Analysis

DEEP SERVER ANALYSIS

OVERVIEW

NEXT STEPS

Data Finder

Request

Slowest Requests

Slowest Requests on Average

Slowest DB Requests On Average

Longest Request Execution Time in Total

Highest DB Row Count by a Request

Highest DB Row Count On Average by a Request

Highest CPU Usage

Highest CPU Usage on Average

Highest CPU Usage in Total

Most Popular Requests



Most DB Queries On Average

Most DB Queries

Most Data Returned (bytes)

Most Data Returned on Average (bytes)

Table of Requests

Time Line of Requests

Time Line of Requests with Resources

Time Line of Requests with DB Requests

Bell-Curve of Request Performance

Request Status Code Brakedown

Request and JDBC Execution Time

Total Request Performance

Most Hits By IP Address

Longest Request Execution Time By IP Address

Aggregate Request List

Request Breakdown

Request Details

Database

Database Requests Grid

Highest DB Request Row Count

Slowest Database Requests

Database Usage Graphs

Requests and JDBC Execution Time

Memory

Memory Usage

Memory Spaces

Memory Heap Non-Heap Summary

CPU

CPU Usage

CPU/Memory Usage

Thread

Thread Activity

General

FusionReactor System Metrics

Server Summary

Resource Usage Data Grid

Logs

Log File Entries

Events

Annotations

Placemarks

Crash Protection

Resources with Annotations

Hot-Spots

Memory Hot-Spots
Memory at 100%

Memory Highest Usage

Memory Events

CPU Hot-Spots
Process CPU at 100%

Process CPU Highest Usage

System CPU at 100%



System CPU Highest Usage

Request Hot-Spots
Requests Not Completed

Slowest Requests (Hot-Spots)

Slowest Requests On Average (Hot-Spots)

Slowest DB Requests On Average (Hot-Spots)

Requests Restart Coverage

Database Hot-Spots
Slowest Database Requests (Hot-Spots)

ColdFusion Monitor

CF General Statistics

CF Scope Sizes

CF Hit Counts

CF DB Pool Stats

Applications

Data Finder

Data Finder

Description

The Data Finder gives you an overview of all the types of data within FusionAnalytics and, once you have isolated a  span of 
data you can switch the Data Finder into a different mode in order to further investigate that data.

Usage

Use the  to move back and forward through the timespan. The Data Finder chart will shows blue bars to Date Navigation
indicate when different types of information are available within the specified time span. There are various types of information 
which can be available, including JDBC, Resource, ColdFusion Monitor, Memory Spaces, Hit Counts, Logs and Request.

To switch the Data Finder to a different type of view, select the required view from the drop down box at the top right of the 
main graph area.

 

: Data Finder Perspective SelectorFigure 1

The various DataFinder views are grouped by data type: Here is a list of the different perspective options you have to select 
from:

DataFinder

Database: Average DB Request Execution Time

Database: DB Request Time Line

Database: DB Requests

Database:Highest DB Row Count

Database: Most DB Queries by a Request On Average

Database: Slowest DB Requests On Average by a Request

Database: Slowest Database Requests

Events: Annotations Time Line

Events: Annotations



Events: Crash Protection Events

Events: Placemarks

General: Server Summary

Log: Log Entries

Request: Average Request Execution Time

Request: Highest Average DB Row Count by a Request

Request: Highest Request DB Row Count

Request: Most DB Queries by a Request

Request: Most Data Returned on Average

Request: Most Popular Requests

Request: Request Cumulative Execution Time

Request: Request Performance Bell-Curve

Request: Request Time Line

Request: Request Not Completed

Request: Requests

Request: Slowest Requests on Average

Request: Slowest Requests

Request: Most Data Returned

Resource: CPU and Memory Usage

Resource: FusionReactor System Metrics

Resource: Highest Memory Usage Data Grid

Resource: Highest Process CPU Usage

Resource: Highest System CPU Usage

Resource: Memory at 100% Data Grid

Resource: Memory Code-Cache Usage

Resource: Memory Eden-Space Usage

Resource: Memory Perm-Gen Usage

Resource: Memory Survivor-Space Usage

Resource: Memory Tenured-Gen Usage

Resource: Memory PS-Eden-Space Usage

Resource: Memory PS-Old-Gen Usage

Resource: memory PS-Perm-Gen Usage

Resource: PS-Survivor-Space Usage

Resource: Process CPU at 100%

Resource: Process Memory Usage

Resource: Process and System CPU Usage

Resource: Resource Usage Data Grid

Resource: System CPU at 100%

Resource: Thread Activity Time Line

CF: CF Active Sessions

CF: CF Scope Sizes

CF: CF CFC Queue

CF: CF CFThread Queue

CF: CF Concurrent Users

CF: CF Flash Remoting Queue

CF: CF Query Cache

CF: CF Request Queue

CF: CF Template Cache

CF: CF Template Queue

CF: CF Throttle Queue Size

CF: CF Request Queue

CF: CF Template Cache

CF: CF Template Queue

CF: CF Throttle Queue Size

CF: CF Web Services Queue

Perspective View



 

: Data Finder PerspectiveFigure 2
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Request

Request

Overview

Next Steps

Slowest Requests

Slowest Requests on Average

Slowest DB Requests On Average

Longest Request Execution Time in Total

Highest DB Row Count by a Request

Highest DB Row Count On Average by a Request

Highest CPU Usage

Highest CPU Usage on Average

Highest CPU Usage in Total

Most Popular Requests



Most DB Queries On Average

Most DB Queries

Most Data Returned (bytes)

Most Data Returned on Average (bytes)

Table of Requests

Time Line of Requests

Time Line of Requests with Resources

Time Line of Requests with DB Requests

Bell-Curve of Request Performance

Request Status Code Brakedown

Request and JDBC Execution Time

Total Request Performance

Most Hits By IP Address

Longest Request Execution Time By IP Address

Aggregate Request List

Request Breakdown

Request Details

SLOWEST REQUESTS

Slowest Requests

Description

This shows a table of the top 100 individual requests by execution time within the specific period of time.perspective 

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.
You can right click on any of the requests in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of 
Requests and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it ran.

Perspective View



 

: Slowest Requests PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Slowest Requests from the ToC, is a  Grid.Server Comparison
It shows the slowest requests from the entire cluster rather than just one server. You can see which server each request came from in the leftmost column of the table, which displays Server 
Name.



 

Figure 2: Cluster Version of Slowest Requests Perspective

 

 

Back to the top

SLOWEST REQUESTS ON AVERAGE

Slowest Requests on Average

Description

This perspective shows a table of the top 100 requests by their average execution time within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View

 



 

: Slowest Requests on Average PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Slowest Requests On Average, from the ToC, is a  Grid.Cluster View
It shows the First 100 Requests, ordered by slowest Average Exec Time for the whole cluster.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster. 



Figure 2: Cluster version of Slowest Requests On Average perspective
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SLOWEST DB REQUESTS ON AVERAGE

Slowest DB Requests On Average

Description

This perspective shows a table of the top 100 requests by their average database execution time within the specific period of time.

Usage

To change the order in which the requests are shows, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Slowest DB Requests On Average PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Slowest DB Requests On Average, from the ToC, is a   Grid.Cluster View
It shows the First 100 Requests, ordered by slowest Average DB Exec Time for the whole cluster.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster Version of Slowest DB Requests On Average perspective
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LONGEST REQUEST EXECUTION TIME IN TOTAL

Longest Request Execution Time in Total

Description

This perspective shows a table of the top 100 requests by their total execution time within the specific period of time. This is an important perspective when looking to optimize the of 
performance of an application or a server. The total execution time is the amount of time that the request actually spent running on the server. Here are some of the cases that this perspective 
can help you analyze:

Fast request but runs so often that they use they have the highest total execution time
In this case optimizing even a small amount of time out the request can reap big benefits simply because of multiplying the saving by the large number of times that the 
request is run

Slow Requests take so long to execute that they use more execution time than the most popular requests
In this case look to optimize the request heavily. Consider caching strategies and when the requests run to reduce the impact of the request

Requests that vary in performance heavily
It's possible that a request typically runs in an acceptable time, but sometimes seems to spike a take much longer. These requests can hog execution threads and cause the 
server to be unresponsive. 

Identify why the request sometimes take a long time to run. Look at external resources such as to Databases and other network connections as common causes

Check the request parameters on slow requests. It could be that the request only runs slowly when passed specific parameter values

Check the timing to see if the request only runs slowly at certain times and look at what other activity the server or application is performing at those times

Check for locking issues with other requests or resources. It is common that a request may execute for a long time, holding and locking other resources simply because of a 
conflict with other requests running at the same time 

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Longest Request Execution Time in Total PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Longest Request Execution Time in Total, from the ToC, is a   Cluster View
Grid.
It shows the First 100 Requests, ordered by Total Exec Time for the whole cluster.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster Version of the Longest Request Execution Time in Total perspective
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HIGHEST DB ROW COUNT BY A REQUEST

Highest DB Row Count by a Request

Description

Highest Total DB Row Count is a perspective to help you identify which request fetched the most rows of data from the database. The report calculates the number of rows fetched from the 
database by a request. Knowing the number of rows returned from the database can help you to identify many potential issues and give you insight into the resource usage and scale of your 
applications. Generally fetching rows from the database takes time, resource and can induce network overhead if the database is located on a remote server. Often rows fetched from the 
database are stored in memory and this can increase the overall memory usage of your application or potentially create spikes in memory usage.

Using this report you should look to fix, tune or optimize the requests that return most rows from the database. This will typically increase application performance, lower resource usage 
including memory, cpu and network traffic.

Usage

Discover which requests fetch the most rows of data from the database(s)

Identify unexpected results - requests with poorly written queries

Use the information to find bugs in pages and/or queries which are causing too many rows to be returned

Use the information to optimize code

Identify changes in application behavior across time

Perspective View



 

: Highest DB Row Count by a Request PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Highest DB Row Count by a Request from the ToC, is a Server 
 Grid.Comparison

It shows the requests from the entire cluster, which fetched the most rows of data from the database. You can see which server each request came from in the leftmost column of the table, 
which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Highest DB Row Count by a Request perspective
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HIGHEST DB ROW COUNT ON AVERAGE BY A REQUEST

Highest DB Row Count On Average by a Request

Description

Highest Total DB Row Count On Average is a report to help you indentify which requests fetch the most rows of data from the database. The report calculates the average number of rows 
fetched from the database per request run grouped them by their URL. Knowing the number of rows returned from the database can help you to indentify many potential issues and give you 
insight into the resource usage and scale of your applications. Generally fetching rows from the database takes time, resource and can induce network overhead if the database is located on 
a remote server. Often rows fetched from the database are stored in memory and this can increase the overall memory usage of your application or potentially create spikes in memory usage.

Using this report you should look to fix, tune or optimize the requests that return most rows from the database. This will typically increase application performance, lower resource usage 
including memory, cpu and network traffic.

Usage

Discover which requests fetch the most rows of data from the database(s)

Indentify unexpected results - requests with poorly written queries

Use the information to find bugs in pages and/or queries which are causing too many rows to be returned

Use the information to optimize code

Indentify changes in application behavior across time

Perspective View

 

: Highest Total DB Row Count On Average PerspectiveFigure 1



 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Highest DB Row Count On Average by a Request, from the ToC, is a Clust
 Grid.er View

It shows the First 100 Requests that have the highest average number of rows fetched from the database.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster. 

Figure 2: Cluster version of the Highest DB Row Count On Average by a Request perspective
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HIGHEST CPU USAGE

Highest CPU Usage

Description

This perspective shows a table of the top 100 individual requests by the amount of time spent on the CPU (CPU Time) within the specific time period

Usage

To change the order in which the requests are shows, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this perspective 
covers.
You can right click on any of the requests in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of 
Requests and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it ran.

Perspective View

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Highest CPU Usage from the ToC, is a   Grid.Server Comparison
It shows the . top 100 requests from the entire cluster, by the amount of time spent on the CPU (CPU Time)
You can see which server each request came from in the leftmost column of the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Highest CPU Usage perspective
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HIGHEST CPU USAGE ON AVERAGE

Highest CPU Usage on Average

 

Description

This perspective shows a table of the top 100 requests by their average time spent on the CPU(Avg CPU Time) within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this perspective 
covers.

Perspective View



 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Highest CPU Usage on Average, from the ToC, is a   Grid.Cluster View
It shows the First 100 Requests for the entire cluster, ordered by the Average Time spent on the CPU (Avg CPU Time).
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Highest CPU Usage on Average perspective
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HIGHEST CPU USAGE IN TOTAL

Highest CPU Usage in Total

Description

This perspective shows a table of the top 100 requests by the total amount of time they have spent using the CPU (Total CPU Time) during the specific time period.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Highest CPU Usage in Total, from the ToC, is a   Grid.Cluster View
It shows the First 100 Requests for the entire cluster, ordered by the total amount of time they have spent using the CPU.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster. 

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Highest CPU Usage in Total perspective
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MOST POPULAR REQUESTS

Most Popular Requests

Description

The most popular requests perspective shows which requests ran the most against the server within a given time frame. The information is represented in different ways to help visualize 
which requests are run the most. The most popular requests are good candidates for optimization on both request size and execution time. Reducing the request/response size or the 
execution time of the most popular pages may result in a large improvement in the user response time. It also can result in lower resource usage which may improve the capacity that the 
server is able to handle. 

Usage

To change the order in which the requests are shown in the table, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.
You can right click any of the requests to bring up a context menu. From there, you can navigate to an Overview for that request for different time periods e.g. 7 days, 30 days. 

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation
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Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Most Popular Requests, from the ToC, is a  .Cluster View
It shows .which requests ran the most against the whole cluster within a given time frame
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Most Popular Requests perspective
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MOST DB QUERIES ON AVERAGE

Most DB Queries On Average

Description

This perspective shows a table of the top 100 Requests by Average Query Count (Grouped by URL) within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View
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Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request >Most DB Queries On Average, from the ToC, is a   Grid.Cluster View
It shows the First 100 Requests for the entire cluster, ordered by the Average Query Count.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Most DB Queries On Average pespective
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MOST DB QUERIES

Most DB Queries

Description

This perspective shows a table of the top 100 Requests by Query Count within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.
You can right click on any of the requests in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of 
Requests and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it ran. 

Perspective View



 

: Most DB Queries PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Most DB Queries from the ToC, is a   Grid.Server Comparison
It shows the top 100 requests from the entire cluster, by the Query Count of the requests.
You can see which server each request came from in the leftmost column of the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Most DB Queries perspective
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MOST DATA RETURNED (BYTES)

Most Data Returned (bytes)

Description

Largest Size (bytes) is a report to help you indentify which request returned the most bytes in it's response to the client. Generally the more data returned to the client the more resource is 
used. Often content (bytes) to be returned are buffered or stored in memory until a request is complete, which can cause large quantities of memory to be used. Many applications servers will 
flush data to the client each time the buffered response reaches a certain size (configurable in many cases) but often the request processing will be halted until the client consumes the 
response being sent. This can cause performance degradation in requests and thread starvation. It can also used to a create Denial of Service (DoS) attacks by the client not consuming or 
only slowly consuming the data, causing requests to backup on the server waiting for a thread to become available.

Using this report you should look to fix, tune or optimize the requests that return the large quantities data. This will typically increase application performance, lower resource usage including 
memory, cpu and network traffic.

Usage

Discover which requests return the most bytes to the client

Identify unexpected results - requests with poorly code

Use the information to find bugs in requests that cause to much data to be returned

Use the information to optimize code

Identify spikes in the application / request behavior (URL parameters that cause issues?)

Identify a need to compress requests

Perspective View



 

: Most Data Returned (bytes) PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request >Most Data Returned (bytes) from the ToC, is a   Grid.Server Comparison
It shows the top 100 requests from the entire cluster, that returned the most bytes in it's response to the client.
You can see which server each request came from in the leftmost column of the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Most Data Returned (bytes) perspective
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MOST DATA RETURNED ON AVERAGE (BYTES)

Most Data Returned on Average (bytes)

Description

This perspective shows a table of the top 100 Most Data Returned on Average (Bytes, Grouped by URL) within the specific period of time.

Usage

To change the order in which the results are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Most Data Returned on Average PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Most Data Returned on Average (bytes), from the ToC, is a   GCluster View
rid.
It shows the First 100 Requests (grouped by URL) for the entire cluster, ordered by the Average Number of Bytes returned by the request.
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Most Data Returned on Average (bytes) perspective
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TABLE OF REQUESTS

Table of Requests

Description

This perspective shows a table of the top 1000 Requests, ordered by Start Time, within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Table of Requests PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request >Table Of Requests from the ToC, is a   Grid.Server Comparison
It shows the top 1000 requests from the entire cluster, ordered by Start Time.
You can see which server each request came from in the leftmost column of the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Table Of Requests perspective
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TIME LINE OF REQUESTS

Time Line of Requests

Description

This perspective shows a Time Block Chart of Requests within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can right click on any of the requests to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. JDBC Graphs 
and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it 
ran.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Time Line of Requests PerspectiveFigure 1
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TIME LINE OF REQUESTS WITH RESOURCES

Time Line of Requests with Resources

Description

This perspective shows a Time Block Chart of Requests, along with a Table of the top 1000 requests, ordered by Start Time, as well as the CPU and Memory Usage
of the Server, all within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can right click on any of the requests in the table or the timeline to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time 
period e.g. JDBC Graphs and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it 
ran.

To move between the three different views, click on the heading for the view you want to see e.g. "Requests Time Block Chart" and that view will be displayed. 
You can switch between there different perspectives very easily this way. 

 

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Time Line of Requests with Resources PerspectiveFigure 1
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TIME LINE OF REQUESTS WITH DB REQUESTS

Time Line of Requests with DB Requests

Description

This perspective shows a Time Block Chart of Requests, alongside another Time Block Chart which shows the JDBC Requests.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can right click on any of the requests to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. JDBC Graphs 
and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it 
ran

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Time Line of Requests with DB Requests PerspectiveFigure 1
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BELL-CURVE OF REQUEST PERFORMANCE

Bell-Curve of Request Performance

Description

This perspective shows a Bell Curve Chart showing Request Performance within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


: Bell-Curve of Request Performance PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective takes request data from across the cluster to form a Bell Curve for the probability distribution of request exec times.

The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

Back to the top

REQUEST STATUS CODE BRAKEDOWN

Request Status Code Brakedown

Description

This perspective shows a breakdown of the Status Codes returned by all the requests than were executed during the specified time period.The information is represented in different
ways to help visualize which status codes are occurring the most.

The Pie Chart and the Bar Chart are different ways to display the count of the status codes, and the table shows more information such as the total amount of time all the requests
that returned that Status Code, have taken to execute.

Usage

To change the order in which the requests are shown in the table, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this 
perspective covers.
You can right click any of the requests to bring up a context menu. From there, you can click "Show Requests", to show a Table of the First 1000 requests within the specified time period that 
returned that Status Code.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Request Status Code Brakedown PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Most Popular Requests, from the ToC, is a  .Cluster View
It  within a given time frame.shows a breakdown of the Status Codes returned by all the requests for the whole cluster
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster.

Figure 2: Cluster version of the Request Status Code Brakedown perspective

Back to the top

REQUEST AND JDBC EXECUTION TIME

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Request and JDBC Execution Time

Description

This perspective shows an area chart of the Average Request Execution Time and the Average Execution Time of Database Requests, within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

 

: Request and JDBC Execution Time PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective now has two different views that can be switched between using the drop down box in the uppermost right hand corner of the perspective.
The first view is a    graph view showing two separate graphs. The first graph showing the Average Request Execution time for each individual server within the cluster. Server Comparison
The second graph shows the Average DB Execution Time for each individual server within the cluster.

The second view is a  showing one Area graph, which displays the Average Request Exec Time and the Average DB Exec Time across the whole cluster.Cluster View
 

http://docs.intergral.com/display/FA20/Date+Navigation
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Figure 2: Server Comparison View for Request and JDBC Execution Time perspective

 

 



Figure 3: Cluster View for Request and JDBC Execution Time perspective

Back to the top

TOTAL REQUEST PERFORMANCE

Total Request Performance

Description

This perspective has four different views that you can switch between using the drop down box in the uppermost right hand corner of the perspective, which is labelled "Totals"
The four different views are:

Totals - This shows two area charts. The first shows the total number of requests that were started and finished during the specified time period. The second shows
the total number of Database requests that were finished during the same time period.

Load - This shows two area charts. The first shows the number of requests that were running at the time, alongside the number of requests that were queued and the number of
requests that were completed at the time. The second chart shows the number of Database requests that were completed at the time. 

Average - This shows a chart that displays the Average Request Execution Time alongside the Average Execution Time of Database Requests, within the specified period of time.

Per(sec) - This shows an area chart that displays the Number of Requests Per Second and the number of Database Requests Per Second.
 

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View
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: Total Request PerformanceFigure 1

 

 

Cluster Perspective

The cluster version of this perspective now has multiple different views that can be switched between using the drop down box in the uppermost right hand corner of the perspective.
Each of the views present in the Server version of the perspective have each been given a  and a  for the cluster version of the perspective.Cluster View Server Comparison

 

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView
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Figure 2: Example Server Comparison view from Total Request Performance perspective

 



Figure 2: Example Cluster View from Total Request Performance perspective

 

Back to the top

MOST HITS BY IP ADDRESS

Most Hits By IP Address

Description

This perspective shows a table of the top 100 IP Addresses making the most hits (within the specific period of time). Using this information you can easy identify IP Addresses running the 
most requests; often these may be Spiders, Bots and potentially even Denial of Service attacks. You may consider blocking or throttling requests from specific IP Addresses if you have 
performance issues caused by particularly high traffic from them. It's a good idea to review this information around the periods where a server had an outage.

Usage

To change the order in which the requests are shows, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Most Hits By IP AddressFigure 1

 

 

Cluster Perspective

The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Most Hits By IP Address, from the ToC, is a   Grid.Cluster View
It shows the for the whole cluster.top 100 IP Addresses making the most hits (within the specific period of time) 
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster. 

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Most Hits By IP Address perspective

Back to the top

LONGEST REQUEST EXECUTION TIME BY IP ADDRESS

Longest Request Execution Time By IP Address

Description

This perspective shows a table of the top 100 IP Addresses with the longest total request execution time (within the specific period of time). Using this information you can easy identify IP 
Addresses spending the most time running requests; often these may be Spiders, Bots and potentially even Denial of Service attacks. You may consider blocking or throttling requests from 
specific IP Addresses if you have performance issues caused by particularly high traffic from them. It's a good idea to review this information around the periods where a server had an outage.

Usage

To change the order in which the requests are shows, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View

 

: Longest Request Execution Time By IP AddressFigure 1

 

 

Cluster Perspective



The cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Request > Longest Request Execution Time By IP Address, from the ToC, is a Cluster
 Grid.View

It shows the  for the whole cluster.top 100 IP Addresses with the longest total request execution time (within the specific period of time)
The perspective will look the same as the Server version, but the data will be calculated for the entire cluster. 

Figure 2: Cluster version of the Longest Request Execution Time By IP Address perspective

Back to the top

AGGREGATE REQUEST LIST

Aggregate Request List

Description

When viewing a grid that displays aggregate statistics for a group of requests, such as " " or " ", you can right click on Slowest Requests on Average Longest Request Execution Time in Total
any of the request URL's to bring up the  . From there you can navigate to the "Request List" perspective.Context Menu
This perspective will show a list of matching requests for the specified time period. The list will be sorted relevant to the original perspective that you were looking at. For example, if viewing 
"Slowest Requests on Average", the list will be sorted by Execution Time. Or, if viewing "Highest CPU Usage on Average", the list will be sorted by CPU Time

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this perspective 
covers.
You can right click on any of the requests in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of 
Requests and System Metrics.
You can also view Request Details, to see specific details of that request, such as the exact end time, the amount of memory it used, and the number of database queries it ran.

Perspective View
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Figure 1: Aggregate Request List perspective

 
REQUEST BREAKDOWN

Request Breakdown (for a collection of requests)

Description

This perspective allows you to breakdown a collection of requests to see where the collection spend their execution time. This information is displayed in a pie chart showing the percentage of 
time the collection of requests spends in each area.
Also provided on this page, is a table showing the minimum, average and maximum for a variety of metrics - such as DB query & row counts, DB execution & transfer times, CPU time and 
final response sizes
In addition, this perspective offers request collection JDBC statistics, pin-pointing the "top 5" SQL statements in terms of cumulative execution time/row count and a variety of other JDBC 

Each of these show a sample SQL statement with the file path & line number to expedite your improvement process.metrics. 

 

Usage

Use the  in order to change the period of time over which this perspective covers. All requests within the time period that match the selected URL, will be taken into account.Date Navigation
To change the order that the data in the table is shown, click on one of the table column headings to toggle between ascending and descending order.

To navigate to the JDBC statistics, select "JDBC statistics" from the drop down box in the uppermost right hand corner of the perspective.

 

Perspective View

NOTE: The loading times for this perspective can vary greatly depending on the number of requests that are included in the data set. For a large number of requests, it can take a 
few minutes to load due to the complex calculations that are being made.



Figure 1: Request Breakdown -> Request Statistics view

 



Figure 2: Request Breakdown -> JDBC Statistics
REQUEST DETAILS

Request Details

Description

When viewing a grid that displays individual requests, such as " " or " ", you can right click on any one request to bring up the  . From there Slowest Requests Highest CPU Usage Context Menu
you can navigate to the Request Details perspective.
This perspective has five different views that you can switch between using the buttons located above the timeline.
The five different views are:

Request Details - Shows all of the details of an individual request, on one easy to read page.

Request DB Details - This displays list of all the queries that were performed by the request.

DB Requests - Shows a timeline of all the queries that were performed by the request.

DB Breakdown - Displays a pie chart showing a breakdown of query execution time across all the queries that were performed by the request.

Request Breakdown - Displays a pie chart which shows a breakdown where the request spends its time (CPU, network/IO, DB, etc).

 

Usage

To change the order in which the details are shown in the tables, click on one of the column headings to toggle between ascending and descending alphabetical order. 
You can right click on any table row or cell, and you will be able to copy the details.

Perspective View



 Figure 1: Request Details view

 



 Figure 2: Request DB Details view

 



Figure 3: DB Requests view

 

 



  DB Breakdown viewFigure 4: 

 



 Figure 5: Request Breakdown

 

 

Database

Database

Overview

Next Steps

Database Requests Grid

Highest DB Request Row Count

Slowest Database Requests

Database Usage Graphs

Requests and JDBC Execution Time

DATABASE REQUESTS GRID

Database Requests Grid

Description

This perspective shows a table of the first 100 Database Requests within the specific period of time.



Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View

 

: Database Requests Grid PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Database > Database Requests Grid from the ToC, is a   Grid.Server Comparison
It shows the first 100 database requests from the entire cluster, ordered by Start Time. You can see which server each request came from in the leftmost column of the table, which displays 
Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Database Requests Grid perspective

Back to the top

HIGHEST DB REQUEST ROW COUNT

Highest DB Request Row Count

Description

Highest Total DB Row Count is a report to help you identify which request fetched the most rows of data from the database. The report calculates the number of rows fetched from the 
database by a request. Knowing the number of rows returned from the database can help you to identify many potential issues and give you insight into the resource usage and scale of your 
applications. Generally fetching rows from the database takes time, resource and can induce network overhead if the database is located on a remote server. Often rows fetched from the 
database are stored in memory and this can increase the overall memory usage of your application or potentially create spikes in memory usage.

Using this report you should look to fix, tune or optimize the requests that return most rows from the database. This will typically increase application performance, lower resource usage 
including memory, CPU and network traffic.

Usage

Discover which requests fetch the most rows of data from the database(s)

Identify unexpected results - requests with poorly written queries

Use the information to find bugs in pages and/or queries which are causing too many rows to be returned

Use the information to optimize code

Identify changes in application behavior across time

Perspective View



 

: Highest DB Request Row Count PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Database > Highest DB Request Row Count from the ToC, is a   GServer Comparison
rid.
It shows  You can see which server each request came from in the leftmost column of the table, which which request from the fetched the most rows of data from the database.entire cluster 
displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Highest DB Request Row Count perspective

Back to the top

SLOWEST DATABASE REQUESTS

Slowest Database Requests

Description

This perspective shows a table of the top 100 Slowest Database Requests within the specific period of time.

Usage

To change the order in which the requests are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Slowest Database Requests PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Database > Slowest Database Requests from the ToC, is a   Grid.Server Comparison
It shows the top 100 slowest database requests from the entire cluster rather than just from one server. You can see which server each request came from in the leftmost column of the table, 
which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Slowest Database Requests perspective
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DATABASE USAGE GRAPHS

FusionAnalytics DataServices

Description

This perspective has three different views that you can switch between using the drop down box in the uppermost right hand corner of the perspective, which is labelled "DB Exec Time"
The three different views are:

DB Exec Time - This shows an area chart which displays the Average Execution Time of Database requests within the specified time period.

DB Completed - This displays a chart showing the number of Database requests completed at the time.

DB Per Second - This displays an area chart showing the number of Database Requests Per Second.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Database Usage Graphs PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective keeps the same  as the server perspective, however, each view has a  graph showing the data for each individual server three views Server Comparison
side
by side, and a  graph and aggregate of the data across the whole server. The first view of the perspective can be seen in figure 2.Cluster View

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the Database Usage Graphs perspective

Back to the top

REQUESTS AND JDBC EXECUTION TIME

Request and JDBC Execution Time

Description

This perspective shows an area chart of the Average Request Execution Time and the Average Execution Time of Database Requests, within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Request and JDBC Execution Time PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective now has two different views that can be switched between using the drop down box in the uppermost right hand corner of the perspective.
The first view is a    graph view showing two separate graphs. The first graph showing the Average Request Execution time for each individual server within the cluster. Server Comparison
The second graph shows the Average DB Execution Time for each individual server within the cluster.

The second view is a  showing one Area graph, which displays the Average Request Exec Time and the Average DB Exec Time across the whole cluster.Cluster View
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Figure 2: Server Comparison View for Request and JDBC Execution Time perspective

 

 



Figure 3: Cluster View for Request and JDBC Execution Time perspective
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Memory

Memory

Overview

Next Steps

Memory Usage

Memory Spaces

Memory Heap Non-Heap Summary

MEMORY USAGE

Memory Usage

Description

This perspective has two different views that you can switch between using the drop down box in the uppermost right hand corner of the perspective, which is labelled "Memory Actual Usage".
The first view shows a chart of the Used Memory and Maximum Memory in kb within the specific period of time.
The second view shows the Used Memory and Maximum Memory in % usage within the specific time period. 

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

http://docs.intergral.com/display/FA20/Date+Navigation


Perspective View

 

: Memory Usage PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective now has three different views that can be switched between using the drop down box in the uppermost right hand corner of the perspective.
Memory Actual Usage and Memory Percentage Usage both have a   graph view showing the Memory Usage for each individual server within the cluster, side by side on Server Comparison
the same graph. 
The final view is a   showing one Area graph, which displays the Average Memory Usage of the whole cluster.Cluster View

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
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Figure 2: Cluster version of the Memory Usage perspective

Back to the top

MEMORY SPACES

Memory Spaces

Description

This perspective is used to analyze different aspects of memory such as  a chart of the memory usage within the specific period of time, for each of the memory Code-Cache, and displays
components.

 You can switch between the different views that the perspective has to offer by using the drop down box in the uppermost right hand corner of the perspective.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View
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: Memory Spaces PerspectiveFigure 1

 

 

Cluster Perspective

Each of the views available in the server version of the perspective has been given a  view for easy comparison between servers, and a  to get Server Comparison Cluster View
a more generalized view of the performance of the cluster .
You can switch between the different views that the perspective has to offer by using the drop down box in the uppermost right hand corner of the perspective. 
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Figure 2: Cluster version of the Memory Spaces perspective
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MEMORY HEAP NON-HEAP SUMMARY

Memory Heap Non-Heap Summary

Description

This perspective has three different views that you can switch between using the drop down box in the uppermost right hand corner of the perspective.
This first view shows a chart of the Memory Heap/Non-Heap Actual Usage in bytes within the specific period of time. This view is offered in a stacked and also a non-stacked way.
The final view shows the Memory Heap/Non-Heap Actual Usage % Usage.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View
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: Memory Heap Non-Heap Summary PerspectiveFigure 1

 

 

Cluster Perspective

The  view from the server version of the perspective has been given a    view to see the data for each individual server within the cluster,  Heap/Non-Heap Actual Usage Server Comparison
side by side on the same graph, and also a  which shows an aggregate of the data across the whole cluster.Cluster View
The   view from the server version of the perspective has bee given Cluster views, one for a stacked version of the graph and one non-stacked. It also Heap/Non-Heap Percentage Usage two 
has a Server Comparison view to see the percentage usage for each individual server within the cluster.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
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Cluster version of the Memory Heap Non-Heap Summary perspective.Figure 2: 
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CPU
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CPU USAGE

CPU Usage

Description

This perspective shows a chart of the Process and System CPU Usage within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View
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: CPU Usage PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective now has two different views that can be switched between using the drop down box in the uppermost right hand corner of the perspective.
There is a   graph view showing the CPU Usage for each individual server within the cluster, side by side on the same graph. Server Comparison
There is also a   showing one Area graph, which displays the Average CPU Usage of the whole cluster.Cluster View
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Figure: Cluster version of the CPU Usage perspective

Back to the top

CPU/MEMORY USAGE

CPU/Memory Usage

Description

This perspective shows a chart of the System CPU Usage(%) alongside the Process CPU Usage(%) and Process Memory Usage(%) within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View
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: CPU Memory Usage PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective is the same as the cluster version of the CPU Usage perspective, except that the  view has an extra graph showing Server Comparison
Process Memory Usage(%) for each server, and the   has an extra series showing the Process Memory Usage(%).Cluster View
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Figure 2: Cluster version of the CPU/Memory Usage perspective
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THREAD ACTIVITY

Thread Activity

Description

The Thread Activity perspective shows a Time Block Chart of the Activity of all threads during the specified time period.
The state of each thread is represented by different colors. The color red means that the thread was blocked by something.
The color green means that the thread is active and running normally, and the color blue means that the thread is waiting or idle. 

This perspective does not appear in the Cluster folder.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can right click on any of the requests to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. JDBC Graphs and System 
Metrics.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


Figure 1: Thread Activity perspective
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FUSIONREACTOR SYSTEM METRICS

FusionReactor System Metrics

Description

This perspective shows the FusionReactor System Metrics Six-Way Charts within the specific period of time.

Usage

Here you can see 6 graphs: Request Load, Request Time, JDBC Load, JDBC Request Time, Memory Demand, and CPU. Click on any graph to maximize it and click on a maximized graph 
to return to the standard view. You can also flip one or all of the graphs between the minute and hour view by selecting one of the options from the little clock menu at the top right corner of 
each graph.You can click on the garbage can on the Memory Demand graph to request the system garbage collector.

Perspective View



 

: FusionReactor System Metrics PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective again shows the 6 graphs: Request Load, Request Time, JDBC Load, JDBC Request Time, Memory Demand, and CPU. For clusters, the data for each 
graph will be an aggregate of the data for all servers in the cluster. Therefore the perspective will look almost the same as the server version.



Cluster version of the FusionReactor System Metrics perspectiveFigure 2: 
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SERVER SUMMARY

Server Summary

Description

This perspective shows a Server Summary table within the specific period of time.

Usage

To change the order in which the results are shown, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.

Perspective View



 

: Server Summary PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective shows the same perspective as the server version(above), however the data will be calculated using the results from all of the servers 
in the cluster to form an aggregate.
The Cluster perspective will look and work the same as the server version of the perspective.

 

Back to the top

RESOURCE USAGE DATA GRID

Resource Usage Data Grid

Description

This perspective shows a table of the top 100 Resource Usage Data within the specific period of time.

Usage

To change the order in which the results are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Resource Usage Data Grid PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > General > Resource Usage Data Grid from the ToC, is a   Grid.Server Comparison
It shows a table of the usage of different resources, such as memory and cpu, at different times. This data is recorded every 5 seconds for each server, and the first 100 times will be shown.
You can see which server the data came from in the leftmost column of the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Resource Usage Data Grid perspecive
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Logs

Logs

Overview

Next Steps

Log File Entries

LOG FILE ENTRIES

Log File Entries

Description

This perspective shows a table of the top 100 Log File Entries within the specific period of time, ordered by Date.

Usage

To change the order in which the log entries are shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective Date Navigation
covers.

Perspective View



 

: Log File Entries PerspectiveFigure 1

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Logs > Log File Entries from the ToC, is a   Grid.Server Comparison
It shows the first 100 Log File Entries, ordered by Date, from the entire cluster. You can see which server each Log File Entry came from in the leftmost column of the table, which displays 
Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Log File Entries perspective
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Events

Overview

Next Steps

Annotations

Placemarks

Crash Protection

Resources with Annotations

ANNOTATIONS

Annotations

Description

This perspective shows a table of the Annotations that were created within the specified time period and a Time Block Chart of when these annotations occurred.

Usage

To change the order in which the annotations are shown in the table, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.
By hovering the mouse over the Annotation on the timeline, its details will be displayed in a popout box. 

http://docs.intergral.com/display/FA20/Date+Navigation


Perspective View

 

: Annotations PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective shows a table of the Annotations that were created within the specified time period, across the whole cluster, and a Time Block Chart of when these 
annotations occurred.
You can see which of the servers the Annotation relates to, by viewing the leftmost column in the table (named Server Name) or by hovering over the Annotation on the timeline until the 
popup is displayed.



Cluster version of the Annotations perspectiveFigure 2: 
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PLACEMARKS

Placemarks

Description

This perspective shows a chart containing the Application Placemarks within the specific period of time.

Usage

When the are a lot of Placemarks within a certain period of time, they will be automatically grouped into blocks that are easier to read and take up less space.
When you zoom in to the auto grouped block, the Placemarks will ungroup and you will be able to see each individual one(see Fig.1).
You can see details of the Placemark by hovering the mouse over it and can make edits to the Placemark, such as the name and description, by right clicking on the node.

Perspective View



 

: Placemarks PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective will show all the Placemarks for all the servers in the cluster, within the specified time period.
The placemarks will be grouped and displayed in the same way, and you will be able to see which of the servers the placemark relates to in the label of the placemark, next to the node.



Figure 2: Cluster version of the Placemarks perspective
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CRASH PROTECTION

Crash Protection

Description

This perspective shows the first 1000 Crash Protection notifications that occurred within the specified time period, and the reasons for the notification.

Usage

To change the order in which the data is shown, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this perspective covers.
You can right click on any of the rows in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of Requests 
and System Metrics.

Perspective View



Figure 1: Crash Protection Perspective

 

 

Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Events > Crash Protection from the ToC, is a   Grid.Server Comparison
It shows the first 1000 Crash Protection events from the entire cluster, ordered by Date/time. You can see which server each event came from in the leftmost column of the table, which 
displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Crash Protection perspective
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RESOURCES WITH ANNOTATIONS

Resources with Annotations

Description

This perspective has three different views that you can switch between using the drop down box in the uppermost right hand corner of the perspective.
The first view shows a chart of the Process and System CPU Usage within the specific period of time.
The second view shows a chart of the Used Memory and Maximum Memory in kb within the specific period of time.
The third view shows a Time Block Chart of the annotations that occurred during this time period. 

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.
By hovering the mouse over the Annotation on the timeline, its details will be displayed in a popout box. 

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: Resources with Annotations PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective has all the views from the Cluster version of the CPU Usage, Memory Usage and Annotations perspectives.
You can switch between the views using the drop down box in the uppermost right hand corner of the perspective 

Figure 2: Cluster version of the Resources with Annotations perspective
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Hot-Spots

Hot-Spots

Overview

Next Steps

Memory Hot-Spots

Memory at 100%

Memory Highest Usage

Memory Events

CPU Hot-Spots

Process CPU at 100%

Process CPU Highest Usage

System CPU at 100%

System CPU Highest Usage

Request Hot-Spots

Requests Not Completed

Slowest Requests (Hot-Spots)

Slowest Requests On Average (Hot-Spots)

Slowest DB Requests On Average (Hot-Spots)

Requests Restart Coverage

Database Hot-Spots

Slowest Database Requests (Hot-Spots)
MEMORY HOT-SPOTS

Memory Hot-Spots

Overview

Next Steps

  Memory at 100% Memory Highest Usage Memory Events

Memory at 100%

Memory at 100%

Description

This perspective shows a table of the first 100 times that the Memory of the server reached 100% usage.
Usage

To change the order in which the data is shown, click on one of the table column headings. Use the Date Navigation in order to change the period of time over which this perspective covers.
You can right click on any of the rows in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of Requests 
and System Metrics.
Perspective View



Figure 1: Memory at 100% Perspective

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> Memory Hot-Spots > Memory at 100% from the ToC, is a Server 
 Grid.Comparison

It shows the  You can see which server the data came from in the leftmost column of the table, first 100 times that the Memory of the any of the servers in the cluster reached 100% usage.
which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Memory at 100% perspective
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Memory Highest Usage

Memory Highest Usage

Description

This perspective shows a table of the top 100 times that had the Highest Memory Usage within the specific period of time.
Usage

To change the order in which the results are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.
Perspective View



 

: Memory Highest Usage PerspectiveFigure 1

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> Memory Hot-Spots > Memory Highest Usage from the ToC, is a Server 
 Grid.Comparison

It shows the  from any of the servers in the cluster. You can see which server the data came from in the leftmost column of the table, which displays top 100 instances of high memory usage
Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Memory Highest Usage perspective
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Memory Events

Memory Events

Description

This perspective shows a table of Memory Annotations that were created within the specified time period and a Time Block Chart of when these annotations occurred.
Usage

To change the order in which the annotations are shown in the table, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.
By hovering the mouse over the Annotation on the timeline, its details will be displayed in a popout box. 
Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


Figure 1: Memory Events Perspective

 

 
Cluster Perspective

The cluster version of this perspective shows a table of the Memory Events that were created within the specified time period, across the whole cluster, and a Time Block Chart of when these 
events occurred.
You can see which of the servers the Event relates to, by viewing the leftmost column in the table (named Server Name) or by hovering over the Event on the timeline until the popup is 
displayed.



Figure 2: Cluster version of the Memory Events perspective
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CPU HOT-SPOTS

CPU Hot-Spots

Overview

Next Steps

   Process CPU at 100% Process CPU Highest Usage System CPU at 100% Syste
m CPU Highest Usage

Process CPU at 100%

Process CPU at 100%

Description

This perspective shows the first 100 times that the Process CPU of the server reached 100%, within the specified time period.
Usage

To change the order in which the data is shown, click on one of the table column headings. Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can right click on any of the rows in the table to bring up a context menu. This will allow you to navigate to other useful perspectives for the same time period e.g. Timeline of Requests 
and System Metrics.
Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


Figure 1: Process CPU at 100% Perspective

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> > CPU Hot-Spots > Process CPU at 100% from the ToC, is a Server 
 Grid.Comparison

It shows the first 100 times that the Process CPU of the any of the servers in the cluster reached 100% usage. You can see which server the data came from in the leftmost column of the 
table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Process CPU at 100% perspective
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Process CPU Highest Usage

Process CPU Highest Usage

Description

This perspective shows a table of the top 100 Highest Process CPU Usage within the specific period of time.
Usage

To change the order in which the results are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.
Perspective View



 

: Process CPU Highest Usage PerspectiveFigure 1

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> CPU Hot-Spots > Process CPU Highest Usage from the ToC, is a Server 
 Grid.Comparison

It shows the first 100 Highest Process CPU Usage times of the any of the servers in the cluster. You can see which server the data came from in the leftmost column of the table, which 
displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Process CPU Highest Usage perspective
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System CPU at 100%

System CPU at 100%

Description

This perspective shows a table of the top 100 System CPU at 100% within the specific period of time.
Usage

To change the order in which the results are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.
Perspective View



 

: System CPU at 100% PerspectiveFigure 1

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> CPU Hot-Spots > System CPU at 100% from the ToC, is a Server 
 Grid.Comparison

It shows the first 100 times that the System CPU of the any of the servers in the cluster reached 100% usage. You can see which server the data came from in the leftmost column of the 
table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the System CPU at 100% perspective
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System CPU Highest Usage

System CPU Highest Usage

Description

This perspective shows a table of the top 100 Process and System CPU Highest Usage within the specific period of time.
Usage

To change the order in which the results are shown, click on one of the table column headings. Use the  in order to change the period of time over which this perspective Date Navigation
covers.
Perspective View



 

: System CPU Highest UsageFigure 1

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> CPU Hot-Spots > System CPU Highest Usage from the ToC, is a Server 
 Grid.Comparison

It shows the top 100 instances of high System CPU Usage from any of the servers in the cluster. You can see which server the data came from in the leftmost column of the table, which 
displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the System CPU Highest Usage perspective
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REQUEST HOT-SPOTS

Request Hot-Spots

Overview

Next Steps

  Requests Not Completed Slowest Requests (Hot-Spots) Slowest Requests On 
  Average (Hot-Spots) Slowest DB Requests On Average (Hot-Spots) Requests 

Restart Coverage

Requests Not Completed

Requests Not Completed

Description

This perspective shows a Table of the first 100 requests that failed to complete within the specified time period, and a Time Block Chart showing when these requests where started.
Usage

To change the order in which the requests are shown in the table, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.
By hovering the mouse over the on the timeline, its details will be displayed in a popout box. requests 
Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


Figure 1: Requests Not Completed perspective

 

 
Cluster Perspective

The Cluster version of this perspective, found under Clusters > "Cluster Name" > Deep Server Analysis > Hot-Spots> Request Hot-Spots > Requests Not Completed from the ToC, is a Server 
 Grid.Comparison

It shows the first 100 requests that were not completed during the time frame, from any of the servers in the cluster. You can see which server the request came from in the leftmost column of 
the table, which displays Server Name.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the Requests Not Completed perspective
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Slowest Requests (Hot-Spots)

Slowest Requests (Hot-Spots)

See Slowest Requests
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Slowest Requests On Average (Hot-Spots)

Slowest Requests On Average (Hot-Spots)

See Slowest Requests On Average
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Slowest DB Requests On Average (Hot-Spots)

Slowest DB Requests On Average (Hot-Spots)

See Slowest DB Requests On Average
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Requests Restart Coverage

Requests Restart Coverage

Description

This perspective makes it easy to identify commonly executing requests at the time of a server failure. The report offers the number of times a request has been executing at the time of a 
failure and the percentage coverage over all server failures in a given time-frame.   It shows the top 100 requests based on the number of restarts they were involved in. It shows the total 
number of requests that were not completed, for any given request URL within the specified time period.   The number of restarts that the particular request was involved in (Restarts Covered) 
and the number of covered restarts as a percentage of the total number of restarts that occurred (Restart Coverage%) are also shown.
Usage

To change the order in which the requests are shown in the table, click on one of the table column headings. Use the   in order to change the period of time over which this Date Navigation
perspective covers.

From easily identifying the failure URL, you can then drill into individual failures identifying the root-cause of each - often finding a simple commonality that can be resolved by the 
development team.
Perspective View

Figure 1: Requests Restart Coverage perspective
DATABASE HOT-SPOTS

Database Hot-Spots

Overview

Next Steps

Slowest Database Requests (Hot-Spots)

Slowest Database Requests (Hot-Spots)

Slowest Database Requests (Hot-Spots)

See Slowest Database Requests
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ColdFusion Monitor

http://docs.intergral.com/display/FA20/Date+Navigation


ColdFusion Monitor

Overview

Next Steps

CF General Statistics

CF Scope Sizes

CF Hit Counts

CF DB Pool Stats

CF GENERAL STATISTICS

CF General Statistics

Description

The perspective has several different views for lots of different ColdFusion Statistics, that you can switch between using the drop down box in the uppermost right hand CF General Statistics 
corner of the perspective
within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: CF General Statistics PerspectiveFigure 1

 

 

Cluster Perspective

All of the views that are available in the server version of this perspective are present in the cluster version, in the form of one   view and one  each.Server Comparison Cluster View
You can switch between the views using the drop down box in the uppermost right hand corner of the perspective.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


 

Figure 2: Cluster version of the CF General Statistics perspective
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CF SCOPE SIZES

CF Scope Sizes

Description

This perspective shows a chart of the CF Scope Sizes within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: CF Scope Sizes PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective consists of four  views: Memory Used(bytes), Application Scope Size(bytes), Session Scope Size(bytes) and Server Scope SizeServer Comparison
(bytes).
Each graph has it's own Select Series" drop down box in the right hand corner of the view.

 

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp


Figure 2: Cluster version of the CF Scope Sizes perspective
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CF HIT COUNTS

CF Hit Counts

Description

This perspective shows a chart of the CF Hit Counts within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


 

: CF Hit Counts PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective consists of a   and a   for Hit Counts and a Server Comparison view and Cluster view for Hit Counts Delta.Server Comparison Cluster View
You can switch between the views using the drop down box in the uppermost right hand corner of the perspective.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


Figure 2: Cluster version of the CF Hit Counts perspective
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CF DB POOL STATS

CF DB Pool Stats

Description

This perspective shows a chart of the CF DB Pool Stats Usage within the specific period of time.

Usage

Use the   in order to change the period of time over which this perspective covers.Date Navigation
You can temporarily remove a series from the graph by clicking the "Select Series" drop down box in the right hand corner of the view, and then
simply uncheck the series that you want to remove by clicking it. This will remove the series from the graph allowing you to the remaining series more easily.

Perspective View

http://docs.intergral.com/display/FA20/Date+Navigation


: CF DB Pool Stats PerspectiveFigure 1

 

 

Cluster Perspective

The cluster version of this perspective a   view of the DBPoolStats for each server in the cluster and one  which shows a sum of all DBPoolStats across all Server Comparison Cluster View
servers in the cluster.
You can switch between the views using the drop down box in the uppermost right hand corner of the perspective.

http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ServerComp
http://docs.intergral.com/display/FA20/Cluster+Perspectives#ClusterPerspectives-ClusterView


\

Figure 2: Cluster version of the CF DB Pool Stats perspective
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Applications

Applications

Applications are an easy way to filter your request data. It works in the same way 
as the filtering options in each of the Request perspectives, but it will be applied 
to each of the perspectives in the Application straight away.
This saves you from having to configure and apply the filters that you most 
commonly use, every time you open a Request perspective. 

Application filters will be applied to all the Request perspectives that are Grids 
and the Database perspectives that are grids, including the perspectives for 
Clusters. When applied, you can find the perspectives under the ToC item labeled 
"Applications".

Creating an Application

To create an application, you must go to the "Manage Applications" page from the 
ToC.

 

You will be taken to the following page. To add an Application, simply enter you 
desired name and click the "Add Application Filter" button.
The name cannot match an already existing name and cannot contain any 
spaces or the following characters: ! # $ % ^ & * ( ) + = ~ ` [ ] \ ' ; , { } | " < > ?.

 

Configuring an Application

   



Once you have added an Application, the following options page will appear:

Figure 1: Example Application Filter

Your new Application will now appear under the ToC menu item "Applications", 
with the name you have given it.
You can add as many Applications as you like, and each of the existing 
Applications will be displayed under "Current Application Filters", with there 
configuration options hidden.
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Request Params

You can filter the requests by parameters that are passed down through the 
query string, such as the event parameter or the fuseaction parameter.
To set this filter option, click the "Request Params" tab in the Application 
Configuration Options (this tab is open by default).

Enter the parameter you want to filter by (e.g. event) into the first text box. 
Choose a filtering action from the drop down box (e.g. IS, IS NOT) and finally 
enter the filter condition that you want the param to meet (in Fig1, page.user is 
used).
Once you have done this, simply click the  button to add the filter. You can chain 
together as many filters as you want to further narrow down your result sets, and 
you can remove
a filter at any time by clicking the small    next to the filter option in the applications 
configuration options.

Figure 2: Slowest Requests Perspective with 'Request Param' Application Filters 

Figure 2 shows the "Slowest Requests" perspective, after the Application Filter 
from Figure1 has been applied. You can see that the data in the table is limited to 
show only the requests with a Query String containing an "event" parameter
that matches the condition "page.user".

 

Request URL

You can filter the data by the URLs of the requests. Each request has its URL 
broken down into segments. Each / in the URL denotes the start of a new 
segment.
For instance, the following URL:  http://int0046.bbn.intergral.com:18080/apps
/modelgluesamples/lhp/index.cfm
can be broken down into the following segments;

Segment Value



URL Protocol
(protocol://*...) 

http

URL Hostname
(*://hostname/*...) 

int0046.bbn.intergral.com

URL Port
(*://*:port/*...) 

18080

Path Element 1
(*://*[1]/*...) 

apps

Path Element 2
(*://*/*/[2]/*...) 

modelgluesamples

Path Element 3
(*://*/*/*/[3]/*...) 

lhp

Path Element 4
(*://*/*/*/*/[4]/*...) 

index.cfm

To set this filter option, click the "Request URL" tab in the Application 
Configuration Options.

Enter the segment you want to filter by (e.g. URL Port) from the first drop down 
box. Choose a filtering action from the second drop down box (e.g. IS, IS NOT) 
and finally enter the filter condition that you want the url segment to meet into the 
text box.
Once you have done this, simply click the  button to add the filter. You can chain 
together as many filters as you want to further narrow down your result sets, and 
you can remove
a filter at any time by clicking the small    next to the filter option in the applications 
configuration options.

Figure 3: The Slowest Request perspective with 'Request URL' Application filters.

Figure 3 shows the "Slowest Requests" perspective, after a Request URL 
Application Filter has been applied. In this case, the Application uses two filter.
It first filters by "Port is  18080", and second filters by "Path Element 3 is lhp". You 
can see that the data in the table is limited to show only the requests that match 
these two filters.
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FusionAnalytics Reporting

FusionAnalytics Reporting

Overview

The reporting feature of FusionAnalytics allows you to receive daily reports on the 
status of your server.

There are 2 different types of reports available:  and TAP Reports Daily Status 
.Reports

TAP Reports

The TAP Reports provide a daily application score and trend analysis, which is 
based on your application's Traffic, Availability and Performance (TAP).

They are designed to be less technical and are aimed at application and program 
managers, business owners and solution stake holders (Figure 1).

Click here to learn more about the TAP Reports.

  TAP Reports:

Running a TAP Report

TAP Report Provider 
Arguments

Understanding the 
TAP Report

Daily Status Reports:

Running a Daily 
Status Report

Daily Status Report 
Provider Arguments

Understanding the 
Daily Status Report

SLA Reports:

Accessing the SLA 
Report Configuration 
Page

If you want to set up this feature as quickly as possible, see the Quick 
.Start Guide

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Figure 1: Part of a TAP Report

Daily Status Reports

The Daily Status Reports are intended to be used by technical developers, project 
leads, project managers and system administrators.

They provide a complete breakdown of your application performance, from 
slowest requests to system load statistics (Figure 2).

Click here to learn more about the Daily Status Reports.

Figure 2: Part of a Daily Status Report

SLA Reports

The SLA Reports are a designed to give an overview of your server performance 
at a glance using business-level statistics.

Click here to learn more about the SLA Reports.
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Daily Status Reports

Running a Daily Status Report

Daily Status Report Provider Arguments
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TAP Reports

TAP REPORTS

OVERVIEW

The Reports give you a less technical view of how your server is performing (Figure 1).

Every day you will get a TAP Score and Grade for how well your server is doing. It will also compare this to your previous scores.

Reports straight to your 
inbox
Make sure you set your 
reports up to receive 
them as emails!

See the Setting Up TAP 
 and Daily Status Reports

or Setting up the SLA 
 quick start guides.Reports
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#
#
#
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This score gives you a standardized comparison of applications regardless of function or hardware capability.

 

Figure 1: TAP Report Overview
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An explanation of how the TAP Score is calculated.

Running a TAP Report
How to run a TAP Report and where to view it after it has run.

TAP Report Provider Arguments
Different arguments you can use to customize your reports.

Understanding the TAP Report
What each section of the TAP Report means and how you can use it to improve your server.
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Running a TAP Report

TAP Report Provider Arguments

Understanding the TAP Report

The TAP Report configuration page

What is TAP Score - and how is it calculated?

What is TAP

TAP is a combination of your server's Traffic, Availability and Performance.

Traffic is measured by the number of impressions and sessions.

Availability is calculated from the amount of uptime and number of server 
restarts.

Performance is measured by the average execution time.

  On This Page:

TAP Score

Impressions

Sessions

If you are looking for a quick start guide for getting your reports up and running as soon as possible, see  in the Setting Up TAP and Daily Status Reports Quick Start 
.Guide



TAP Score

The TAP Score is measured from 0 (worst score) to 10 (best score).

There are 5 sections, awarding up to 2 points each.

Back to the top

Impressions

Calculated on a normalized scale from 
365 days of historic data and then 
scaled between -4 and +4 standard 
deviations from the mean.

+4 standard deviations = 100%

-4 standard deviations = 0%

Back to the top

Sessions

Calculated on a normalized scale from 
365 days of historic data and then 
scaled between -4 and +4 standard 
deviations from the mean.

+4 standard deviations = 100%

-4 standard deviations = 0%

Back to the top

Uptime

Calculated on a set exponential scale:

No downtime = 100%

1 minute downtime = 97%

2 minutes downtime = 94%

3 minutes downtime = 91%

4 minutes downtime = 89%

5 minutes downtime = 86%

10 minutes downtime = 74%

20 minutes downtime = 55%

30 minutes downtime = 41%

60 minutes downtime = 17%

Back to the top

Restart Count

Calculated on a set exponential scale:

0 restarts = 100%

1 restart = 90%

Uptime

Restart Count

Execution Time



2 restarts = 81%

3 restarts = 74%

4 restarts = 67%

5 restarts = 60%

10 restarts = 37%

20 restarts = 14%

30 restarts = 5%

Back to the top

Execution Time

Calculated on a normalized scale 
from 365 days of historic data and 
then scaled between -4 and +4 
standard deviations from the mean.
As lower execution times are better, 
the scaling used is the inverse of that 
for impressions and sessions.

-4 standard deviations = 100%

+4 standard deviations = 0%

Back to the top

Next Steps

Running a TAP Report
How to run a TAP Report and where to view it after it has run.

TAP Report Provider Arguments
Different arguments you can use to customize your reports.

Understanding the TAP Report
What each section of the TAP Report means and how you can use it to improve your server.

Running a TAP Report

Running a TAP Report

This section covers several aspects of running a TAP Report. See the links on the right to jump to a specific section.

Viewing Scheduled TAP Reports

A TAP Report is automatically scheduled for each FADS application.

These tasks can be found by logging into FADS and going to  (Figure 1).Scheduled Tasks  Application Tasks Summary

If you are looking for a quick guide to getting the reports running, see  in the .Setting Up TAP and Daily Status Reports Quick Start Guide

The Application must be started for the reports to be able to run.



Figure 1: Application Scheduled Tasks

The table below gives an explanation of each column from the above picture (Figure 1).

Column Name Description

Task Name A description of the task; e.g. TAP Report.

Provider Name The type of task and the application it is running on. Each application has its own TAP Report scheduled.

Duration How long the task will run for. By default the TAP Reports will keep running indefinitely.

Schedule When the task will run. It is recommended that the TAP Report runs every day to give the most accurate score.

Last Run The time and date when the task last ran, either if it ran when scheduled or was manually run.

Status Shows if the task is Scheduled, Not Scheduled or Running.

Back to the top

Changing When a TAP Report Runs

You can edit the scheduled TAP Report by clicking  (Figure 2).Edit

This allows you to edit when the TAP Reports will run. The most suitable option is to have them running once a day, so that your receive your reports daily.

You also have the option to change if the task is active and the duration of the task, if needed.

This is also where  are entered if needed. See  for more information.Provider Arguments Customizing a TAP Report

Figure 2: Editing a TAP Report

Back to the top



Running a TAP Report Instantly

You can run a TAP Report at any time by clicking  (Figure 3).Run Now

This will generate a report for the previous day.

Figure 3: Run a task instantly

 The Application must be started for the button to be enabled.

Back to the top

Activating and Deactivating a TAP Report

The TAP Reports in the  are activated by default.Application Tasks Summary

If you need to deactivate TAP Reports for a particular application, you can click the  button (Figure 4).Deactivate

You can start it again by clicking .Activate

Figure 4: Report Buttons

Back to the top

Customizing a TAP Report

You can use  to customize your TAP Reports to meet your needs.Provider Arguments

For example:

sending reports as emails 

using a different timezone

using HTTPS for links and images

See  for more information.TAP Report Provider Arguments

Back to the top

Viewing a TAP Report

After a TAP Report has run you can view it in the client, under  (Figure 5).Business Metrics  Reports

You can double click on a report to open it.



 

Figure 5: Reports Perspective

You can also use the  option, found next to the  tab at the bottom of the screen, to find specific reports (Figure 6).Report Filter Timeline

For help using the , see the  section.Report Filter Reports

Figure 6: Report Filters

  You can also configure your TAP Reports so that you can view them as emails. See the  argument in  .users TAP Report Provider Arguments

Back to the top

Next Steps

What is TAP
An explanation of how the TAP Score is calculated.

TAP Report Provider Arguments
Different arguments you can use to customize your reports.

Understanding the TAP Report
What each section of the TAP Report means and how you can use it to improve your server.

Take me back to .FusionAnalytics Reporting

TAP Report Provider Arguments

TAP Report Provider Arguments

Argu
ment 
Name

Default 
Value

Description Example 
Values

date Previous 
day's date

The date that the report will run for.

This will override the previous day's date that is automatically provided by 
the scheduled task.

The value must be a UTC time in milliseconds.

The value that is entered will be rounded to midnight (the start of the 
day) in the specified timezone and will become the end date of the report.

1312243200000 
(Report Date: 
1st-2nd August 

 GMT)

1310281200000  
(Report Date: 
9th-10th August 
GMT)

https False Defines if HTTP or HTTPS will be used.

HTTP / HTTPS is used for links and images.

The same setting will apply to reports that are emailed to users.

If the argument is not provided, HTTP is always used.

true

   
All of these arguments are optional
The reports will run without any of these arguments being provided, but they can be used to enhance your 
reports to suit your needs.



previou
sDays

None Collects any data that is available for previous days.

The value must be a UTC time in milliseconds.

Make sure the time is the start of the day i.e. midnight.

If you have data from previous days imported into FusionAnalytics, but no 
TAP Reports for those days, you can use this argument to collect the data.

Using this argument will produce one report for each day onwards from 
the specified time.

   You should not use this every time you run a TAP Report:Warning:
Data from previous TAP reports can automatically be retrieved, 
without this argument.

If you have a large amount of previous data, it may also take a long 
time to run.

1361404800000

timezo
ne

DataCollect
or's 
timezone

Used to change the default timezone of the report.

This will change the start and end dates of the report to midnight in the 
specified timezone.

Any valid Java timezone can be used.

If the timezone is misspelt, it will revert back to the timezone of the 
DataCollector. See   for more information.Applications (FADC)

America
/New_York 

Europe/Berlin 

GMT

users None Used to email reports to the specified users.

Users  have an email address on their account. See must Users Summary 
 for more information. (FADS)

The Mail Server  also be configured. See   for more must Server Settings
information.

Multiple users can be added by separating the usernames with a comma 
(no space).

admin 

admin,user1,
user2

Adding Provider Arguments

To add your Provider Arguments, you will need to go to the  in FADS and click the Application Tasks Summary Edit
button on the TAP Report task.

In the  section, you will see fields for the Name and Value (Figure 1).Provider Arguments

You can add multiple arguments by clicking  .Add New Argument

You can remove arguments by clicking .

Click  when you have finished editing the task.Update Task

Figure 1: Adding Provider Arguments

Next Steps

What is TAP Score - and how is it calculated?
An explanation of how the TAP Score is calculated.

Running a TAP Report
How to run a TAP Report and where to view it after it has run.

Understanding the TAP Report
What each section of the TAP Report means and how you can use it to improve your server.

Take me back to .FusionAnalytics Reporting

Understanding the TAP Report



Understanding the TAP Report

This page will help you to understand the data in your TAP Report. Please see 
the links to the right to jump to a particular section.

In the top right corner of the report you can find 3 links:

Link Name Description

?What is 
TAP?

This will take you to an online description of what TAP is and how it is 
calculated.

View Daily 
Status 
Report

This is only displayed if there is also a Daily Status Report for the 
same DataCollector, date and timezone.

View in 
FusionAnalyti
cs

If you are viewing the report as an email, you can click this to take 
you directly to this application in FusionAnalytics.

On this page:

Overview

Last 7 Days

Weekly Report

Day of Week

Overview

The Overview header displays the following information (Figure 1):

Figure 1: TAP Overview section header example

The table below gives an explanation of what each part of the header means:

Header Information Description

DataCollector 
e.g. cfsrv-2

The DataCollector that the data belongs to.

Day 
e.g. Thursday, 11 
August 2011

The date that the report is run for (from midnight to midnight of that day).

Time Zone The default time zone is the one set on the DataCollector. See  if you want to TAP Report Provider Arguments
change the time zone of the report.

Start The exact date and time that the data in the report starts from. It also includes the offset from UTC time (e.g. 
.+0200)

End The exact date and time that the data in the report ends at. It also includes the offset from UTC time (e.g. 
.+0200)

 Clicking on the Overview header will take you to a copy of the TAP Report in the Web Client.

The Overview contains the following sections:

Name Example Description

TAP Score A value between 0.0 (worst score) and 10.0 (best score), this is the 
score that your server has received for that day. 

For more information on how the TAP Score is calculated, see What is 
.TAP?

TAP Grade Related to the TAP Score, it is the grade that corresponds with your 
score: 

9.0 and above = A++

8.0 to 8.9 = A+

7.0 to 7.9 = A

6.0 to 6.9 = B

5.0 to 5.9 = C

4.0 to 4.9 = D



3.0 to 3.9 = E

2.9 and below = F

Week-to-Date 
Trend

The Last 7 Days score is an average of the TAP scores from today and 
the 6 previous days. 

The arrow indicates if today's score has improved, decreased or stayed 
the same compared to the week's average. 

Change gives the percentage change from the Last 7 Days average and 
today's score. 

30-Day Trend The Last 30 Days score is an average of the TAP scores from today and 
the 29 previous days. 

The arrow indicates if today's score has improved, decreased or stayed 
the same compared to the month's average. 

Change gives the percentage change from the Last 30 Days average 
and today's score. 

Year-to-Date 
Trend

The Last 365 Days score is an average of the TAP scores from today 
and the 364 previous days. 

The arrow indicates if today's score has improved, decreased or stayed 
the same compared to the year's average. 

Change gives the percentage change from the Last 365 Days average 
and today's score. 

TAP History

(click to enlarge)

The TAP History graph shows a maximum of 30 days. There are 3 lines, 
showing: 

The TAP score for each day

The 30 day average TAP scores

The 365 day average TAP scores 

 Until you have more than 30 days of TAP data, the 30 and 365 
day averages will be the same.

Recommendat
ions for 
Improvement

(click to enlarge)

The Recommendations give ideas on how you can improve your score. It 
will only suggest improvement in areas that can actually be improved (e.
g. if Uptime is already 100%, improvement will not be suggested). 

You can also see the score you will achieve by making all of the 
improvements. 

Back to the top

Last 7 Days

The top row of the Last 7 Days table is 
highlighted; this is the data that has been 
generated for the day the report has been run (i.e. 
the previous day).

Last 7 Days contains the following sections:

N
a
m
e

Example Descri
ption

D
at
e 
e.
g. 
Fri
da
y, 
1 

The top 
row, 
highlight
ed in 
purple, 
is the 
date 
that the 
report 

Example Last 7 Days

(click to enlarge)



Ju
ly 
20

 11

has 
been 
generat
ed for. 

The 
next 
rows 
show 
the 
previous
7 days, 
going 
back to 
the 
same 
day of 
the 
previous
week (e.
g. 
Friday 
24 July 
2011).

T
A
P 
Sc
or
e

The 
TAP 
Score 
that 
your 
server 
received
for 
each 
day. 

30
-
D
ay
Tr
en
d

This 
compar
es the 
TAP 
Score 
from 
each 
day 
with the 
30-day 
Average
score 
from 
each 
day. 

A green 
arrow 
indicate
s your 
server 
has 
improve
d on 
the 30 
day 
average
; a red 
arrow 
indicate
s your 
score 
has 
decreas
ed and 
a grey 
arrow 
indicate
s no 
change.

30
-
D
ay
Av
er
ag
e

This is 
than 
average
of TAP 
Scores 
from 
the ?
past 30 



days. It 
is the 
same 
as the 
30-Day 
Trend 
from 
the Ove

 rview
section. 

Im
pr
es
si
on
s 
(T
raf
fic)

Impressi
ons are 
the 
total 
number 
of hits 
received
during 
the 
start 
and 
end 
date of 
the 
report. 

For 
Impressi
ons, 
higher 
values 
are 
preferab
le. 

The 
Impressi
ons 
section 
will 
receive 
a score 
between
0.0 - 
2.0 
(see ?W
hat is 

 TAP?
for 
more 
informat
ion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the bar, 
the 
better 
the 
score.

S
es
si
on
s 
(T
raf
fic)

Session
s are 
the 
total 
number 
of 
session
s 
between
the 
start 
and 
end 
date of 
the 
report. 



For 
Session
s, 
higher 
values 
are 
preferab
le. 

The 
Session
s 
section 
will 
receive 
a score 
between
0.0 - 
2.0 
(see ?W
hat is 

 TAP?
for 
more 
informat
ion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the bar, 
the 
better 
the 
score.

U
pti
m
e 
(A
va
ila
bil
ity)

Uptime 
is the 
percent
age of 
time 
that 
your 
server 
has 
been 
up 
between
the 
start 
and 
end 
date of 
the 
report. 

If your 
Uptime 
is not 
100%, 
you can 
hover 
your 
mouse 
over 
the 
value to 
see the 
exact 
amount 
of time 
your 
server 
was 
down. 

For 
Uptime, 



higher 
values 
are 
preferab
le. 

The 
Uptime 
section 
will 
recieve 
a score 
between
0.0 - 
2.0 
(see ?W
hat is 

 foTAP?
r more 
informat
ion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the bar, 
the 
better 
the 
score.

R
es
tar
t 
C
ou
nt 
(A
va
ila
bil
ity)

Restart 
Count 
is the 
total 
number 
of 
server 
restarts 
between
the 
start 
and 
end 
date of 
the 
report. 

For 
Restart 
Count, 
lower 
values 
are 
preferab
le. 

The 
Restart 
Count 
section 
will 
receive 
a score 
between
0.0 - 
2.0 
(see ?W
hat is 

 foTAP?
r more 
informat
ion). 
The 
size of 
the bar 
is 
measur
ed on 



this 
score; 
the 
shorter 
the bar, 
the 
better 
the 
score.

Ex
ec
. 
Ti
m
e 
(P
erf
or
m
an
ce)

Exec. 
Time is 
the 
average
executio
n time 
of 
request
s 
between
the 
start 
and 
end 
date of 
the 
report. 

For 
Exec. 
Time, 
lower 
values 
are 
preferab
le. 

The 
Exec. 
Time 
section 
will 
receive 
a score 
between
0.0 - 
2.0 
(see ?W
hat is 

 foTAP?
r more 
informat
ion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
shorter 
the bar, 
the 
better 
the 
score.

Back to the top

Weekly Report

N
a
m
e

Example De
sc
rip
tio
n

M
on

Ea
ch 

Example Weekly Report



da
y 
to 
S
un
da
y

row
is 
on
e 
we
ek; 
the
dat
es 
are
fro
m 
Mo
nd
ay 
to 
Su
nd
ay. 
  
Th
e 
top
row
incl
ud
es 
the
dat
e 
tha
t 
the
rep
ort 
has
be
en 
ge
ner
ate
d 
for. 

7-
D
ay
Av
er
ag
e

Th
e 
7-
Da
y 
Av
era
ge 
is 
an 
ave
rag
e 
of 
the
TA
P 
sco
res
fro
m 
tha
t 
we
ek 
(M
on
day
to 
Su
nd
ay)
. 

 If 
the
cur
ren

(click to enlarge)



t 
we
ek 
has
not
yet 
fini
she
d, 
the
top
row
will 
sho
w 
the
ave
rag
e 
fro
m 
Mo
nd
ay 
to 
the
cur
ren
t 
day
. 

30
-
D
ay
Tr
en
d

Thi
s 
co
mp
are
s 
the
TA
P 
Sc
ore
fro
m 
eac
h 
day
wit
h 
the
30-
day
Av
era
ge 
sco
re 
fro
m 
eac
h 
day
. 

A 
gre
en 
arr
ow 
indi
cat
es 
you
r 
ser
ver
has
imp
rov
ed 
on 
the
30 
day



ave
rag
e; 
a 
red
arr
ow 
indi
cat
es 
you
r 
sco
re 
has
dec
rea
sed
an
d 
a 
gre
y 
arr
ow 
indi
cat
es 
no 
cha
ng
e. 

30
-
D
ay
Av
er
ag
e

Thi
s 
is 
tha
n 
ave
rag
e 
of 
TA
P 
Sc
ore
s 
fro
m 
the
?
pas
t 
30 
day
s. 
It 
is 
the
sa
me
as 
the
30-
Da
y 
Tre
nd 
fro
m 
the 
Ov
ervi

 ew
sec
tion
.

7-
D
ay
Av
er
ag
e 

 ?(click to enlarge)

Thi
s 
sho
ws 
the
7-
Da



T
A
P 
Sc
or
e

y 
ave
rag
e 
as 
a 
bar
gra
ph,
allo
win
g 
you
to 
eas
ily 
co
mp
are
whi
ch 
we
eks
ha
d 
bet
ter 
TA
P 
sco
res
on 
ave
rag
e. 
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Day of Week

N
a
m
e

Example Descri
ption

Da
te 
e.
g. 
Tu
es
da
y, 
28 
Ju
ne 
20
11

The 
top 
row, 
highligh
ted in 
purple, 
is the 
date 
that 
the 
report 
has 
been 
generat
ed for.  

The 
next 
rows 
show 
the 
same 
day of 
the 
week, 
going 
back 
over 5 
weeks. 

TA
P 
Sc
or
e

The 
TAP 
Score 
that 
your 
server 

Example Day of Week

(click to enlarge)



receive
d for 
each 
day.

La
st 
4 
Day
Tr
en
d 
e.
g. 
La
st 
4 
Tu
es
da
y 
Tr
end

This 
compar
es the 
TAP 
Score 
from 
each 
day 
with 
the 
Last 4 

 Day
Trend 
score 
from 
each 
day.  

A 
green 
arrow 
indicate
s your 
server 
has 
improve
d from 
the 
trend; 
a red 
arrow 
indicate
s your 
score 
has 
decreas
ed and 
a grey 
arrow 
indicate
s no 
change. 

La
st 
4 
Day
Av
er
ag
e 
e.
g. 
La
st 
4 
Tu
es
da
y 
Av
er
age

This is 
an 
averag
e of 
the 
scores 
from 
the last 
4 rows 
(the 
same 
day of 
each 
week).

Im
pr
es
sio
ns 
(Tr
affi
c)

Impress
ions 
are the 
total 
number
of hits 
receive
d 
during 
the 
start 
and 
end 
date of 
the 



report.  

For 
Impress
ions, 
higher 
values 
are 
prefera
ble.  

The 
Impress
ions 
section 
will 
receive 
a score 
betwee
n 0.0 - 
2.0 
(see ?
What 
is TAP?
 for 
more 
informa
tion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the 
bar, 
the 
better 
the 
score.

Se
ssi
on
s 
(Tr
affi
c)

Session
s are 
the 
total 
number
of 
session
s 
betwee
n the 
start 
and 
end 
date of 
the 
report.  

For 
Session
s, 
higher 
values 
are 
prefera
ble.  

The 
Session
s 
section 
will 
receive 
a score 
betwee
n 0.0 - 
2.0 
(see ?
What 
is TAP?
 for 



more 
informa
tion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the 
bar, 
the 
better 
the 
score.

Up
tim
e 
(A
vai
lab
ilit
y)

Uptime 
is the 
percent
age of 
time 
that 
your 
server 
has 
been 
up 
betwee
n the 
start 
and 
end 
date of 
the 
report.  

If your 
Uptime 
is not 
100%, 
you 
can 
hover 
your 
mouse 
over 
the 
value 
to see 
the 
exact 
amount
of time 
your 
server 
was 
down.  

For 
Uptime,
higher 
values 
are 
prefera
ble.  

The 
Uptime 
section 
will 
recieve 
a score 
betwee
n 0.0 - 
2.0 
(see ?
What 
is TAP?
 for 
more 
informa



tion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
longer 
the 
bar, 
the 
better 
the 
score. 
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rt 
Co
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(A
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Restart 
Count 
is the 
total 
number
of 
server 
restarts
betwee
n the 
start 
and 
end 
date of 
the 
report.  

For 
Restart 
Count, 
lower 
values 
are 
prefera
ble.  

The 
Restart 
Count 
section 
will 
receive 
a score 
betwee
n 0.0 - 
2.0 
(see ?
What 
is TAP?
 for 
more 
informa
tion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
shorter 
the 
bar, 
the 
better 
the 
score. 

Ex
ec.
Ti
me 

(P
erf

Exec. 
Time is 
the 
averag
e 
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on time 



or
ma
nc
e)

of 
request
s 
betwee
n the 
start 
and 
end 
date of 
the 
report.  

For 
Exec. 
Time, 
lower 
values 
are 
prefera
ble.  

The 
Exec. 
Time 
section 
will 
receive 
a score 
betwee
n 0.0 - 
2.0 
(see ?
What 
is TAP?
 for 
more 
informa
tion). 
The 
size of 
the bar 
is 
measur
ed on 
this 
score; 
the 
shorter 
the 
bar, 
the 
better 
the 
score. 

Back to the top

Next Steps

What is TAP?
An explanation of how the TAP Score is calculated.

Running a TAP Report
How to run a TAP Report and where to view it after it has run.

TAP Report Provider Arguments
Different arguments you can use to customize your reports.

The TAP Report configuration page

THE TAP REPORT CONFIGURATION

The TAP Reports come with a new report configuration feature will allows you to a
 This feature can be found within the dd email recipients to the report.

FusionAnalytics Client.

There are two ways to access the client, either through a web browser (see The 
) or using our Air Dashboard (see FusionAnalytics Web Client The FusionAnalytics 

).AIR Client

On this page:

Adding a recipient 
from FADS users

Adding a custom 
email address

 



Where to go from the client

Once you've accessed the client, you'll find a new ToC item under Administrator > 
TAP Report Configuration.

Clicking this will display the new configuration screen which may contain existing 
report configurations if some have previously been created.

Session 
Configuration

Adding email recipients.

This page allows you to configure who will receive the report via email.

There are two methods of adding recipients:

Adding a recipient from FADS users. Only users who are mapped are available to add with this method.

Adding a custom email address.

Adding a recipient from FADS users.

To add from FADS users, simply click the Add From Users button to view a list of viable FADS users and click the  button to add them to 
the recipients list.

Adding a custom email address

To add a custom email address, simply enter the email address and optional description into the corresponding fields and click the  
button.

Session Configuration

Click on the Report Configuration tab. You will see a page that looks like this:



This page will allow you to tell the TAP report which of your servers use sessions.

For those that use sessions, the box MUST be checked for the TAP report to calculate the data.

If a server does not use sessions, then the check box should be left clear. In these cases, the TAP report will not take session data into 
account when calculating the final score.

 

 

 

Daily Status Reports

DAILY STATUS REPORTS

OVERVIEW

The Daily Status Reports provide detailed information about the requests, database activity, resource usage and even a breakdown of the individual applications running.

Each day you can see how your server has done compared to the previous day.

This allows you to easily analyze which areas need improvement, helping you to improve the performance of your server.

 

Figure 1: Daily Status Report

Find out more

Running a Daily Status Report
How to run a Daily Status Report and where to view it after it has run.

Daily Status Report Provider Arguments
Different arguments you can use to customize your reports.

Understanding the Daily Status Report
What each section of the Daily Status Report means and how you can use it to improve your server.

NEXT STEPS

If you are looking for a quick start guide for getting your reports up and running as soon as possible, see ?Setting Up TAP and Daily Status Reports in the ?Quick 
 Start Guide guide.



Running a Daily Status Report

Daily Status Report Provider Arguments

Understanding the Daily Status Report

The Daily Status Report configuration page

Running a Daily Status Report

Running a Daily Status Report

This section covers several aspects of running a Daily Status Report. See the links on the right to jump to a specific section.

Viewing Scheduled Daily Status Reports

A Daily Status Report is automatically scheduled for each FADS application.

These tasks can be found by logging into FADS and going to  (Figure 1).Scheduled Tasks  Application Tasks Summary

Figure 1: Application Scheduled Tasks

The table below gives an explanation of each column from the above picture (Figure 1).

Column 
Name

Description

Task Name A description of the task; e.g. Daily Status Report.

Provider Name The type of task and the application it is running on. Each application has its own Daily Status Report 
scheduled.

Duration How long the task will run for. By default the Daily Status Reports will keep running indefinitely.

Schedule When the task will run. It is recommended that you keep the Daily Status Report running every day.

Last Run The time and date when the task last ran, either if it ran when scheduled or was manually run.

Status Shows if the task is Scheduled, Not Scheduled or Running.

Back to the top

Changing When a Daily Status Report Runs

You can edit the scheduled Daily Status Report by clicking  (Figure 2).Edit

This allows you to edit when the Daily Status Reports will run. The most suitable option is to have them running once a day, so that your receive your reports daily.

You also have the option to change if the task is active and the duration of the task, if needed.

This is also where  are entered if needed. See  for more information.Provider Arguments Customizing a Daily Status Report

If you are looking for a quick guide to getting the reports running, see ?  in the ?  guide.Setting Up TAP and Daily Status Reports Quick Start Guide

The Application must be started for the reports to be able to run.



Figure 2: Editing a Daily Status Report

Back to the top

Running a Daily Status Report Instantly

You can run a Daily Status Report at any time by clicking  (Figure 3).Run Now

This will generate a report for the previous day.

Figure 3: Run a task instantly

 The Application must be started for the button to be enabled.

Back to the top

Activating and Deactivating a Daily Status Report

The Daily Status Reports in the  are activated by default.Application Tasks Summary

If you need to deactivate the Daily Status Reports for a particular application, you can click the  button (Figure 4).Deactivate

You can start it again by clicking .Activate

Figure 4: Report Buttons



Back to the top

Customizing a Daily Status Report

You can use  to customize your Daily Status Reports to meet your needs.Provider Arguments

For example:

sending reports as emails

using a different timezone

using HTTPS for links and images

See  for more information.Daily Status Report Provider Arguments

Back to the top

Viewing a Daily Status Report

After a Daily Status Report has run you can view it in the client, under  (Figure 5).Business Metrics  Reports

You can double click on a report to open it.

 

Figure 5: Reports Perspective

You can also use the  option, found next to the  tab at the bottom of the screen, to find specific reports (Figure 6).Report Filter Timeline

For help using the , see the  section.Report Filter Reports

Figure 6: Report Filters

  You can also configure your Daily Status Reports so that you can view them as emails. See the  argument in ? .users Daily Status Report Provider Arguments

Back to the top

Next Steps

Daily Status Report Provider Arguments
Different arguments you can use to customize your reports.

Understanding the Daily Status Report
What each section of the Daily Status Report means and how you can use it to improve your server.

Take me back to .FusionAnalytics Reporting

Daily Status Report Provider Arguments

Daily Status Report Provider Arguments



Argume
nt 
Name

Default 
Value

Description Example Values

date Previous 
day's date

 The date that the report will run for.

This will override the previous day's date that is automatically provided by the 
scheduled task.

The value must be a UTC time in milliseconds.

The value that is entered will be rounded to midnight (the start of the day) in the 
specified timezone and will become the end date of the report.

1312243200000 
(Report Date: 1st-

 2nd August GMT)

1310281200000  
(Report Date: 9th-

 10th August GMT)

https False  Defines if HTTP or HTTPS will be used.

HTTP / HTTPS is used for links and images.

The same setting will apply to reports that are emailed to users.

If the argument is not provided, HTTP is always used.

true

timezone DataCollector'
s timezone

Used to change the default timezone of the report.

This will change the start and end dates of the report to midnight in the specified 
timezone.

Any valid Java timezone can be used.

If the timezone is misspelt, it will revert back to the timezone of the DataCollector. 
See ?  for more information.Applications (FADC)

America/New_York 

Europe/Berlin 

GMT

users None  Used to email reports to the specified users.

Users  have an email address on their account. See ?must Users Summary (FADS)
 for more information. 

The Mail Server  also be configured. See ?  for more must Server Settings
information.

Multiple users can be added by separating the usernames with a comma (no 
space).

admin 

admin,user1,user2

Adding Provider Arguments

To add your Provider Arguments, you will need to go to the  in FADS and click the Application Tasks Summary Edit
button on the Daily Status Report task.

In the  section, you will see fields for the Name and Value (Figure 1).Provider Arguments

You can add multiple arguments by clicking  .Add New Argument

You can remove arguments by clicking  .

Click  when you have finished editing the task.Update Task

Figure 1: Adding Provider Arguments

Next Steps

Running a Daily Status Report
How to run a Daily Status Report and where to view it after it has run.

Understanding the Daily Status Report
What each section of the Daily Status Report means and how you can use it to improve your server.

Take me back to ? .FusionAnalytics Reporting

All of these arguments are optional
The reports will run without any of these arguments being provided, but they can be used to enhance your 
reports to suit your needs.



Understanding the Daily Status Report

Understanding the Daily Status Report

This page will help you to understand the data in your Daily Status Report. Please 
see the links to the right to jump to a particular section.

In the top right corner of the report you can find 2 links:

Link Name Description

View TAP 
Report

This is only displayed if there is also a TAP Report for the same 
DataCollector and date.

View in 
FusionAnalyt
ics

If you are viewing the report as an email, you can click this to take you 
directly to this application in FusionAnalytics.

This report uses arrow indicators to allow you to easily see if the performance of 
your server and improved or decreased.

Arrow 
Indicator

Description

 

A green arrow indicates a good change. 

In some cases a lower value is preferable, e.g. Average Request 
Execution Time.

 

A red arrow indicates a bad change. 

In some cases a higher value is not preferable, e.g. Average Memory 
Used.

 

A grey arrow indicates that the change is neither good nor bad. 

For example, the Average Requests Running uses this type of arrow.

This indicates no change between the current and previous values

On this page:

Overview

Performance Charts

System Load Statistics

Session Statistics

Slowest Requests

Slowest Requests on 
Average

Application Data 
Overview

Application JDBC 
Overview

Applications

Overview

The Overview header displays the following information (Figure 1):

Figure 1: Overview section header example

The table below gives an explanation of what each part of the header means:

Header 
Information

Description

DataCollector 
e.g. cfsrv-2

The DataCollector that the data belongs to.

Day 
e.g. Monday, 25 
July 2011

The date that the report is run for (from midnight to midnight of that day).

Time Zone The default time zone is the one set on the DataCollector. See ?  if you Daily Status Report Provider Arguments
want to change the time zone of the report.



Start The exact date and time that the data in the report starts from. It also includes the offset from UTC time (e.g. 
).+0200

End The exact date and time that the data in the report ends at. It also includes the offset from UTC time ( ).e.g. +0200

 Clicking on the Overview header will take you to the Overview perspective in the Web Client.

Overview contains the following sections:

Name Example Description

Total Requests Completed The total number of requests that 
have completed during the 24 hours. 

Min Requests Completed 
(Between Samples)

The smallest number of requests 
completed at sampled points 
throughout the 24 hours. 

Peak Requests Completed 
(Between Samples)

The largest number of requests 
completed at sampled points 
throughout the 24 hours.

Average Requests / Sec The average number of requests that 
are completed per second.

Min Requests / Sec The smallest number of requests that 
are completed per second.

Peak Requests / Sec The largest number of requests that 
are completed per second. 

Average Requests Running The average number of requests 
running at any time.

Average Request Execution 
Time (sec)

The average execution time. in 
seconds, of all requests in the 24 
hours.

Total JDBC Requests 
Completed

The total number of JDBC requests 
that have completed during the 24 
hours.

Min JDBC Requests Completed 
(Between Samples)

The smallest number of JDBC 
requests completed at sampled 
points throughout the 24 hours. 

Peak JDBC Requests 
Completed (Between Samples)

The largest number of JDBC 
requests completed at sampled 
points throughout the 24 hours. 

Average JDBC Requests / Sec



The average number of JDBC 
requests that are completed per 
second. 

Min JDBC Requests / Sec The smallest number of JDBC 
requests that are completed per 
second.

Peak JDBC Requests / Sec The largest number of requests that 
are completed per second. 

Average JDBC Request 
Execution Time (sec)

The average JDBC execution time, in 
seconds, of all requests in the 24 
hours. 

Back to the top

Performance Charts

The Performance Charts section contains the following:
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(click to enlarge)
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 Clicking on the Performance Charts header will take you to 
the Overview perspective in the Web Client.

Back to the top

System Load Statistics

The System Load Statistics section contains the following:

N
a
m
e

Example D
e
s
c
ri
p
ti
o
n 

Sy
st
e
m 
C
P
U 
Lo
ad 

A 
b
ar
gr
a
p
h 
s
h
o
wi
n
g 
th
e 
n
u
m
b
er
of
s
a
m
pl
e
s 

Example System Load Statistics

(click to enlarge)
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 Clicking on the System Load Statistics header will take you to 
the CPU/Memory Usage Chart perspective in the Web Client.

Back to the top

Session Statistics

The Session Statistics section contains the 
following:

Name Description

Unique 
Session IDs

The total number of unique 
session IDs used during that day. 

The arrow and percentage 
indicate the change between the 
values from today and yesterday. 

Unique 
ColdFusion 
IDs

The total number of unique 
ColdFusion IDs used during that 
day. 

The arrow and percentage 
indicate the change between the 
values from today and yesterday.

Request 
Count

The total number of requests 
during that day. 

The arrow and ?percentage 
indicate the change between the 
values from today and yesterday.

Average 
Requests per 
ColdFusion 
ID Token

The average number of requests 
that occurred for each ColdFusion 
ID

Average 
Requests per 
JSession ID

The average number of requests 
that occurred for each JSession 
ID

Server ID If there have been any server 
restarts, the server ID will be 
listed, with the Date/Time (see 
below).

Date / Time The time of any server restarts 
that have occurred during that 
day.

 Clicking on the Session Statistics header will 
take you to the Table of Requests perspective in 
the Web Client.

Back to the top

Example Session Statistics

(click to enlarge)

Slowest Requests

Slowest Requests contains the following sections:
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 Clicking on the Slowest Requests header will take you to the 
Slowest Rwquests perspective in the Web Client.

You can also click  to see more slow requests.Expand / Collapse

Back to the top



Slowest Requests on Average

Slowest Requests on Average contains the following section:
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(click to enlarge)



o
m
pl
et
e 
o
n 
a
v
er
a
g
e. 

Ex
ec
uti
on
Ti
m
e 
(s
ec
)

T
h
e 
a
v
er
a
g
e 
e
x
e
c
ut
io
n 
ti
m
e 
in
s
e
c
o
n
d
s 
fo
r 
e
a
c
h 
U
R
L. 

 Clicking on the Slowest Requests on Average header will take you 
to the Slowest Requests on Average (Grouped by URL) perspective in 
the Web Client.

You can also click  to see more slow requests.Expand / Collapse

Back to the top

Application Data Overview

Application Data Overview contains the following 
sections:

Name Example Description

Applicati
on Key

Each 
application 
filter that you 
define will be 
listed. 

To find out 
how to 
configure 
your own 
application 
filters, see ?
Manage 

.Applications

Example Application Data Overview

(click to enlarge)



Amount 
of Views

The total 
amount of 
times the 
pages within 
this filter 
have been 
viewed.

Average 
Executio
n Time 
(sec)

The average 
execution 
time in 
seconds for 
the requests 
within each 
application 
filter.

Total 
Executio
n Time

The total 
execution 
time for the 
requests 
within each 
application 
filter.

Average 
Bytes 
Sent

The average 
number of 
bytes for 
each 
application 
filter.

Total 
Bytes 
Sent

The total 
number of 
bytes sent 
for each 
application 
filter.

Unique 
Session 
IDs

The number 
of unique 
session IDs 
per 
application.

Unique 
ColdFusi
on IDs

The number 
of unique 
ColdFusion 
IDs per 
application.

Back to the top

Application JDBC Overview

Application JDBC Overview contains the following 
sections:

Name Example Description

Applic
ation 
Key

Each 
application 
filter that you 
define will be 
listed. 

To find out how 

Example Application JDBC Overview

(click to enlarge)



to configure 
your own 
application 
filters, see ?Ma
nage 

.Applications

Avera
ge 
JDBC 
Querie
s

The average 
number of 
database 
queries 
specifically 
from the 
requests within 
each 
application 
filter.

Totall 
JDBC 
Querie
s

The total 
number of 
database 
queries 
specifically 
from the 
requests within 
each 
application 
filter.

Avera
ge 
JDBC 
Time 
(sec)

The average 
database 
execution time 
in seconds for 
the requests 
within each 
application 
filter.

Total 
JDBC 
Time

The total time 
spent 
executing 
queries on a 
database for 
the requests 
within each 
application 
filter.

Avera
ge 
JDBC 
Rows

The average 
number of 
rows returned 
from the 
database for 
each 
application.

Total 
JDBC 
Rows

The total 
number of 
rows returned 
from the 
database for 
each 
application.

Back to the top

Applications

Applications contains the following sections:
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Also See

FusionAnalytics User's Guide
See the User's Guide for more information on the different parts of FusionAnalytics.

?Manage Applications
Visit this section for help configuring your own application filters.

Take me back to .FusionAnalytics Reporting

The Daily Status Report configuration page

THE DAILY STATUS REPORT CONFIGURATION

The Daily Status Reports come with a new report configuration feature will allows 
you to add email recipients to the report. This feature can be found within the 
FusionAnalytics Client.

There are two ways to access the client, either through a web browser (see The 
) or using our Air Dashboard (see FusionAnalytics Web Client The FusionAnalytics 

).AIR Client

Where to go from the client

Once you've accessed the client, you'll find a new ToC item under Administrator > 
Daily Status Report Configuration.

Clicking this will display the new configuration screen which may contain existing 
report configurations if some have previously been created.

On this page:

Adding a recipient 
from FADS users

Adding a custom 
email address

 

Adding email recipients.



This page allows you to configure who will receive the report via email.

There are two methods of adding recipients:

Adding a recipient from FADS users. Only users who are mapped are available to add with this method.

Adding a custom email address.

Adding a recipient from FADS users.

To add from FADS users, simply click the Add From Users button to view a list of viable FADS users and click the  button to add them to 
the recipients list.

Adding a custom email address

To add a custom email address, simply enter the email address and optional description into the corresponding fields and click the  
button.

SLA Reports

SLA REPORTS

OVERVIEW

The SLA Report provides business-level information on your server's 
performance.

You can choose to receive daily, weekly and monthly reports, compare to 
previous reports and even change the way the reports are displayed based on 
whether your server met your targets.

   



Find out more

Accessing the SLA Report Configuration Page
Where to find the new report configuration area.

Adding a new SLA Report Configuration
How to add new reports and configurations to your application.

The SLA Report Configuration
Understand what each of the configuration elements mean and how they should 
be used.

NEXT STEPS

Accessing the SLA Report Configuration Page

Adding a new SLA Report Configuration

The SLA Report Configuration

Report Configuration Tab

Email Recipients Tab

Domain Filters Tab

Thresholds Tab

Running the SLA Reports

Accessing the SLA Report Configuration Page

Accessing the SLA Report configuration page

The SLA Reports come with a new report configuration feature will allows you to 
change the way reports will behave. This feature can be found within the 
FusionAnalytics Client.

There are two ways to access the client, either through a web browser (see The 
) or using our Air Dashboard (see FusionAnalytics Web Client The FusionAnalytics 

).AIR Client

Where to go from the client

Once you've accessed the client, you'll find a new ToC item under Administrator > 
SLA Report Configuration.

Clicking this will display the new configuration screen which may contain existing 
report configurations if some have previously been created.

   

Next Steps

Adding a new SLA Report Configuration
Discover how to add new SLA report

The SLA Report Configuration
Learn what each of the configuration options mean and how to use them.

Take me back to  .FusionAnalytics Reporting

Adding a new SLA Report Configuration

ADDING A NEW SLA REPORT CONFIGURATION

There are a two ways you can add a report configuration:

Create a new configuration

Copy a configuration

Create a new configuration

If you are looking for a quick start guide for getting your SLA reports up 
and running as soon as possible, see Setting up the SLA Reports in the 

 Quick Start Guide guide.

#
#
#
#
#


Whether configurations already exist or not you will see the Add New Report section. Enter a suitable report name and press the "Add 
Report" button.

Report names cannot contain the following characters: ! # $ % ^ & * ( ) + = ~ ` [ ] \ ' ; , { } | " < > ?

Copy a configuration

If you already have an existing configuration, you can create a copy using the   button.

You will be prompted to enter a name for the new configuration. Again, names cannot use the characters shown above.

Once you have added a new report, the configuration options for it will be added to the page and automatically expanded for editing.

NEXT STEPS

The SLA Report Configuration
Learn what each of the configuration options mean and how to use them.

Report Configuration Tab
Choose from daily, weekly and monthly reports or any combination of the three, and customise how the reports will appear in your inbox.

Email Recipients Tab
Learn how to select who should receive the report via email.

Domain Filters Tab
Understand the different options that can be found on the Domain Filters tab.

Thresholds Tab
Configure your report to show you whether your server is performing correctly at a glance.

Take me back to  .FusionAnalytics Reporting

The SLA Report Configuration



THE SLA REPORT CONFIGURATION

The report configuration allows you to tweak the settings for each report. You can 
 as you like.add as many reports

Your reports will be listed on the page with their configuration options hidden:

Icon N
a
me

Description

E
dit

Opens the configuration 
options for this report to allow 
you to make changes.

R
en
a
me

Allows you to rename the 
report. Names cannot already 
exist, contain spaces or the 
characters ! # $ % ^ & * ( ) + = 
~ ` [ ] \ ' ; , { } | " < > ?.

C
opy

Creates a copy of this report 
with a new name of your 
choosing.

D
el
ete

Deletes this report.

  Other steps in this 
tutorial:

Accessing the SLA 
Report 
Configuration Page

Adding a new SLA 
Report Configuration

The SLA Report 
configuration

Report 
Configuratio
n Tab

Email 
Recipients 
Tab

Domain 
Filters Tab

Thresholds 
Tab

Running the 
SLA Reports

NEXT STEPS

Start configuring your SLA Reports: Report Configuration Tab
REPORT CONFIGURATION TAB

Report Configuration tab

This tab allows you to choose when you would like the report to run as well as 
some additional settings.

Schedule

Time 
period

Description

Daily Your report will run every day showing data from the previous day..

Weekly Checking this box will allow you to choose from 3 different week 
periods.

Weekdays (M, T, W, T, F)

Week starting Monday (M, T, W, T, F, S, S)

Week starting Sunday (S, M, T, W, T, F, S)
Your report will run every week showing data for the previous 
week based on the type you selected.

Monthly Your report will run on the 1st of each month showing data from 
the entire previous month.

Email Prefixes

These settings allow you to change the email subject that will be displayed in your 
recipients inbox.

The default subject is: "[fusionanalytics] [timeframe] SLA Report for 
[Report_Name] ([DataCollector_Name]) from [Date].

For this example, our default title would look like:

  On this page:

Schedule

Email Prefixes

Other steps in this 
tutorial:

Accessing the SLA 
Report 
Configuration Page

Adding a new SLA 
Report Configuration

The SLA Report 
Configuration

Report 
Configuratio
n Tab

Email 
Recipients 
Tab

Domain 
Filters Tab

Thresholds 
Tab

Running the 
SLA Reports

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Custom email title

This setting allows you to replace the text "SLA Report for DemoReport" in the 
email subject.

Successful Report

A report is considered successful if all targets were met. If the report is 
successful, this value will directly follow [fusionanalytics] in the email subject.

Failed Report

A report is considered failed if one or more targets were not met. If the report has 
failed, this value will directly follow [fusionanalytics] in the email subject.

 

This is an example of how these settings will effect the title we were 
getting before on a failed report:

Next Steps

Configure who will receive the reports via email: Email Recipients Tab
EMAIL RECIPIENTS TAB

Email Recipients tab

This tab allows you to configure who will receive the report via email.

There are two methods of adding recipients:

Adding a recipient from FADS users. Only users who are mapped are 
available to add with this method.

Adding a custom email address.

Adding a recipient from FADS users.

To add from FADS users, simply click the Add From Users button to view a list of 
viable FADS users and click the  button to add them to the recipients list.

Adding a custom email address

To add a custom email address, simply enter the email address and optional 
description into the corresponding fields and click the  button.

 

  On this page:

Adding a recipient 
from FADS users

Adding a custom 
email address

Other steps in this 
tutorial:

Accessing the SLA 
Report 
Configuration Page

Adding a new SLA 
Report Configuration

The SLA Report 
Configuration

Report 
Configuratio
n Tab

Email 
Recipients 
Tab

Domain 
Filters Tab

Thresholds 
Tab

Running the 
SLA Reports

[fusionanalytics] Daily SLA Report for DemoReport (cfsrv-2) from 
Monday, 12  March 2012

[fusionanalytics] (Fail) Daily Demonstration report for 
documentation (faDataCollector-1) from Monday, 12 
March 2012

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


Next Steps

Select which domains should be included or excluded on your report: Domain Filters Tab
DOMAIN FILTERS TAB

Domain Filters Tab

The SLA report shows request information for all domains by default. This tab 
allows you to only show information for specific domains, or show information for 
all domains except the ones you choose.

Filter Type

M
e
t
h
od

Description

In
cl
u
de

Selecting this option will  show information on the report for only
domains you add to the list. Any others will be ignored. If you add 
incorrect domains or domains that receive no requests to the list they 
will also be displayed on the report.

E
x
cl
u
de

Selecting this option will show all domains on the report the except 
domains you added to the list.

Example

Assume our server takes requests on the following domains:

domain1.intergral.com

domain2.intergral.com

domain3.intergral.com
We might want to configure one report to display all of this information, and 
another that only contains information on "domain1.intergral.com" and "domain2.
intergral.com". For this we would choose the "Include" option and add our 
domains to the list.

Now only information for those two domains would be visible on the report.

  On this page:

Filter Type

Example

Other steps in this 
tutorial:

Accessing the SLA 
Report 
Configuration Page

Adding a new SLA 
Report Configuration

The SLA Report 
Configuration

Report 
Configuratio
n Tab

Email 
Recipients 
Tab

Domain 
Filters Tab

Thresholds 
Tab

Running the 
SLA Reports

Next Steps

Set threshold targets to define successful and failed reports: Thresholds Tab
THRESHOLDS TAB

Thresholds Tab

Thresholds tab

This tab allows you to set target thresholds for your SLA report. These targets will 
be used to determine whether your report was successful or not and will alter the 
appearance of the report.

Name D
ef
a
ul
t 
V
al
ue

Ena
ble
d 
By 
Def
ault

Description

Uptime 10 Yes This allows you to set the minimum uptime allowed before your 

  Other steps in this 
tutorial:

Accessing the SLA 
Report 
Configuration Page

Adding a new SLA 
Report Configuration

The SLA Report 
Configuration

Report 
Configuratio
n Tab

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#


1.  

2.  

0% report is flagged as failed.

Outag
es

0 Yes This is the number of times your server can go offline before 
your report is flagged as failed. This value is per-day, so it will 
be multiplied for the number of days the report runs.

Example: If your outages target is 0 and you run a 7-day 
report, your target for that report will be 7 outages.

Total 
Reque
sts

0 No The minimum number of requests on your server before this 
report is flagged as failed. This is not enabled by default. This 
value is per-day, so it will be multiplied for the number of days 
the report runs.
Example: If your outages target is 0 and you run a 7-day 
report, your target for that report will be 7 outages.

Avera
ge 
Page 
Perfor
mance

10
00
ms

Yes If the average request execution time is longer than the 
specified value your report will be flagged as failed.

Email 
Recipients 
Tab

Domain 
Filters Tab

Thresholds 
Tab

Running the 
SLA Reports

Running the SLA Reports

RUNNING THE SLA REPORTS

By default, the SLA Report will run at 4:00am every morning. There are two steps 
involved with this:

FusionAnalytics will generate all the data required for the reports that are 
going to run.

The SLA reports will be generated and the emails will be sent.

Depending on the size of your database and the type of report that will run (daily, 
weekly, monthly) the data generation process can take a long time. Once this has 
run however, reports should run instantly if you choose to re-run them.

Re-running a report manually

Running the SLA Report Task manually will cause all configured SLA reports for 
that application to be emailed again. This can be useful when you are creating 
new report configurations and would like to see how they will appear in your inbox.

To run the report task manually, log into  FusionAnalytics DataServices (FADS)
and navigate to Scheduled Tasks > Application Tasks Summary. Here you'll see 
a list of tasks for your applications including the "SLA Report" task.

Clicking the "Run Now" button will force the task to run. If the task has already run 
that day then the process should be almost instant. You can tell the task is 
finished when the status changes from "Running" to "Scheduled".

If you have  correctly they should now be waiting in your configured your reports
inbox.

Changing when the report automatically runs

You can change the default scheduled time of 4:00am from the same page. 
Simply click the Edit button for the "SLA Report" task for your application to be 
presented with the task scheduler:

  On this page:

Re-running a report 
manually

Changing when the 
report automatically 
runs

NEXT STEPS

Do not change any other settings!
The report task must run every day to ensure the correct data is 
generated. This schedule page was designed for non-configurable 
reports. If you wish to disable the SLA Report emails simply uncheck 
the schedule options in the client configuration. See Report 

.Configuration Tab

#
#
#
#
#
#
#
#
#
#
#


Having trouble receiving SLA Reports via email? See SLA Report FAQ

Using FusionAnalytics to analyze a cluster of servers / instances

Clusters

The user now has the ability to group their servers together into a ' '. This will allow you to easily Cluster
compare the performance of each independent cluster member, and identify which member is causing 
problems.
You can also see the average performance of the entire cluster itself to get a general idea of how the 
cluster is performing. 

Any number of servers, and any combination of servers, can be added to a cluster at any time.
There is no limit on how many clusters can be configured.

Configuring a Cluster

Once you have accessed the client, you'll find a new ToC item under Administrator > Manage Clusters.

Clicking this will display the new configuration screen which may contain existing cluster configurations if 
some have previously been created.

Your existing clusters will be listed with their configuration options hidden.

Icon N
a
me

Description

E
dit

Opens the configuration options for this cluster to allow 
you to make changes.

R
en
a
me

Allows you to rename the cluster. Names cannot 
already exist, contain spaces or the characters ! # $ % 
^ & * ( ) + = ~ ` [ ] \ ' ; , { } | " < > ?.

C
opy

Creates a copy of this cluster with a new name of your 
choosing.

D
el
ete

Deletes this cluster.

ADDING A NEW CLUSTER

You can add as many clusters as you like.

There are a two ways you can add a report configuration:

Create a new configuration

Copy a configuration

Create a new configuration

On this 
page:

Configurin
g a Cluster

Adding a 
new 
Cluster

Configurati
on Options

#


Whether configurations already exist or not you will see the Add New Cluster section. Enter a suitable 
cluster name and description(optional) and then press the "Add Cluster" button.

Cluster names cannot contain the following characters: ! # $ % ^ & * ( ) + = ~ ` [ ] \ ' ; , { } | " < > ?
You cannot use a name if a cluster already exists with that name. 

Copy a configuration

If you already have an existing cluster configured, you can create a copy using the   button.

You will be prompted to enter a name for the new configuration. Again, names cannot use the characters 
shown above, and cannot match the name of an existing cluster.

 

 

CONFIGURATION OPTIONS

The following page is displayed when adding a new cluster or when clicking the  icon.

 

The Servers tab allows you to choose which servers you want to be included in the cluster. Any existing 
servers will appear in the drop down box.

To add a server to the cluster simply select it from this drop down box and add it using the  button. 
Adding a description is optional.
The server will then appear in the table underneath and will be saved to your cluster. You can add any 
number of existing servers to a cluster at any time.

To remove a server from the cluster, simply click the   button in the table, next to the server you wish to 
remove. You can remove a server from the cluster at any time.

Next Steps

Cluster Perspectives 
Learn about the new types of perspectives and where to find them. 

Cluster Perspectives

Cluster Perspectives
 

CHANGES TO THE TOC

There have been some minor changes to the ToC to accommodate clusters. You will now 
see that there is a cluster folder at the top.
The folders for the individual servers(e.g. fa-DataCollector-1) and all their sub-folders have 
now been moved into a folder named "Servers" . This is a simplified, easier to understand, 
layout for the ToC.
If a cluster has been added, but it contains no servers, the message "No Servers" will be 
displayed next to the folder, and you will be prompted to the "Manage Clusters" page so 
that you can add servers.

 

When a cluster has been set up, you can access all the usual perspectives that are 
included in the Server folders, by expanding the Cluster folder from the ToC.
The perspectives are ordered in the same way, with the same folder structure as in 
Servers.

 

Before you are able to use functionality of clusters, you must set up the cluster 
correctly. See  . Setting Up A Cluster

#


NEW VIEWS

The cluster perspectives are based off the same perspectives in the Server folders. I.e. 
Slowest Requests for Clusters, works in the same way as Slowest Requests for Servers, 
but it displays data for all the servers in the Cluster.

There are two basic types of view within the cluster perspectives. These are the Server 
 and the Comparison View Cluster View

Server Comparison View

In a server comparison view, the data from one of the servers in the cluster is taken and 
displayed directly alongside the data from the other servers in the cluster.
This allows the user to directly compare the performance of each of the servers that are 
included in the cluster.
In data grids, such as 'Slowest Requests'(figure 1), the Server Comparison Views have an 
extra column which displays the  . This is so that you can see which server Server Name
any particular data entry comes from.

Figure 1:  Server Comparison Example. Shows the Slowest Request perspective for a 
cluster. You can see which server had the slowest request of the day.

 

In Graphs, such as 'Memory Usage', the Server Comparison Views are displayed as a line 
graph where each line (or 'series') represents the data from one particular server.
For example, in Memory Usage, the 'Used Memory %'  for all servers is displayed on the 
same line graph. In Fig.2 you can see that the data for server 1 is displayed as the blue 
line, 
and the data for server 2 is displayed as the orange line. In this example, both servers are 
performing equally. 

Figure 2:  Server Comparison Example. Shows the Used Memory(%) graph from the 
Memory Usage perspective for a cluster. 

 

Cluster Views

The cluster view is used when the data for the cluster is an aggregate rather than specific 
to a server. For some perspectives the data needs to be averaged, such as "Slowest 
Requests On Average", where execution times of the requests need to be averaged across 
the entire cluster.
We call these cases ' '. An example is given in Fig.3, in which you can see Cluster Views
the cluster data for Slowest Requests On Average

Figure 3: Cluster View example. Showing the Slowest Requests On Average perspective 
for a cluster.

 

In Fig.3, you can see that the perspective looks the same as the perspective in Servers. 
The same columns are displayed, however, this is a cluster view, so in this case the Reque'
st Count  for a particular request '
is summed up for all servers in the cluster. The Exec Time is taken as an average across ' '  
all the servers in the cluster.

Below is an example of  a cluster view for graphs. Again this appears the same as the 
perspective for Servers, however, the data for each series is taken as either an average or 
a sum across all the servers in the cluster.

  Cluster View example. Shows the Request and JDBC Execution Time Figure 4: 
perspective for a cluster.

FAQs



Frequently Asked Questions (FAQ) for FusionAnalytics

Overview

This section will include Frequently Asked Questions (FAQs) for the different sections on 
FusionAnalytics.

FAQ Sections

GENERAL FAQ

SERVER FAQ

DATACOLLECTOR FAQ

FUSIONANALYTICS APPLICATION FAQ

DESKTOP CLIENT FAQ

LICENSING FAQ

SLA REPORT FAQ

 

General FAQ

General FAQ
 

What's the difference between FusionReactor and FusionAnalytics?

Do I need FusionReactor to be able to use FusionAnalytics?

Do I need a separate database for FusionAnalytics?

Which Version and Edition of FusionReactor does FusionAnalytics 
require?

Should I have a separate server for FusionAnalytics?

How can I evaluate FusionAnalytics?

Does the edition of Adobe ColdFusion I have effect whether or not I can 
use FusionAnalytics?

How can I find more help on FusionAnalytics?

Which levels of support services do you offer for FusionAnalytics?

How do I find the size of the database?

WHAT'S THE DIFFERENCE BETWEEN FUSIONREACTOR AND FUSIONANALYTICS?

FusionReactor is a professional server monitor, it captures metrics 
(instrumentation) as the server is running and it is able to store many requests 
online for an immediate diagnostic view about the health of your server, but it is 
not able to provide information about long-term data - this keeps FusionReactor 
compact and ensures that overhead is kept to an absolute minimum. 
FusionAnalytics is a visual tool for analyzing the data which has been provided 
by FusionReactor. FusionAnalytics loads the extensive log file data captured by 
FusionReactor into the FusionAnalytics DB. It then provides numerous graphs, 
charts, tables and reports, to visualize the data. FusionAnalytics is all about 
"Making IT Better" and giving you the information and data to help you make 
better business decisions, improve application performance and quality of your 
applications as well as measure exactly how your applications are performing on 
a continuous day to day basis.

DO I NEED FUSIONREACTOR TO BE ABLE TO USE FUSIONANALYTICS?

Yes – FusionAnalytics relies on the metric (log) files which have been generated 
from FusionReactor.

DO I NEED A SEPARATE DATABASE FOR FUSIONANALYTICS?

   

This page is currently growing and FAQ's will be continually added to this section 
of the Documentation as they come in.



Yes – FusionAnalytics relies on using a separate database.    For information on 
supported databases - please refer to our  page.system requirements

WHICH VERSION AND EDITION OF FUSIONREACTOR DOES FUSIONANALYTICS REQUIRE?

FusionAnalytics works with both the Standard and Enterprise versions of Fusion
 and above.Reactor 4

SHOULD I HAVE A SEPARATE SERVER FOR FUSIONANALYTICS?

Yes – FusionAnalytics analyzes your historical monitoring data. The amount of 
data you collect and the processing required to 'crunch' this information can be 
high (depending on how busy your target platform is). For this reason, we 
recommend installing FusionAnalytics on a separate machine. View more 
information about hardware requirements on our  page.system requirements

HOW CAN I EVALUATE FUSIONANALYTICS?

We offer a free trial of FusionAnalytics. After 30 days, the Trial simply  30-DAY 
disables itself, without the need to uninstall it. Evaluators can turn the Trial into 
any full version by entering a valid license key without reinstalling the software.

DOES THE EDITION OF ADOBE COLDFUSION I HAVE EFFECT WHETHER OR NOT I CAN USE 
FUSIONANALYTICS?

Indirectly. FusionAnalytics relies on FusionReactor 4 or above – FusionReactor 
works with ColdFusion 6, 7, 8, 9 and 10 You can purchase either the 
FusionReactor Enterprise or Standard Edition, regardless of which version of 
ColdFusion you currently wish to monitor.

HOW CAN I FIND MORE HELP ON FUSIONANALYTICS?

We offer a wide range of resources and documentation on the FusionAnalytics 
product. As well as this online documentation, you can also refer to our website s

 area which contains our Knowledge Base and links to Google groups.upport

WHICH LEVELS OF SUPPORT SERVICES DO YOU OFFER FOR FUSIONANALYTICS?

Documentation, tutorials, knowledge base and our Google groups are available 
for free to help you get up and running. Additionally, we offer a Quick Start Install

 package - in this case one of our trained engineers will install & configure ation
FusionAnalytics for you. This is the fastest, hassle-free way to get 
FusionAnalytics installed. We also offer  which is a paid Fusion Premium Support
support option and can be purchased on an incident by incident basis. We also 
provide professional onsite and remote  if you ColdFusion Consulting Services
have serious CF problems which you need detail assistance with. Take a look at 
our Support Area for a complete overview.

HOW DO I FIND THE SIZE OF THE DATABASE?

In FusionAnalytics the size of the database is displayed on the Application Detail 
page under the Database Details section.

Alternatively you can display the size of the database in the Microsoft SQL 
Server Management Studio by selecting the FA database and choosing Proper

 from the context menu.ties

Back to the top

 

 

Server FAQ

Server FAQ

CAN I RUN MY OWN WEBAPPS IN FUSIONANALYTICS?    

http://docs.intergral.com/display/FA20/System+Requirements
http://docs.intergral.com/display/FA20/System+Requirements
http://www.fusion-analytics.com/fa/support.cfm
http://www.fusion-analytics.com/fa/support.cfm
http://www.fusion-analytics.com/support/install_configuration.cfm
http://www.fusion-analytics.com/support/install_configuration.cfm
http://www.fusion-analytics.com/support/productsupport.cfm
http://www.fusion-analytics.com/support/services/coldfusionconsulting.cfm
http://www.fusion-analytics.com/fr/support.cfm


FusionAnalytics consists of two webapps: and Data Services (FADS) Data 
. These run within a Tomcat application server as separate Collector (FADC)

webapps. Although Tomcat doesn't restrict how many webapps can be run within 
one container, we do not support adding any further webapps to this Tomcat 
instance.

WE ALREADY HAVE A STANDARD J2EE CONTAINER, CAN I RUN FUSIONANALYTICS IN THAT?

No; the only supported container for FusionAnalytics is the one that we ship with 
the installer. All other containers and versions are unsupported.

HOW DO I INCREASE THE MEMORY USED BY FUSIONANALYTICS?

To change the VM memory settings for the FusionAnalytics Server do the 
following:

1. Stop the FusionAnalytics Service
2. Backup \FusionAnalytics\Server\bin\FusionAnalytics Server.
vmoptions
3. Edit \FusionAnalytics\Server\bin\FusionAnalytics Server.
vmoptions

Edit the line:

-Xmx768m

and increase the memory for example to 1GB (if the server has the memory 
available).

-Xmx1024m

4. Start the FusionAnalytics Service

See also: .Windows Service Configuration

WHAT SPECIFICATION SERVER DOES FA REQUIRE?

DataServices: FADS operates an asynchronous message service to deal with 
requests from clients. The faster the system, the faster responses will be 
processed and delivered to the client systems. Memory is required to perform 
analytics on data sets (although as much of this as possible is offloaded to the 
database) and to prepare and transfer analytics to the client.

DataCollector: FADC benefits most of fast disk I/O as it's main task is to read 
files from the file system, parse and import them to the database. The database 
should be best located on a dedicated computer and not on the same machine as 
FADC.

For more information on FusionAnalytics System Requirements, click . here

 

CAN I RUN FUSIONANALYTICS ON AMAZON EC2?

Yes, you will be able to run FusionAnalytics Server on Amazon EC2, however, 
you should be aware of matching the Amazon EC2 instance to your application 
on FusionAnalytics, as well as Amazon's pricing policies for EC2 before 
attempting to set up any instances.

Please refer to our Amazon EC2  page for more test system guidelines
information.

 

Back to the top

 

When would I do this?
Typically you do not have to alter the default settings. However, if you 
manually increase the number of import threads, the JVM could run out 
of memory. We have tested bulk imports of data consisting of more 
than 250000 files with more than 60GB in size without any problems.

http://docs.intergral.com/display/FA20/System+Requirements


DataCollector FAQ

DataCollector FAQ
What is the DataCollector ?

What is DCML?

WHAT IS THE DATACOLLECTOR ?

The FusionAnalytics DataCollector (FADC) provides high speed import of 
arbitrary log files into a SQL database so that the resulting data can be 
processed by the FusionAnalytics Server and visualized by the FusionAnalytics 
Client. FADC uses applications to model different usage scenarios. An 
application is typically made up of a DCML file and a set of auxiliary Groovy and
/or BeanShell scripts, optionally accompanied by further classes or JAR files (e.
g. JDBC drivers).

WHAT IS DCML?

DCML is the abbreviation of  DataCollector Markup Language. A DCML file is 
used to define how a FADC application works. See  for more DCML (FADC)
information.

Back to the top

 

   

 

FusionAnalytics Application FAQ

FusionAnalytics Application FAQ
Why can't I reinstall a FusionAnalytics DataServices application with the 
same name?

In FADS, What is the "Controllers" page for? What about "Asynchronous 
Jobs"?

WHY CAN'T I REINSTALL A FUSIONANALYTICS DATASERVICES APPLICATION WITH THE 
SAME NAME?

Due to the way Java locks files, when you uninstall a FADS application, the actual 
files may not be immediately deleted. On some operating systems, the files are 
locked until the server stops. In this case, FADS will delete them when the server 
restarts. Until this deletion occurs, FADS won't allow you to install another 
application with the same name. If you require the application to have the same 
name as a deleted application, restart the service to ensure the files are actually 
deleted. You should then be able to add the application under the required name.

IN FADS, WHAT IS THE "CONTROLLERS" PAGE FOR? WHAT ABOUT "ASYNCHRONOUS 
JOBS"?

The Controllers page details all the modules which make up DataServices. Some 
modules have optional operations (e.g. Dump, Clear etc.). These are intended for 
debugging purposes, should you need to get in touch with support. You'll be 
directed to use these operations as required for troubleshooting.

The Asynchronous Jobs page shows the last few requests that clients made for 
analytical datasets. Again, this is used for troubleshooting. A non-zero value for 
"cancelled" is normal, but a non-zero value for "Failed" might indicate an issue 
processing requests from clients. 

 

Back to the top

   

Desktop Client FAQ

Desktop Client FAQ



What is the Desktop Client ?

Do I need to install the AIR Client to use FusionAnalyitics ?

Do I need Adobe AIR to run the Desktop Client ?

How do I get the Desktop Application ?

How do I add an application to the FA Desktop Application ?

How do I login to an FA application from the AIR Desktop ?

What is an alternative to using the Desktop Client ?

WHAT IS THE DESKTOP CLIENT ?

The Desktop Client enables the FusionAnalytics Web / Browser Client to be taken, installed and ran on the users Desktop. The Desktop Client is a cross platform 
application that is built using (and ran inside of) Adobe AIR, therefore it is required that the AIR runtime is installed.

Provided that the AIR runtime has been successfully installed, the Desktop Client can be installed trouble free as all files go into the application directory.

The main advantage of using the Desktop Client is that you can quickly open and access FusionAnalytics applications and analyze data from the desktop eliminating the 
the need of the browser. The Desktop client has access to the local computer, e.g. access to local storage allowing multiple applications to be saved and loaded from the 
client.
Back to the top

DO I NEED TO INSTALL THE AIR CLIENT TO USE FUSIONANALYITICS ?

No - the AIR Client is not a mandatory install component. You can always access FusionAnalytics from the browser interface ( ), irrespective of whether you Web Client
have the AIR client installed or not. All the same, we do recommend that you download and install the .FusionAnalytics AIR Client

NoteL In this case, you will also need to download the  if you've not already got it installed.Adobe AIR Runtime
Back to the top
 

DO I NEED ADOBE AIR TO RUN THE DESKTOP CLIENT ?

Yes. The Desktop Client is built with and runs inside of Adobe AIR, therefore it is required that the Adobe AIR runtime has been installed before the Desktop Application 
can be used.

The Adobe AIR runtime can be downloaded from the . Once AIR has been downloaded, simply run the installer to install the runtime.Adobe Air website

Supported from version 2.7 onwards

Visit  for more informationthe Adobe website

Back to the top

HOW DO I GET THE DESKTOP APPLICATION ?

If you have not already got a copy of the FusionAnalytics Desktop Client, It is available to download from our .website

Note: Before the Desktop Application can be installed the  must also be installed.Adobe Air runtime
Back to the top

HOW DO I ADD AN APPLICATION TO THE FA DESKTOP APPLICATION ?

When the Desktop Client is first loaded, an address bar (URL input box) is positioned at the top of the screen (similar to the layout of a web browser). This address bar 
can be used to add applications to the client as URLs are used to identify and connect to applications.

The FusionAnalytics Application URL's use the following pattern: http://127.0.0.1:8400/fads/myFADSApplicationName

This is broken down as follows:

URL Element Description

http:// HTTP is the default. See the tutorial on  for secure connections.Setting Up FusionAnalytics with HTTPS

127.0.0.1 The machine where FusionAnalytics Server is installed. This example uses the local machine, so the address is 127.0.0.1.

8400 The machine port. If you changed the default port during the installation, use that instead; if not, use the default (8400).

Download for free: Latest version of Adobe AIR

#
http://www.fusion-analytics.com/fa/downloads.cfm
http://get.adobe.com/air/
http://get.adobe.com/air/
http://www.adobe.com/products/air/
http://docs.intergral.com/: http:/www.fusion-analytics.com/fa/downloads.cfm
http://get.adobe.com/air/
http://127.0.0.1:8400/fads/myFADSApplicationName
http://get.adobe.com/air/


/fads The fixed path to DataServices.

/myFADSApplicationN
ame

The name of the DataServices application you want to connect to. If you used the suggested name from the , this will installation guide
be coldfusion9.

Once the application URL has been entered into the address bar click Add Application button. The application will be added and a shortcut will be created (Figure 1):

 

Figure 1: AIR Client Shortcuts 

For more information about adding applications to the Desktop Client see: .Setting Up the AIR Client
Back to the top

HOW DO I LOGIN TO AN FA APPLICATION FROM THE AIR DESKTOP ?

After an application(s) has been added to the Desktop Client the application shortcuts (application icons) can be selected. Simply double click an application shortcut to 
open up the login screen for the selected application (Figure 2):

#


 

Figure 2: Login Screen 

At the login page, you can enter the relevant username and password for the selected application and click the login button. If the correct credentials have been entered 
and the application has been started the application will be logged into successfully.
For more information about logging into applications from the Desktop Client see: Setting Up the AIR Client.

Back to the top

WHAT IS AN ALTERNATIVE TO USING THE DESKTOP CLIENT ?

If you do not have an AIR client available, you can also access the client in your web browser. The same URL can be entered into the address bar or you can log into Fusi
 and click Launch on the application that you want to view.onAnalytics DataServices (FADS)

Back to the top
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Licensing FAQ
What is a product family?

What are "constraints" in a FusionAnalytics license?

What is a user (as a license constraint)?

What is a DataCollector (as a license constraint)?

What is an Application (as a license constraint)?

I tried to activate my license and was told I have no activations remaining

I didn't activate my license in time and the activation period has expired. 
Have I lost my configurations?

My license expires soon. Can I purchase another activation for it?

I need a bigger license. Do I have to purchase a new one?

Can I install two licenses for the same product family?

WHAT IS A PRODUCT FAMILY?

A product family is a "group" to which applications and DataCollectors can belong 
to. For example, the product family of the application that comes with 
FusionAnalytics is "FA4FR" a.k.a "FusionAnalytics for FusionReactor". This 
product family is covered by a single license. If you wish to use applications 
belonging to a different product family, you must also install a license for that 
family. With the first release of Analytics only the "FusionAnalytics for 
FusionReactor" application is supported.

WHAT ARE "CONSTRAINTS" IN A FUSIONANALYTICS LICENSE?

FusionAnalytics licenses are divided into 3 parts:

Users

Applications

DataCollectors

Each license is for a single product family.

WHAT IS A USER (AS A LICENSE CONSTRAINT)?

The user constraint only refers to FADS. The single user in FADC has nothing to 
do with licensing.

In FADS, you may add as many users as you wish. In order for this user to do 
anything, he must be mapped to a product family. When mapped to 1 or more 
applications for a family, the user is then considered a user of that product family.

In other words, whether mapped to 1 or 10 FA4FR applications, a user is 
considered a single user of that product family and only counts for 1 user on your 
license.

WHAT IS A DATACOLLECTOR (AS A LICENSE CONSTRAINT)?

DataCollectors are only used in FADC. They are not used anywhere in FADS.

When you add additional DataCollectors to a FADC application, it is counted as a 
DataCollector from your license. If you add a new FADC application, by default it 
will have 1 DataCollector, so while you are allowed an unlimited number of FADC 
applications, if you have reached your limit of DataCollectors you will be not be 
able to upload another app (this does not effect FADS applications).

WHAT IS AN APPLICATION (AS A LICENSE CONSTRAINT)?

The application constraint only refers to FADS applications. FADC applications do 
not effect this constraint.

Whenever you upload an application to FADS it counts as 1 application on your 
license for its product family. If you have reached your limit of applications for that 
family you will not be able to upload another one.

I TRIED TO ACTIVATE MY LICENSE AND WAS TOLD I HAVE NO ACTIVATIONS REMAINING

   



If you see this message, it means you have already installed this license on the 
number of machines it is valid for.

In order to check the number of activations left for that license key, navigate to 
the FADC or the FADS application and go to  There you System > License Info.
will be able to see the section indicating the remaining DataCollector, Applications 
and Users. If you want a bigger license key, more information about pricing can 
be found   or if you want to use the same license key, then you must here uninstall

.the license from another machine before you can use it again

More information about the license activation and license deactivation can be 
found in the links below.

Installing a valid License Key

Uninstalling a FusionAnalytics License Key

I DIDN'T ACTIVATE MY LICENSE IN TIME AND THE ACTIVATION PERIOD HAS EXPIRED. HAVE I 
LOST MY CONFIGURATIONS?

If your activation period expires there is no need to worry. Simply activate the 
license and your users, applications and DataCollectors will function as they did 
before.

MY LICENSE EXPIRES SOON. CAN I PURCHASE ANOTHER ACTIVATION FOR IT?

If your license is going to expire soon you must purchase a new license. When 
you install it everything will function as it did before.

I NEED A BIGGER LICENSE. DO I HAVE TO PURCHASE A NEW ONE?

If you need a bigger license, please contact us and we will help you upgrade. You 
will only have to pay the price of the upgrade, not the full price of a new bigger 
license.

CAN I INSTALL TWO LICENSES FOR THE SAME PRODUCT FAMILY?

You cannot install two licenses for the same product family. You must upgrade 
your license if your current one is too small.

Back to the top

SLA Report FAQ

SLA Report FAQ

Why am I not receiving SLA reports via email?

Why can't I see my FADS users in the report configuration?

Why can't I see my SLA Reports in the reports perspective of the client?

WHY AM I NOT RECEIVING SLA REPORTS VIA EMAIL?

If you are not receiving your reports via email as expected, please make sure you 
have configured the following settings:

Added email server details to FADS on the   page.Server Settings

Added a new report configuration. See Adding a new SLA Report 
.Configuration

Selected an appropriate time period to run the report. Daily reports are a 
good way to test your settings as these will always run. See Report 

.Configuration Tab

Configured the recipients for this report. See  .Email Recipients Tab

Once you have configured the steps above, try   manually running the report task
to see if you receive the emails.

 

WHY CAN'T I SEE MY FADS USERS IN THE REPORT CONFIGURATION?

   

http://www.fusion-analytics.com/pricing/
http://docs.intergral.com/display/FA207/Installing+your+license
http://docs.intergral.com/display/FA206/Uninstall+a+FusionAnalytics+License+Key


For security reasons, the report configuration will only display users who are 
mapped to the application being edited. You can find out how to map your users h

.ere

WHY CAN'T I SEE MY SLA REPORTS IN THE REPORTS PERSPECTIVE OF THE CLIENT?

SLA Reports are not currently supported in the reports perspective due to the 
introduction of the new report configuration feature. This will be added at a future 
date.

 

 

Feedback and Support

Feedback and Support

We welcome feedback on all our products and publications. To discover the 
various ways of contacting us, please use our . We will address your contact page
feedback as quickly as possible.

Back to the top

Known Issues

Introduction

This section lists   to some of the common known problems encountered using the latest version of FusionAnalytics. You can answers
also find support information, updates and articles at the   or go straight to the   located there.FusionAnalytics Website FAQ

Common Issues

NOT A VALID LICENSE FILE

One of the most common issues with the latest version of FusionAnalytics is the license key activation. If you are not able to activate a 
valid license key and you get the error message " " , the section below will provide you with a couple of possible Not a valid license file
fixes.

Possible Fixes

Make sure that a   or a   is not blocking the license activation process.Firewall configuration policy

Make sure that an anti-virus software running in your system is allowing you to completely   the FusionAnalytics directory exclude
and  peeking into the web requests of the JVM process associated to FusionAnalytics. exclude

Make sure that the hash value of the license key is not changed. There are a number of open source tools that can be used for 
that purpose.

For additional support information and material please see the Support 
 section of the FusionAnalytics website./ Knowledge Base

Additionally you can refer to the  for FusionAnalytics Google Groups
further support and information.

http://www.fusion-reactor.com/contact.html
http://www.fusion-analytics.com/support/
http://www.fusion-analytics.com/faq/
http://www.fusion-analytics.com/fa/support.cfm
http://www.fusion-analytics.com/fa/support.cfm
http://groups.google.com/group/fusionanalytics


1.  

a.  

2.  
a.  

3.  

1.  

2.  

3.  

If you are still unable to activate a valid license key, please contact the FusionReactor Support Team in the following email address: supp
 for more information.ort@fusion-reactor.com

MANUAL LICENSE ACTIVATION IS FALLING

Another common issue is related to the manual license activation of FusionAnalytics. If the server running FusionAnalytics is not 
connected to the Internet,  you will be taken to the manual activation page.

Possible Fixes

Make sure that a   or a   is not blocking the license activation process.Firewall configuration policy

Make sure that an anti-virus software running in your system is not blocking the license activation process.

Make sure that you have copied the whole License activation key string from the Manual License Activation page of 
FusionAnalytics.

Make sure that you have press the " " button.Activate License

More information about the Manual License activation can be found here,  .Manual License activation

NOT RECEIVING THE TAP/SAP/DAILY REPORT

There are many reason why you are not able to receive any reports from FusionAnalytics. The most common is that the mail server 
configuration in FusionAnalytics is not correct or the configured email is not correct.

Unfortunately, there is no way to test the mail server in FusionAnalytics however, there a a number of things that you can check in order 
to make sure that your configuration is correct.

More information about the things you can check can be found in the documentation below and in section "Why am I not 
receiving SLA reports via email?"

http://docs.intergral.com/display/FA207/SLA+Report+FAQ

Additionally, you can try to re-run the reports manually. For more information please check out the link below.
http://docs.intergral.com/display/FA207/Running+the+SLA+Reports

Another way to test the mail server is by "abusing" the Disk Usage check in the FADC application. For example, this can be 
achieved by temporary changing a value that will always create/send an email alert. More information about the Disk Usage 
Check can be found in the following link;  .http://docs.intergral.com/pages/viewpage.action?pageId=34898117

CANNOT SEE ANY DATA IN THE REPORTS

Another issue that often occurs is that the TAP/SAP/Daily report might contain no data and there are many reasons for that behavior. In 
order to solve the issue, please follow the steps mentioned below.

Make sure that FusionReactor communicates successfully with FusionAnalytics and the archive files are send to the defined 
target. If you have issues accessing the FusionAnalytics server, please make sure that a Firewall policy/configuration is not 
blocking that traffic.

Check the status of the Datacollector. This can be done by accessing the FADC application and then by navigating to Applicatio
.ns > Import History

If you are able to see data in the "Import History" area, check the   file for error fusionanalytics-datacollector-errors.log
messages.This can be found by navigating to C:\FusionAnalytics\Server\logs.

If you are unsure about the error messages and you require further assistance, please feel free to get in touch with the FusionReactor 
Support Team on .support@fusion-reactor.com

mailto:support@fusion-reactor.com
mailto:support@fusion-reactor.com
http://docs.intergral.com/display/FA206/Installing+your+license
http://docs.intergral.com/display/FA207/SLA+Report+FAQ
http://docs.intergral.com/display/FA207/Running+the+SLA+Reports
http://docs.intergral.com/pages/viewpage.action?pageId=34898117
mailto:support@fusion-reactor.com


[FNS-1] Creating Daily Status Reports in FusionAnalytics

Creating Daily Status Reports in FusionAnalytics

INTRODUCTION

A major new feature in the release candidate is the addition of a Daily Status Report.This report contains a breakdown of the server's 
performance on the previous day including detailed information about the requests, database activity, resource usage and even a 
breakdown of individual applications running. The report can be scheduled to be emailed every day to a number of users. Details on how 
to setup and configure the Daily Reports can be found in the article below.

1.0 SETUP

1.1 USERS

During the installation of FusionAnalytics, you will have created an administrator account. To create other accounts, you need to go to 
FusionAnalytics DataServices > Users tab > Users Summary. Here you will be able to see any existing user accounts and create new 
ones.

To add an email address to an existing user: Click the   button under the username of the account that you want to add an address Edit
to. Type an email address into the email field and click the   button.Modify User Details

To create a new user: Click the   button. You must fill in the username and password fields; the first name, last name Create A New User
and email fields are optional. You can always go back and edit these details later.

There is the option to make the account a System User, which means they will have access to all applications (this is the same settings 
as the administrator account). Once you have clicked  , you can add any application mappings that the user will need. An Add New User
account with an administrator role can make changes to the application, but an account with a user role can only view the data in a client.

1.2 SERVER SETTINGS

During installation, you will have set the host address and port number of the server for FusionAnalytics. If needed, these settings can be 
changed under FusionAnalytics DataServices > System tab > Server Settings. This needs to be correct for the reports (and any other 
background tasks) to run.

The server host field is the server or IP address that FusionAnalytics is running on; the server port is the port that FusionAnalytics is 
configured to use.

1.3 EMAIL SETTINGS



You will also need to make sure that the email server settings are correct before you can receive any emails from FusionAnalytics. To do 
this, go to FusionAnalytics DataServices > System tab > Server Settings. These fields need to be set, as any emails that are sent to and 
from FusionAnalytics use these as the default. This includes the sending of all notification emails.

The mail server field needs to be set to the server or IP address of the server that sends SMTP mail messages; e.g. mail.company.com:
. By default the port number is set to 25, but you can specify a port number after the address if needed; e.g.  . If you need 25 127.0.0.1:587

to provide authentication, you need to put this in front of the address:  .username:password@mail.company.com:25

1.4 DAILY STATUS REPORTS

The reports are configured in FusionAnalytics DataServices > Scheduled Tasks tab > Create A New Task. You can set the name, how 
long and how often the task will run. The task will run indefinitely if no end date is specified. There are several options for how often you 
want the task to run; as these are Daily Status Reports, you probably want to have them recurring daily at a suitable time, e.g. early in 
the morning when there are no other tasks running.

The   must be set to  . You can then provide particular arguments to the report if needed (see Provider Name DailyStatus 2.2 receiving 
 and  ).reports as emails 2.3 running reports for a specific date

 

2.0 CUSTOMISING YOUR REPORTS

2.1 APPLICATON FILTERS

By making use of the application filters in the FusionAnalytics client, you can make sure you get the most out of the information you 
receive in your Daily Reports. They allow you to see data specifically for particular parts of your application.

Under the Administrator tab in your FusionAnalytics client, you need to select  . Click the  buttManage Applications Add New Application
on; specify an appropriate name and set the filter either by URL or by writing your own specific parameters. The filters allow you to sort 
the requests from each application by protocol, username, password, hostname, port or by a particular path element.

Once you have added application filters, you must log out of the client and log in again to see the applications listed. You can add as 
many application filters as you need; these allow you to sort the data to only see requests from particular parts of the application.

2.2 RECEIVING REPORTS AS EMAILS

To send the report straight to your inbox, you must first have an email address set on your user account. To do this, see  . The 1.1 users
advantage of setting this up is that every time a report is scheduled to run, it will also email a copy to any users that are specified.

Once you have ensured that the required users have email addresses, you will need to create a scheduled task (see 1.4 daily status 
). In the provider arguments section, you will need to put   in the name field and insert   in the value field.reports users your username

http://username:password@mail.company.com:25


To send the report to multiple users, in the value field insert the usernames separated by a comma and no spaces; e.g. admin,user1,
. All these user accounts must have email addresses set, otherwise they will not receive the report.user2

2.3 RUNNING REPORTS FOR A SPECIFIC DATE

You can also set the reports to run on data from a specific day. When you are creating your scheduled task, add the following provider 
arguments:   (for the name field) and a   (for the value field). There are many free UTC calculators date UTC time format in milliseconds
available on the Internet to help you calculate this value. From the date entered, the report will show the previous 24 hours.

 

3.0 RUNNING THE REPORTS

3.1 RUNNING DAILY STATUS REPORTS INSTANTLY

The report will run at the time you have specified, but you can also force it to run at any time by clicking   in the FusionAnalytics Run Now
DataServices > Scheduled Tasks tab > Scheduled Tasks Summary.

Once the report has run, you will see it in your FusionAnalytics client > Business Metrics > Reports. You can use the timeline to navigate 
to the reports from previous dates. To open a report, right click the row and select .Open Report

3.2 READING A DAILY STATUS REPORT

By comparing data with the previous day, the Daily Status Reports allow you to see the changes in your server from day to day. This 
gives you information on each section and what it all means.

Overview: As the name suggests, this section allows you to quickly see vital statistics about the requests that have run in the last 24 
hours. The arrows easily show if the change is positive, negative or neutral. For example, a red arrow means a negative change, but this 
may point up, as an increase may indicate requests are taking longer to complete.

Each attribute also shows the amount of change as a percentage, the delta value, the actual value for the last 24 hours and the value for 
the previous day (for the 24 prior to the current report). Several rows also list the minimum and maximum requests that occurred 
between each sample.

System Load Statistics: These graphs show the system and process CPU load and memory usage. If the graphs are showing that the 
loads or usage is high, this can indicate that the application needs to be looked at. Underneath the graphs, there is also a percentage 
change from the previous day, with actual and previous day values.



Session Statistics: This gives the recorded number of session and ColdFusion IDs, including the average number of requests that run 
per ID.

Slowest Requests: This section allows you to easily see which requests are taking the longest to complete. Only the longest 5 requests 
are shown, but if viewed in a web browser, this can be expanded to show the 20 slowest requests. If the same URLs constantly give 
slow requests, it may need to be investigated further in the application.

Slowest Requests on Average: Similar to the above section, this allows you to see the slowest requests grouped by URL. It also shows 
how many times this URL was used in the request count. This section can also be expanded in a web browser to see more requests.

Application Data Overview: If you have application filters configured (see 2.1 application filters), you will see them listed in this section. 
This gives similar information shown in the overview and session statistics sections, but only counts data that is relevant to that part of 
the application.

Application JDBC Overview: Similar to the above section, it lists JDBC data that is relevant to each application filter that has been 
configured (see 2.1 application filters).

Applications: This section divides each configured application filter into a separate sub-section, which lists the overall slowest requests 
and the slowest requests on average for each one. This is the same as the previous sections on slowest requests and slowest requests 
on average, but with data relevant to a specific part of the application.
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